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Part No. 32267900-EN 

Revision C 

User Manual 

WARNING! Read this manual before using this product.  Failure to follow 

the instructions and safety precautions in this manual can result in 

serious injury.  Keep this manual in a safe location for future reference. 

Copyright  2016 by SKF USA Inc.   

All rights reserved. 

Technical Support Email: tsg-americas@skf.com  North and South America 

Technical Support Email: tsg-emea@skf.com  
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SKF USA Inc. 

® SKF is a registered trademark of the SKF Group.  

All other trademarks are the property of their respective owners.   

© SKF 2016 

 

The contents of this publication are the copyright of the publisher and may not be reproduced (even 

extracts) unless prior written permission is granted. Every care has been taken to ensure the accuracy of 

the information contained in this publication but no liability can be accepted for any loss or damage whether 

direct, indirect or consequential arising out of the use of the information contained herein. SKF reserves the 

right to alter any part of this publication without prior notice. 
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Product Support – Contact Information 

 

Product Support – To request a Return Authorization, Product Calibration or a Product Support Plan, use 

the web page links for direct contact and support.   

 

Product Sales - For information on purchasing condition monitoring products, services or customer 

support, contact your local SKF sales office. 

 

General Product Information 

 

For general product information (i.e., product data sheet, accessories catalog, etc.), visit the Condition 

Monitoring Products page on SKF.com and select the appropriate product link. 

 

Technical Support Group 

 

Discuss/review issues of specific interest with maintenance and reliability specialists from around the world 

at the SKF Knowledge Centre. 

 

For technical support on issues like troubleshooting product installation, troubleshooting product 

performance, etc., use our technical support web page to contact one of our Technical Support Groups. 

 

Product Registration 

 

Please take a moment to register your product at www.skf.com/cm/register to receive exclusive benefits 

offered only to our registered customers, including receiving technical support, tracking your proof of 

ownership, and staying informed about upgrades and special offers.  (Please visit our website for more 

details on these benefits.) 

 

Tell us how we’re doing! 

 

It’s important that you’re satisfied with the quality of our product user manuals.  We appreciate your 

feedback; if you have comments or suggestions for improvement, please tell us how we’re doing! 

 

121216dc 

 

http://www.skf.com/group/products/condition-monitoring/condition-monitoring-product-support/equipment-calibration/return_authorization_form.html
http://www.skf.com/group/products/condition-monitoring/condition-monitoring-product-support/equipment-calibration/index.html
http://www.skf.com/group/products/condition-monitoring/condition-monitoring-product-support/product-support-plans/index.html
http://www.skf.com/portal/skf/home/skfsites?contentId=188864&lang=en
http://www.skf.com/group/products/condition-monitoring/index.html
http://www.skf.com/group/products/condition-monitoring/index.html
http://www.skf.com/group/knowledge-centre/index.html
http://www.skf.com/group/products/condition-monitoring/condition-monitoring-product-support/technical-support/index.html
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mailto:SKF%20CM%20User%20Manual%20Feedback@skf.com?subject=AI_9_UM_feedback


  

End-User License Agreement 

 

THIS END-USER LICENSE AGREEMENT (this 

“Agreement”) is entered into by and between 

SKF USA Inc. and/or SKF Condition Monitoring 

Center AB (hereinafter referred to collectively as 

the “Licensor”) and any person or business that 

executes this Agreement by clicking the “I agree” 

icon at the end of this Agreement or by 

accessing, using, or installing the Software 

(“Licensee” or “You”).  Licensor and Licensee 

shall be referred to collectively in this 

Agreement as the Parties. 

 

BY CLICKING THE ACCEPTANCE BUTTON OR 

ACCESSING, USING, OR INSTALLING THE 

SOFTWARE, OR ANY PART THEREOF, YOU 

EXPRESSLY AGREE TO BE BOUND BY ALL OF 

THE TERMS OF THIS AGREEMENT.  IF YOU 

DO NOT AGREE TO ALL OF THE TERMS OF 

THIS AGREEMENT, THE BUTTON INDICATING 

NON-ACCEPTANCE MUST BE SELECTED, 

AND YOU MAY NOT ACCESS, USE, OR 

INSTALL ANY PART OF THE SOFTWARE. 

 

1. DEFINITIONS 

 

(a) Derivative Works.  The Term 

“Derivative Works” shall have the 

same meaning as set forth in the U.S. 

Copyright Act, as amended from time 

to time, in title 17 of the United States 

Code. 

 

(b) Effective Date.  The term “Effective 

Date” shall mean the date on which 

Licensee assents to the terms of this 

Agreement by clicking the “I agree” 

button at the bottom of this 

Agreement. 

 

(c) Intellectual Property Rights.  The 

term Intellectual Property Rights shall 

mean all rights arising or protectable 

under the copyright, trademark, 

patent, or trade secrets laws of the 

United States or any other nation, 

including all rights associated with the 

protection of computer programs 

and/or source code. 

(d) Person.  The term “Person” shall 

mean an individual, a partnership, a 

company, a corporation, an 

association, a joint stock company, a 

trust, a joint venture, an 

unincorporated organization, or a 

governmental entity (or any 

department, agency, or political 

subdivision thereof). 

 

(e) Software.  The term “Software” shall 

mean the software application entitled 

Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family suite, which 

is an application developed, owned, 

marketed, and licensed by Licensor.  

The term Software shall include the 

object code of Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other object 

code within the SKF @ptitude family 

suite and any and all user manuals, or 

other technical documentation, 

authored by Licensor in connection 

with Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family.  The term 

“Software” includes any corrections, 

bug fixes, enhancements, releases, 

updates, upgrades, or other 

modifications, including custom 

modifications, to Software for 

Wireless Monitoring System V/T, SKF 

@ptitude Analyst, SKF @ptitude 

Inspector, SKF @ptitude Observer, 

SKF @ptitude Decision Support or any 

other software within the SKF 

@ptitude family suite and any and all 

user manuals.  The term Software 

also includes any supplemental, add-

on, or plug-in software code provided 



to Licensee in the course of receiving 

Product Support Plan services from 

Licensor.  The term Software shall not 

be construed to include the source 

code for Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other 

software within the SKF @ptitude 

family suite. 

 

2. LICENSE 

 

(a)  Grant of License.  Licensor grants 

Licensee, pursuant to the terms and 

conditions of this Agreement, a non-

exclusive, non-transferable, and 

revocable license to use the Software 

in strict accordance with the terms 

and conditions of this Agreement, 

including any concurrent use, network 

or other limitations set forth in 

subsection (b) below.  All rights not 

specifically granted by Licensor under 

this Agreement are retained by 

Licensor and withheld from Licensee. 

 

(b) Installation and Use Rights.  

Licensee shall use the Software only 

on its internal computer equipment, 

whether such equipment is owned, 

leased, or rented, at the Licensee’s 

principal business office.  The 

following paragraphs govern your 

installation and use rights with regard 

to the Software, depending on the 

type of license you have obtained from 

Licensor. 

 

(i) If you obtained a stand-alone 

license of the Software, you 

may install one (1) copy of the 

Software on one (1) computer 

residing in your principal 

business office. 

 

(ii) If you obtained a network 

license of the Software, you 

may install one (1) copy of the 

Software on as many 

networked clients 

(workstations) as authorized 

by your network license, as set 

forth more particularly in the 

applicable purchase order or 

other ordering documents 

memorializing your license 

acquisition; provided, however, 

that all network clients 

(workstations) are connected 

to a single licensed database 

residing in your principal 

business office. 

 

(iii) If you obtained a network 

license of the Software, you 

may connect to multiple 

licensed databases, you may 

install the database-dedicated 

clients up to the total number 

of networked clients acquired 

by you under the applicable 

purchase order or other 

ordering documents 

memorializing your license 

acquisition. 

 

(c) Other Conditions of Use.  Licensor 

understands and agrees that the 

Software works in conjunction and is 

compatible with database software 

licensed to you by Microsoft or 

Oracle.  Upon installation of the 

Software, the Software may detect 

an installed database software 

application from Oracle or Microsoft, 

and if so, the Software will be fully 

installed.  If no installed database 

software application from Oracle or 

Microsoft is detected, the Software 

will not install until such time as 

Licensee installs a valid and Software 

compatible copy of an Oracle 

database or a Microsoft SQL Server 

database and consents to the license 

terms of such database software 

application.  If Licensee does not 

agree to the terms of the the Oracle 

database license or the Microsoft 



  

SQL Server license, or if the Licensee 

fails to install such database 

software, the Software will not work.  

Licensee is responsible for 

maintaining a valid database license 

in accordance with the Oracle or 

Microsoft license agreement (which 

ever is applicable) at all times. 

 

(d) Restrictions on Use.  Licensee may 

use the Software only for its internal 

business purposes and on the 

identified equipment on which the 

Software was first installed or for 

which it is otherwise licensed; 

provided, however, that Licensee 

may temporarily use the Software on 

a back-up system in the event that 

the primary licensed system is 

inoperative or test system not used 

for production but solely for the 

purposes of testing the Software.  

Licensee may not use the Software 

for any other purpose.  Licensee shall 

not: 

 

(i)  permit any parent, 

subsidiaries, affiliated entities 

or third parties to use the 

Software; 

 

(ii) use the Software in the 

operation of a service bureau; 

 

(iii) allow access to the Software 

through any workstations 

located outside of Licensee’s 

principal business offices; 

 

(iv) rent, resell, lease, timeshare 

or lend the Software to any 

Person; 

 

(v) sublicense, assign, or transfer 

the Software or this license for 

the Software to any Person; 

 

(vi) reproduce, distribute, or 

publicly display the Software; 

 

(vii) make the Software accessible 

to any Person by any means, 

including posting on a web site 

or through other distribution 

mechanisms over the Internet; 

 

(viii) reverse assemble, 

disassemble, reverse engineer, 

reverse compile, decompile, or 

otherwise translate the 

Software or prepare 

Derivative Works based on the 

Software; 

 

(ix) place, reproduce, or make 

available the Software on 

Licensee’s computer network 

if Licensee is only authorized 

by this Agreement to operate 

the Software on a single 

workstation; 

 

(x) exceed at any given point in 

time the total number of 

network clients authorized by 

the applicable purchase order 

or ordering document to use 

or access the Software; 

 

(xi) edit or modify the Software 

except as expressly authorized 

by Licensor, including altering, 

deleting, or obscuring any 

proprietary rights notices 

embedded in or affixed to the 

Software; 

 

(xii) use the Software in any 

manner that disparages 

Licensor, Microsoft, or Oracle, 

or use the Software in a way 

that infringes the Intellectual 

Property Rights of the 

foregoing parties; or 

 

(xiii) use the Software in a manner 

that violates any federal, state, 

or local law, rule or regulation, 

or use the Software to violate 

the rights of any third party, or 



use the Software to promote 

pornography, hatred, or 

racism. 

 

(e) Copies.  Licensee, solely to enable it 

to use the Software, may make one 

archival copy of the Software’s 

computer program, provided that the 

copy shall include Licensor’s copyright 

and any other proprietary notices.  

The Software delivered by Licensor to 

Licensee and the archival copy shall 

be stored at Licensee’s principal 

business office.  If you purchased a 

network license of the Software, you 

may install one additional copy of the 

Software on your network for the 

limited purpose of testing the 

Software’s operation.  Except for the 

limited reproduction rights set forth in 

this paragraph, Licensee shall have no 

other right to copy, in whole or in part, 

the Software.  Any copy of the 

Software made by Licensee is the 

exclusive property of Licensor. 

 

(f) Modifications.  Licensee agrees that 

only Licensor shall have the right to 

alter, maintain, enhance or otherwise 

modify the Software. 

 

(g) Protection of Software.  Licensee 

agrees that it will take action by 

instruction, written agreement, or 

otherwise as appropriate with any 

person permitted access to the 

Software to enable Licensee to comply 

with its obligations hereunder.  

Licensee shall maintain records of the 

number and location of all copies of 

Software.  Licensee shall not provide, 

permit access to or use of, or 

otherwise make available any 

Software in any form without 

Licensor’s prior written agreement, 

except to Licensee’s employees for 

purposes specifically authorized by 

this Agreement.  Licensee 

understands and agrees that the 

source code for the Software is a 

valuable copyright and contains 

valuable trade secrets of Licensor.  

Licensee agrees not to discover or 

attempt to discover, or assist or 

permit any Person to discover or 

attempt to discover, by any means 

whatsoever the source code of the 

Software. 

 

(h) Licensor’s Audit Rights.  Licensor 

shall possess the right to audit 

Licensee’s use of the Software to 

determine compliance with this 

Agreement (hereinafter referred to as 

“Licensor’s Audit Rights”).  Licensor’s 

Audit Rights shall be exercised in 

accordance with the following 

paragraphs: 

 

(i) Notice of Audit.  Licensor 

shall provide Licensee with at 

least five (5) calendar days 

advance written notice of its 

intent to exercise the 

Licensor’s Audit Rights. 

 

(ii) Conduct of Audit.  The audit 

conducted by Licensor shall 

consist of a physical review of 

the computer hardware, 

software, and middleware 

operated by Licensee at its 

principal business office and 

any other office for which 

Licensor, in its sole and 

arbitrary discretion, deems an 

audit appropriate.  Licensee 

shall provide Licensor with 

unrestricted access to its 

computer hardware, software, 

and middleware in connection 

with any audit conducted by 

Licensor. 

 

(iii) Costs of Audit.  If Licensor’s 

audit uncovers a violation of 

this Agreement by Licensee, 

Licensee shall pay all costs 

and expenses incurred by 

Licensor in exercising the 



  

Licensor Audit Rights, 

including, without limitation, 

all attorneys’ fees and agent 

fees incurred by Licensor.  If 

Licensor concludes that no 

violation of this License 

Agreement has occurred, 

Licensor shall bear all costs 

and expenses incurred in 

exercising the Licensor Audit 

Rights.  If Licensee obstructs, 

restricts, or otherwise 

prevents Licensor from 

conducting a full and 

unrestricted audit, Licensee 

shall bear all costs and 

expenses, including attorneys’ 

fees, incurred by Licensor in 

enforcing this Section 2(h) 

before any court or judicial 

tribunal. 

 

(iv) Frequency of Audits.  

Licensor’s Audit Rights shall be 

exercised no more than two 

(2) times in any one calendar 

year.  

 

(i) Validity of Intellectual Property 

Rights.  In any action, dispute, 

controversy, or lawsuit arising out of 

or related to this Agreement, Licensee 

shall not contest the validity of 

Licensor’s Intellectual Property Rights 

related to the Software.  Licensee 

hereby agrees that it has had an 

opportunity to investigate the validity 

of Licensor’s Intellectual Property 

Rights, and acknowledges that 

Licensor’s Intellectual Property Rights 

related to the Software are valid and 

enforceable. 

 

(j) Material Terms and Conditions.  

Licensee specifically agrees that each 

of the terms and conditions of this 

Section 2 are material and that failure 

of Licensee to comply with these 

terms and conditions shall constitute 

sufficient cause for Licensor to 

terminate this Agreement and the 

license granted hereunder 

immediately and without an 

opportunity to cure.  This subsection 

2(j) shall not be construed to preclude, 

or in any way effect, a finding of 

materiality with respect to any other 

provision of this Agreement. 

 

3.   LICENSE FEE 

The applicable licensee fees will be set forth 

in the quote issued to Licensee by Licensor 

or otherwise established in the applicable 

purchase order or other ordering 

documents memorializing your license 

acquisition. 

 

4.   OWNERSHIP 

 

(a) Title.  Licensee understands and 

agrees that Licensor owns all 

Intellectual Property Rights related to 

the Software, including custom 

modifications to the Software, 

whether made by Licensor or any 

third party.  Licensee agrees that this 

Agreement effects a license, not a 

sale, of the Software and that the first 

sale doctrine, as codified in 17 U.S.C. 

§ 109, does not apply to the 

transaction effected by this 

Agreement. 

 

(b) Transfers.  Under no circumstances 

shall Licensee sell, license, sublicense, 

publish, display, distribute, assign, or 

otherwise transfer (hereinafter 

referred to collectively as a “Transfer”) 

to a third party the Software or any 

copy thereof, in whole or in part, 

without Licensor’s prior written 

consent.  Any Transfer effected in 

violation of this Section 4(b) shall be 

void ab initio and of no force or effect. 

 

5. MAINTENANCE AND SUPPORT 

Licensor may provide you with support 

services related to the Software called 

Product Support Plan (“PSP”) services.  Use 

of PSP is governed by the policies and 



programs described in the PSP literature or 

other material from Licensor’s Product 

Support Department (hereinafter referred 

to as the “PSP Policies”) that may be 

updated by Licensor from time to time. If 

you select and pay for PSP, the PSP 

Policies shall be specifically incorporated 

into this Agreement by this reference.  

Licensee acknowledges that Licensor may 

use any technical information provided by 

Licensee in the course of receiving PSP 

services for Licensor’s business purposes, 

including for product support and 

development.  Licensor will not utilize such 

technical information in a manner that 

identifies Licensee. 

 

6. CONFIDENTIAL INFORMATION 

Licensee agrees that the Software contains 

proprietary information, including trade 

secrets, know-how and confidential 

information (hereinafter referred to 

collectively as the “Confidential 

Information”), that is the exclusive property 

of Licensor.  During the period this 

Agreement is in effect and at all times after 

its termination, Licensee and its employees 

and agents shall maintain the confidentiality 

of the Confidential Information and shall not 

sell, license, publish, display, distribute, 

disclose or otherwise make available the 

Confidential Information to any Person nor 

use the Confidential Information except as 

authorized by this Agreement.  Licensee 

shall not disclose the Confidential 

Information concerning the Software, 

including any flow charts, logic diagrams, 

user manuals and screens, to persons not 

an employee of Licensee without the prior 

written consent of Licensor. 

 

7.   LIMITED WARRANTIES 

 

(a) Licensor warrants that the Software 

will perform substantially in 

accordance with its documentation for 

a period of 180 days from the date of 

shipment of the Software; provided, 

however, that the foregoing warranty 

only applies if: (i) Licensee makes 

Licensor aware of any defect with the 

Software within seven (7) days after 

the occurrence of the defect; (ii) 

Licensee has paid all amounts due 

under this Agreement; and (iii) 

Licensee has not breached any 

provision of this Agreement.  The 

foregoing warranty does not apply in 

the event that: (i) the Software and 

documentation have been subject to 

misuse, neglect, alteration, 

modification, customization, improper 

installation, and/or unauthorized 

repair; (ii) the Software or any 

associated software or equipment 

have not been properly maintained in 

accordance with applicable 

specifications and industry standards 

or have been maintained in unsuitable 

environmental conditions; or (iii) 

Licensee has used the Software in 

conjunction with other equipment, 

hardware, software, or other 

technology that created an adverse 

impact on the operation, functioning, 

or performance of the Software. 

 

(b) EXCEPT AS SET FORTH IN THIS 

SECTION 7 AND TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, 

ALL EXPRESS AND/OR IMPLIED 

WARRANTIES OR CONDITIONS, 

INCLUDING BUT NOT LIMITED TO 

IMPLIED WARRANTIES OR 

CONDITIONS OF MERCHANTABILITY, 

MERCHANTABILITY OF A COMPUTER 

PROGRAM, INFORMATIONAL 

CONTENT, SYSTEM INTEGRATION, 

FITNESS FOR A PARTICULAR 

PURPOSE, AND NON-

INFRINGEMENT, ARE HEREBY 

DISCLAIMED AND EXCLUDED BY 

LICENSOR. 

 

(c) The remedies set forth in this Section 

7 are the exclusive remedies available 

to Licensee for any problem in the 

performance of the Software. 

 



  

8.   LIMITATIONS ON LIABILITY 

 

(a) Limitations and Exclusions.  IN NO 

EVENT WILL LICENSOR BE LIABLE 

TO LICENSEE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, 

CONSEQUENTIAL, PUNITIVE OR 

OTHER SPECIAL DAMAGES, LOST 

PROFITS, OR LOSS OF INFORMATION 

SUFFERED BY LICENSEE ARISING 

OUT OF OR RELATED TO THIS 

AGREEMENT OR THE USE OF THE 

SOFTWARE, FOR ALL CAUSES OF 

ACTION OF ANY KIND (INCLUDING 

TORT, CONTRACT, NEGLIGENCE, 

STRICT LIABILITY, BREACH OF 

WARRANTY OR CONDITION, AND 

STATUTORY) EVEN IF LICENSOR HAS 

BEEN ADVISED OF THE POSSIBILITY 

OF SUCH DAMAGES.  THE 

PRECEDING EXCLUSION AND 

DISCLAIMER OF DAMAGES SHALL 

APPLY TO ALL CLAIMS MADE BY 

LICENSEE RELATED TO OR ARISING 

OUT OF LICENSEE’s USE OF THE 

SOFTWARE, INCLUDING, BUT NOT 

LIMITED TO, CLAIMS ALLEGING THAT 

THE SOFTWARE, OR ANY 

COMPONENT THEREOF, FAILED OF 

ITS ESSENTIAL PURPOSE OR FAILED 

IN SOME OTHER RESPECT. 

 

(b) Acknowledgment.  Licensee agrees 

that the limitations of liability and 

disclaimers of warranty set forth in 

this Agreement will apply regardless 

of whether Licensor has tendered 

delivery of the Software or Licensee 

has accepted the Software.  Licensee 

acknowledges that Licensor has set its 

prices and entered into this 

Agreement in reliance on the 

disclaimers of warranty and the 

limitations and exclusions of liability 

set forth in this Agreement and that 

the same form an essential basis of 

the bargain between the Parties. 

 

9.   TERM AND TERMINATION 

 

(a) Term.  This Agreement shall 

commence on the Effective Date and 

shall continue in existence until it is 

terminated in accordance with Section 

9(b) below. 

 

(b) Termination.  Licensor may 

terminate this Agreement and the 

license conveyed hereunder in the 

event that Licensee breaches any 

provision, term, condition, or 

limitation set forth in this Agreement, 

including but not limited to the license 

restrictions set forth in Section 2(d) of 

this Agreement. 

 

(c) Effect of Termination.  Within ten 

(10) days after termination of this 

Agreement and the license granted 

hereunder, Licensee shall return to 

Licensor, at Licensee’s expense, the 

Software and all copies thereof, and 

deliver to Licensor a certification, in 

writing signed by an officer of 

Licensee, that all copies of the 

Software have been returned to 

Licensor and that Licensee has 

discontinued its use of the Software. 

 

10. ASSIGNMENT 

 Licensee shall not assign or otherwise 

transfer the Software or this Agreement to 

anyone, including any parent, subsidiaries, 

affiliated entities or third Parties, or as 

part of the sale of any portion of its 

business, or pursuant to any merger, 

consolidation or reorganization, without 

Licensor’s prior written consent.  Any 

assignment or transfer effected in violation 

of this Section 10 shall be void ab initio 

and of no force or effect. 

 

11. FORCE MAJEURE 

 Neither party shall be in default or 

otherwise liable for any delay in or failure 

of its performance under this Agreement if 

such delay or failure arises by any reason 

beyond its reasonable control, including 



any act of God, any acts of the common 

enemy, the elements, earthquakes, floods, 

fires, epidemics, riots, failures or delay in 

transportation or  communications; 

provided, however, that lack of funds shall 

not be deemed to be a reason beyond a 

party’s reasonable control.  The Parties 

will promptly inform and consult with each 

other as to any of the above causes that in 

their judgment may or could be the cause 

of a delay in the performance of this 

Agreement. 

 

12. NOTICES 

 All notices under this Agreement are to be 

delivered by depositing the notice in the 

mail, using registered mail, return receipt 

requested, to the party’s last known 

principal business address or to any other 

address as the party may designate by 

providing notice.  The notice shall be 

deemed delivered four (4) days after the 

notice’s deposit in the mail, if such notice 

has been sent by registered mail. 

 

13. CHOICE OF LAW 

 This Agreement (including all Exhibits), 

including its formation, execution, 

interpretation, and performance, and the 

rights and obligations of the Parties 

hereunder, shall be governed by and 

construed in accordance with the laws of 

the Commonwealth of Pennsylvania, 

without regard to any conflicts of law (or 

choice of law) principles thereof. 

 

14. CONSENT TO JURISDICTION 

 In the event that either party initiates 

litigation relating to or arising out of this 

Agreement, Licensor and Licensee 

irrevocably submit to the exclusive 

jurisdiction of the state or federal court in 

or for Philadelphia, Pennsylvania for the 

purposes of any suit, action or other 

proceeding relating to arising out of this 

Agreement or any transaction 

contemplated hereby or thereby (“Legal 

Proceedings”).  Licensee further agree that 

service of any process, summons, notice, 

or document by U.S. registered mail to 

such Party’s respective address shall be 

effective service of process for any Legal 

Proceeding.  Licensor and Licensee 

irrevocably and unconditionally waive any 

objection to personal jurisdiction and/or 

the laying of venue of any Legal 

Proceeding in the state or federal court in 

or for Philadelphia, Pennsylvania, and 

hereby further irrevocably and 

unconditionally agree not to plead, argue, 

or claim in any such court that any Legal 

Proceeding brought in any such court has 

been brought in an inconvenient forum 

and otherwise waive any and all objections 

to the forum. 

 

15. EXPORT CONTROLS 

 Licensee shall not export or reexport, 

directly or indirectly, the Software without 

complying with the export controls 

imposed by the United States Export 

Administration Act of 1979, as amended 

(or any future U.S. export control 

legislation) and the regulations 

promulgated thereunder.  

 

16. GOVERNMENT END USERS 

 If Licensee is acquiring the Software for or 

on behalf of a subdivision of the U.S. 

federal government, this Section 16 shall 

apply.  The Software was developed 

completely at private expense, is existing 

computer software, is a trade secret for all 

purposes of the Freedom of Information 

Act, is “restricted computer software” and 

in all respects proprietary data belonging 

solely to Licensor, and all rights are 

reserved under the copyright laws of the 

United States.  Use, duplication, or 

disclosure by the Government is subject to 

restricted rights as set forth in 

subparagraphs (a) through (d) of the 

Commercial Computer Software Restricted 

Rights clause at FAR 52.227-19, or for 

DoD units, the restrictions as set forth in 

subparagraph (c)(1)(ii) of the Rights in 

Technical Data and Computer Software 

clause at DFARS 252.227-7013. 

 



  

17. TRADEMARKS 

 Licensee agrees that SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude Decision 

Support or any other software within the 

SKF @ptitude family suite and the trade 

dress, logos and other designations of 

source used by Licensor to identify the 

Software are trademarks or registered 

trademarks of Licensor.  Licensee shall not 

use Licensor’s trademarks or service 

marks without the prior written consent of 

Licensor.  If the Software contains any 

active links to web sites, you agree to 

maintain such active links and not redirect 

or modify them. 

 

18. GENERAL PROVISIONS 

 

(a)  Complete Agreement.  The Parties 

agree that this Agreement is the 

complete and exclusive statement of 

the agreement between the Parties, 

which supersedes and merges all 

prior proposals, understandings and 

all other agreements, oral or written, 

between the Parties relating to the 

use of the Software. 

 

(b) Amendment.  This Agreement may 

not be modified, altered or amended 

except by written instrument duly 

executed by both Parties.  Any 

purchase orders or other ordering 

documents issued to Licensee by 

Licensor shall not have the effect of 

amending or modifying this 

Agreement, and shall only serve to 

memorialize the number of licenses 

or products ordered by Licensee.  In 

the event of a conflict between the 

PSP Policies and this Agreement, the 

terms of this Agreement shall 

control. 

 

(c) Waiver.  The waiver or failure of 

either party to exercise in any 

respect any right provided for in this 

Agreement shall not be deemed a 

waiver of any further right under this 

Agreement. 

 

(d) Severability.  If any provision of this 

Agreement is invalid, illegal or 

unenforceable under any applicable 

statute or rule of law, it is to that 

extent to be deemed omitted.  The 

remainder of the Agreement shall be 

valid and enforceable to the 

maximum extent possible. 

 

(e) Read and Understood.  Each party 

acknowledges that it has read and 

understands this Agreement and 

agrees to be bound by its terms. 

 

(f) Limitations Period.  No action 

arising under, or related to, this 

Agreement, may be brought by 

either party against the other more 

than two (2) years after the cause of 

action accrues, unless the cause of 

action involves death or personal 

injury. 

 

(g) Attorneys’ Fees.  In the event any 

litigation is brought by either party in 

connection with this Agreement, the 

prevailing party in such litigation will 

be entitled to recover from the other 

party all the costs, reasonable 

attorneys’ fees, and other expenses 

incurred by such prevailing party in 

the litigation. 

 

(h) Authorized Representative.  The 

person installing or using the 

Software on behalf of Licensee 

represents and warrants that he or 

she is legally authorized to bind 

Licensee and commit Licensee to the 

terms of this Agreement. 

 

(i) Injunctive Relief.  Licensee agrees 

that Licensor may suffer irreparable 

harm as a result of a violation of 

Sections 2, 4, 6, 10, 15, and 17 of 

this Agreement and that monetary 

damages in such event would be 



substantial and inadequate to 

compensate Licensor.  Consequently, 

Licensor shall be entitled to seek and 

obtain, in addition to such other 

monetary relief as may be 

recoverable at law or in equity, such 

injunctive other equitable relief as 

may be necessary to restrain any 

threatened, continuing, or further 

breach by Licensee without showing 

or proving actual damages sustained 

by Licensor and without posting a 

bond. 

 

CM-F0176 (Revision F, January 2011) 
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Introduction to SKF @ptitude Inspector 

About This Manual 

As you'll soon realize, SKF @ptitude Inspector is easy to install and use.  Chances are, 

after reading what you need to know in order to get going, you won't use this manual 

except as a quick reference aid. 

This manual helps you install your @ptitude Inspector software, create your @ptitude 

Inspector machinery hierarchy of measurement POINTs, download and upload 

measurements between @ptitude Inspector and your data collection device, and 

generate graphic plots and reports for analyzing the measured machinery's condition.  

This manual's chapters are organized according to the steps in this process (a chapter 

overview follows on page 2).   

 In writing this manual we assume you are familiar with common 

Windows operations.  Refer to your Windows guides for 

information in these areas. 

As you use this manual, you'll discover certain conventions used: 

Bold type is used to indicate text that appears in a SKF @ptitude Inspector 

menu, window, or dialog. 

Italics are used to emphasize important information. 

 - are used to indicate notes to the reader. 

Step-by-step procedures are sequenced using 

bullets, •. 

Technical Support  

If you have questions regarding the installation or operation of SKF @ptitude Analyst, 

please visit the self-help portal before contacting the help desk to see if the answer is 

already published:  . 

Technical Support Self-help Portal: www.skf.com/cm/tsg  

If further assistance is needed, please submit a support request by clicking on the 

SUPPORT tab and one of our support engineers will contact you shortly.  

The technical support team can be reached during normal business hours (7:00 a.m. to 

4:00 p.m. local time) by phone, e-mail, or live chat:  

 Customers in Europe, Middle East and Africa:  

Phone: +46 31 337 6500  

E-Mail: TSG-EMEA@skf.com  

Chat: www.skf.com/cm/tsg  

 Customers in all other locations:  

Phone: 1-858-496-3627 or toll-free (USA) 1-800-523-7514  

http://www.skf.com/cm/tsg
mailto:TSG-EMEA@skf.com
http://www.skf.com/cm/tsg
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E-Mail: TSG-Americas@skf.com   

Chat: www.skf.com/cm/tsg  

Note: Standard technical support will be provided at no cost on products or software 

covered under an SKF Product Support Plan (PSP), whenever applicable.  Many SKF 

Machine Health products include limited technical support for the first 180 days after 

purchase.  Support obtained after 180 days or without PSP coverage will be Support 

obtained after 180 days or without PSP coverage will be subject to a per-incident fee. 

Contact the technical support team for more information.  

Chapter Overview 

This User Manual is divided into 5 chapters and 1 appendix: 

Chapter 1, Introduction - Introduces manual conventions and overviews the @ptitude 

Inspector / Microlog Inspector / MARLIN System. 

Chapter 2, Working With Your SKF @ptitude Inspector Hierarchy - Describes in 

detail how to organize your machinery measurement POINTs into @ptitude Inspector 

hierarchies, SETs, machines, and POINTs.  Also details how to establish @ptitude 

Inspector’s many alarm criteria.  Describes hierarchy editing procedures using @ptitude 

Inspector’s Templates, Modify by Attribute feature, and Filters. 

Chapter 3, Data Collection ROUTEs and Other Data Transfer Operations - 

Describes how to create @ptitude Inspector measurement collection ROUTEs, how to 

download ROUTEs to the data collection devices, how to upload measurements from 

the data collection devices, and how to manually enter data into the @ptitude Inspector 

hierarchy. 

Chapter 4, Displaying Graphic Plots - Describes methods for displaying collected 

machinery measurements in graphic plot format, and describes in detail @ptitude 

Inspector’s menu options for manipulating graphic plots to obtain useful analysis data. 

Chapter 5, Generating and Printing SKF @ptitude Inspector Reports - Describes in 

detail how to create report templates and how to generate and print @ptitude Inspector 

reports. 

Appendix A, SKF @ptitude Inspector Toolbars - Offers an overview of @ptitude 

Inspector’s toolbars and details the custom toolbar creation procedure. 

What is the SKF @ptitude Inspector / Microlog Inspector / MARLIN System? 

Components of SKF Reliability System’s Microlog Inspector / MARLIN System work with 

SKF @ptitude Inspector software to provide an inexpensive, easy-to-use machinery and 

plant process monitoring system.  Machinery condition data and plant process data are 

easily recorded and automatically monitored for exceptions to normal conditions.  When 

conditions change, the Microlog Inspector / MARLIN System directs the operator toward 

appropriate corrective actions.  Microlog Inspector / MARLIN System components 

perform all of these functions in-the-field, or after uploading, on a host computer 

running SKF @ptitude Inspector (which facilitates easier set-up, provides long term data 

storage, and provides extensive reporting features). 

mailto:TSG-Americas@skf.com
http://www.skf.com/cm/tsg
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 Most @ptitude Inspector setup fields are identical for both the 

Microlog Inspector and MARLIN systems.  Fields specific to either 

the Microlog Inspector or the MARLIN are so designated. 

Three components make up the Microlog Inspector / MARLIN System: 

 Machine Condition Detector Probe (MCD, MCD-IS, Wireless MCD) – Monitors 

overall machine and rolling element bearing vibration and temperature. 

 FFT spectrum data collection is available with MARLIN Firmware 

version 4.5, Microlog Inspector version 1.0, and WMCD Firmware 

version 6.3.0 and newer. 

 MARLIN Quick Connect Stud (MQC) – Enhances data collection speed and accuracy, 

and provides very precise alarm control for MCD probe vibration and temperature 

POINTs. 

 Data Manager – A portable, hand-held computer dedicated to easy input, storage, 

display and alarming on machinery condition data and plant process data.  

These Microlog Inspector / MARLIN System components are designed to work in 

concert (all components interacting) or independently of each other. 

 

Figure 1 - 1. 

Some Microlog Inspector / MARLIN System Components. 

Machine Condition Detector Probe (MCD / WMCD) 

 With @ptitude Inspector, settings are identical for both the MCD 

and WMCD.  Both are therefore generically referred to as the 

MCD. 

 Microlog Inspector uses only the WMCD. 

The MCD probe is a portable sensor instrument capable of measuring, displaying, and 

alarming on two types of machinery vibration, and machine temperature. 
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Vibration signals are processed by the MCD probe to produce two very meaningful 

vibration measurements for each data collection POINT: 

 Overall velocity vibration for monitoring and detecting general machinery faults like 

imbalance, misalignment, and looseness; and 

 Enveloped acceleration vibration for early detection of rolling element bearing and 

gear faults. 

The MCD probe performs these measurements and the temperature measurement 

simultaneously.  Results are immediately displayed on the MCD’s display.  Exceptions 

from normal conditions are indicated on the display, and on green, yellow, and red 

indicator lights. 

The MCD probe is capable of working independently, or with the MARLIN hand-held 

computer for more precise alarm settings, data storage, and trend review capabilities.  

The MCD probe also works with MARLIN Quick Connect studs (MQC) for more precise 

alarm control and more efficient and consistent data collection. 

MARLIN Quick Connect Stud (MQC) 

The MQC stud enhances data collection speed and accuracy, and provides very precise 

alarm control for MCD probe vibration and temperature POINTs. 

The MQC is a small stud-like device that mounts permanently to a machinery 

measurement POINT (typically a bearing cap).  The system’s MCD probe mounts quickly 

and securely to the installed MQC stud using a ¼ turn screw mount (hence the name, 

MARLIN Quick Connect).  This mounting method ensures proper probe location and 

orientation, and provides more accurate vibration measurements (especially for rolling 

element bearing defect and gearmesh vibration signals). 

There are two versions of MQC studs available: 

Mechanical Stud - The MQC mechanical stud does not house programmable 

memory.  It is a mechanical interface only.  Use it to ensure proper probe 

location and orientation, and to attain the best possible vibration signal for 

periodic monitoring purposes. 

Computerized Stud (MARLIN only) - In addition to providing a secure mechanical 

interface between the MCD probe and the measured machine, the MQC “smart 

stud” houses a memory chip.  This chip is easily programmed via the MDM 

hand-held computer for POINT Id information (for automatic POINT 

identification) and for alert and danger alarm settings specific to the measured 

POINT. 

During data collection, when the MCD probe is connected and the vibration and 

temperature measurements performed: 

 The MQC smart stud’s alarm settings are temporarily uploaded into the 

MCD probe’s memory. 

 In the MCD probe, the POINT’s current measurement values are compared 

to the POINT’s alarm settings, and MCD probe alarm indicators react 

specifically to the monitored POINT. 
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Again, MQC studs and the MCD probe may be used independently, or in concert with 

the MARLIN hand-held computer. 

Data manager (MDM) 

The data managers (MDM) are portable hand-held computers dedicated to easy input, 

storage, display, and alarming on machinery condition data and plant process data. 

 

Figure 1 - 2. 

The Microlog Inspector / MARLIN Family. 

Using the provided interface cable, machine vibration and temperature measurements 

are input to the MDM directly from the MCD probe.  Plant process data are easily 

recorded on the MDM’s touch sensitive display using the plastic stylus “pen” tool.  

Collected machine data, alarm information, and alarm messages to the operator are 

immediately displayed on the MDM’s LCD display screen for in-the-field fault detection, 

trend analysis, and corrective actions. 

Like the SKF Microlog, the MDM can utilize data collection ROUTEs (measurement 

sequences set up and downloaded from SKF @ptitude Inspector) to facilitate the most 

efficient MDM data collection.  Vibration and temperature measurements (MCD probe / 

WMCD POINTs), process POINTs, and routine machine inspection POINTs (including 

alarm settings) are setup in @ptitude Inspector and downloaded to the MDM.  After 

data collection is complete, collected measurement and alarm data may be uploaded to 

the @ptitude Inspector hierarchy for long term storage, @ptitude Inspector analysis, 

and @ptitude Inspector reporting. 

 MDM POINTs may also be easily collected in random sequence 

using the MARLIN data manager’s built-in barcode scanning 

device.  This built-in scanner automatically identifies machines 

and measurement POINTs in the field. 
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The Host Computer 

The host computer has Microsoft Windows 7, 8.1 or 10, an Intel 2.0 GHz, 32 or 64-bit, 

or better processor, 6 or more Gbytes of RAM, and a 30 Gbyte hard disk (minimum 10 

Gbyte); and enough free disk space to store your @ptitude Inspector measurement 

hierarchy (whose size depends on the number of monitored measurement POINTs).  

Together, the host computer and @ptitude Inspector software perform database 

management, trending, display, and reporting functions for the Microlog Inspector / 

MARLIN System. 

For further details, refer to the SKF @ptitude Analyst Installation Manual (P/N 

32312400). 

SKF @ptitude Inspector Software 

The easy-to-use @ptitude Inspector software works with DADs (Data Acquisition 

Devices) to assist machinery maintenance personnel in managing and analyzing their 

collected data.  @ptitude Inspector automatically uploads measurement data from DADs 

and performs the tedious clerical work required in sorting, storing, and pre-analyzing 

measurement data.  Use @ptitude Inspector to easily configure measurement POINTs 

(a machinery location at which measurement data is collected), for downloading 

measurement POINT setups to DADs, for hierarchy manipulation of collected data, and 

to graphically display and generate reports on collected measurement data. 

Exception Reports - @ptitude Inspector automatically compares current measurement 

values to past measurement values, and to pre-defined alarm values to detect changes 

from normal machinery conditions.  Using hierarchy list alarm status indicators and 

detailed printed reports, @ptitude Inspector alerts maintenance personnel to alarm 

conditions (exceptions from normal conditions). 

Analysis - @ptitude Inspector displays and prints various plots and reports for 

analyzing machinery condition. 
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Figure 1 - 3. 

An Example MCD Trend Plot. 

Trend plots are easily displayed to help determine if machinery condition changes are 

occurring.  For the easiest and most effective use of the Microlog Inspector / MARLIN 

System, you should: 

Use SKF @ptitude Inspector to: 

 Organize your hierarchy into SETs and machines. 

 Add measurement POINTs to these hierarchy machines, configuring each 

POINT's measurement and alarm settings as it is created. 

 Create a collection ROUTE of measurement POINTs. 

 Download the collection ROUTE to the MARLIN data manager (MDM). 

Use the SKF Microlog Inspector / MARLIN to: 

 Walk the ROUTE with a DAD, collecting data for each pre-determined 

measurement POINT. 

Use SKF @ptitude Inspector to: 

 Upload the collected data to @ptitude Inspector. 

 Use @ptitude Inspector’s alarm detection features to quickly scan for abnormal 

machine conditions. 

 Use @ptitude Inspector plots and reports to analyze, trend, report, and store 

measurement data. 
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Working With Your SKF @ptitude Inspector Hierarchy 

Selecting which of your machinery requires monitoring, what measurements to perform 

on the selected machinery, and how often to perform these measurements requires a 

careful study of the needs of the plant.   

Creating a Paper Copy Hierarchy 

It is advisable to create a paper copy hierarchy before creating your @ptitude Inspector 

hierarchy.  This paper copy hierarchy of your machinery measurement POINTs should be 

organized in hierarchical format by machines and POINTs for each machine. 

For each hierarchy, use an outline format to create your organizational hierarchy, with 

measurement POINTs branching from machines, which branch from SETs. 

 

 

Take time to organize your paper copy hierarchy thoroughly.  A complete and organized 

paper copy hierarchy makes building your @ptitude Inspector hierarchy much easier.  

When naming POINTs, it is helpful to keep machine names and POINT identifiers in 

columns (as exampled above). 

 If you have several machines with the same title (for example, 

GAS TURBINE), use an alpha or numeric prefix or suffix to 

uniquely identify one machine only (for example, GAS TURBINE 

INLT). 

About POINT Names 

In the @ptitude Inspector system, each measurement must be identified by a descriptive 

name.  This can be accomplished by adding a suffix to each equipment name to denote 

the specific location, measurement orientation, and type of measurement.  

Suffixes such as AHV, 1VD, and so on, can be used to identify specific MCD Probe 

vibration measurements, with letters denoting which end of the machine (A, B, 1, 2, 

etc.), direction (H - horizontal, V - vertical, or A - axial), and type of measurement (V - 

velocity, D - displacement, etc.). 

 POWER GENERATION 

  GAS TURBINE 

   GT INLT 1HV 

   GT INLT 1VV 

   GT INLT 1XV 

   GT INLT 2HV 

   GT INLT 2VV 

   GT INLT 2XV 

  MAIN PUMP 

 WATER TREATMENT 

HIERARCHY 
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 In a hierarchy list, POINTs branching from the same machine 

must have unique names.  However, POINTs branching from 

different machines may share the same name.  Also, each 

machine must have a unique name.  If you try to create a 

machine with the same name as another in the hierarchy list, SKF 

@ptitude Inspector automatically adds a numeric suffix to the 

machine’s name.  The same holds true for POINTs branching 

from the same machine.  For example, if you have a machine 

named Pump and try to name another machine with the same 

name, @ptitude Inspector adds a suffix, and the new machine is 

named Pump.1. 

Overview 

In @ptitude Inspector, you create a hierarchy that organizes your monitored machinery 

measurements into a hierarchy structure consisting of Groups (which consist of 

organizational SETs, machines, or custom groups) and measurement POINTs. 

Each @ptitude Inspector hierarchy displays in the Hierarchy window in which its 

hierarchy items list.  Multiple databases display in the same Hierarchy window, and only 

one Hierarchy window may be open at a time. 

When building your hierarchy, you insert hierarchy Groups which you identify as either a 

Machine hierarchy item or an organizational SET hierarchy item, or a custom Group 

Type you create. 

IMPORTANT 

All hierarchy lists must contain Machine hierarchy items from which measurement 

POINTs branch.  Measurement POINTs cannot branch from a SET hierarchy item or the 

root node.  They must branch from a “Machine” hierarchy item. 

After creating your paper copy hierarchy, your next task is to use your paper copy 

hierarchy to input your organizational hierarchy into @ptitude Inspector to build your 

@ptitude Inspector hierarchy.  This chapter walks you through the usual @ptitude 

Inspector steps for creating a new hierarchy.  These steps are: 

 Create one or more new hierarchies. 

 Create each hierarchy’s organizational SETs (optional) and Machines. 

 Add measurement POINTs to their appropriate machine, configuring 

each POINT as it is created. 

The general steps required to create a new hierarchical structure are listed below.  

Refer to the indicated dialogs and topics for more information on specific steps. 

 Use the File menu’s New option to create a new hierarchy.  A hierarchy window 

displays with a Hierarchy root node. 

 Only the hierarchies to which the user has access display.  For 

details on setting Hierarchy access, refer to the Customizing Your 

@ptitude Inspector Software section in Chapter 2 – Getting 

Around in SKF @ptitude Inspector. 
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 With the Hierarchy window active, use the Insert menu to insert new Groups in the 

hierarchy window.  Specify the new Group's Type as either Machine group, a SET 

group, or one of your custom groups (if available). 

 Refer to Group Properties for more information. 

 After inserting your Machine hierarchy items, click to highlight a specific Machine 

and insert New POINTs for the Machine.  Specify the new POINT's DAD and POINT 

Properties. 

 Refer to POINT Properties for more information. 

IMPORTANT: 

 

* Machines must have unique names. 

 

* POINTs must branch from a machine. 

 

* POINTs branching from the same machine must have unique names. 

Displaying Existing SKF @ptitude Inspector Hierarchies in the Hierarchy 

Window 

 Use the File menu's Open/Close command to display the Open/Close dialog.  All 

available hierarchies display in the Open/Close dialog. 

 In the Open/Close dialog, enable the checkbox next to the hierarchy name(s) you 

wish to display in the Hierarchy window and click OK. 

The selected hierarchies’ display in the Hierarchy window. 

To remove a hierarchy from the Hierarchy window: 

 Use the File menu’s Open/Close command to display the Open/Close dialog.   

 In the Open/Close dialog, disable the checkbox next to the hierarchy name(s) you 

wish to no longer display in the hierarchy and click OK.  The disabled hierarchies no 

longer display in the Hierarchy window. 

Creating a New SKF @ptitude Inspector Hierarchy 

@ptitude Inspector’s installation program installs a “demo” hierarchy (unless you 

selected to install an empty hierarchy only).  You should create a new hierarchy to store 

your machinery vibration measurements. 

To create a new @ptitude Inspector hierarchy: 

 Select the File menu’s New command.  The New dialog opens. 

 Enter a unique name for the new hierarchy and click OK.   

A blank Hierarchy window displays.  The hierarchy name appears in the window’s title 

bar. 
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 Access to the new hierarchy is assigned only to its creator.  To 

give other users access to the new hierarchy, refer to the 

Customizing Your @ptitude Inspector Software section in 

Chapter 2 – Getting Around in SKF @ptitude Inspector. 

Inserting @ptitude Inspector Groups 

When building your hierarchy, you insert hierarchy Groups which you identify as either a 

Machine hierarchy item, an organizational SET hierarchy item, or a custom Group Type 

previously created. 

To insert a new Group: 

 Select the Insert menu’s New Groups option.  The Group Properties dialog 

displays.   

 The keyboard’s Insert key may also be used to insert a new group 

when in a Hierarchy, ROUTE, or Workspace window. 

Setting Your Primary Hierarchy 

@ptitude Inspector’s Hierarchy window displays multiple hierarchies at one time in the 

same window.  One hierarchy must be designated as the primary hierarchy. 

The primary hierarchy is the default hierarchy and owns any newly created ROUTEs and 

Workspaces.  When working in areas of the application that require hierarchy selection 

(e.g., Reports, Filters, Workspaces, etc.), this hierarchy will be offered by default.  When 

in areas of the application where hierarchy selection is not offered (for example, 

Transfer), the primary hierarchy will automatically be used. 

To set the primary hierarchy: 

 In the File menu’s Open/Close dialog, you may click the Set Primary button to set 

the highlighted hierarchy as the primary hierarchy.  The primary hierarchy name 

appears in bold with the [primary] displayed next to the hierarchy name. 

OR 

 In the Hierarchy window, right click the hierarchy’s root node, and select the Set 

Primary option.  The primary hierarchy name displays in bold. 

Group Properties Dialog 

General Tab 

Group Properties / General fields are organized into three areas; Settings, Segment 

and asset tracking, and Miscellaneous. 

Settings fields include: 

Name – Enter a unique name to identify the new group. 

Description – (optional) Enter a description to further identify the new group. 
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Type – Select Machine or SET from the drop down list. 

 Custom group types may also be available for selection.  Creation 

of custom group types is discussed later in this chapter. 

 Once a Group’s Type is specified, it cannot be changed. 

Enable data collection checkbox – Click the checkbox to enable POINT transfer to a 

DAD. 

 By default, data collection is enabled.  To temporarily disable data 

collection, clear the checkbox. 

Segment and asset tracking fields include: 

Segment name – Enter text that defines the Group’s physical location.  For example, 

enter “Level 2” or “Press Section.” 

Asset name – Enter text that defines the physical machinery currently occupying the 

Segment entered above.  For example, enter a machine’s serial or part number. 

 Segments remain fixed while Assets may be moved from one 

location (segment) to another. 

 Segment name and Asset name fields are unavailable when 

working with a template item's group properties. 

Miscellaneous fields include: 

Priority – Priority assignments may be used in filtering and reporting.  A machine is 

typically given a Priority rating when a problem is found and you wish to prioritize the 

problems to be addressed.  Specify a machine's priority from the drop down list.   

 The Priority field is only available if you are working with a 

Machine-type Group. 

 Assign a color for each machine priority to allow easy 

identification of all machines with priority assignments.  Enable to 

display a machine priority color in the hierarchy for all machines 

with assigned priority levels on the Customize / Preferences / 

General tab.  Default is disabled. 

Available priority assignments are: 

<No Priority> 

1 – Critical 

2 – High 

3 – Medium 

4 – Low 

5 – Lowest 
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Figure 2 - 1. 

Example of Machine Priority Color Displayed in Hierarchy. 

 

Filter Keys Tab 

@ptitude Inspector allows you to create Filter Keys which can be associated with 

POINTs and Machines for automated filtering purposes.  For example, if you activated a 

“Pump” filter key for a Group and later filter a hierarchy list using the Filter Key / 

Pump, then all Groups with active Pump filter keys display in the filtered Workspace. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab lists all created filter keys and indicates whether or not 

they are currently assigned.   

 Click a specific filter key’s checkbox to associate it to the current POINT. 

 The checkbox appears gray if the filter key is enabled for a parent 

hierarchy item. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 

Notes Tab 

The Group Properties / Notes tab allows you to attach a text note to the Group along 

with a date / time stamp.  This feature conveniently stores and records relevant Group 

information such as maintenance history. 

 Coded notes uploaded from the Microlog Inspector / MARLIN for 

the current Machine display in the Notes tab. 

 Click the Notes tab’s Add button to add a new note and date / time stamp. 

 Click the Save button to save edits made to a note. 

 Click the Undo button to cancel edits made to a note. 

 Click the Remove button to remove the selected note from the display. 

Group Properties / Notes fields include: 

Date – Select the current date from the drop down list. 
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Time – Select the current time. 

The selected date and time appear in the dialog’s left Notes field. 

Text – Type in desired note text in the text field. 

 Click the tab’s OK button to save all entries. 

Images Tab 

Scanned photographs or digital images can be added to a particular Group, stored in the 

database, and viewed from the Images tab.  Images help identify SETs / machines, 

organize similar equipment, and document known defects. 

Group Properties / Images fields include: 

Image – All attached images display in the drop down list. 

Description – Enter text to identify the image.  Click the Save button to save your 

description entry.  If saved, the new description replaces the filename in the Images list. 

 Click OK to save your new description entry. 

To add a new image: 

 Click the Add button to add a new image.  The Windows’ Open dialog displays.  

Select desired image and click Open to add or Cancel to undo. 

 Added images use the filename as the default description. 

To replace / update the current image: 

 Click the Browse button. 

 Select a replacement image.  The new image displays on the tab. 

 Click Save to confirm the image replacement. 

 Click Cancel to undo the image replacement. 

 The image name and description of the old image are retained for 

the replacement image. 

To export an image to a specific location: 

 Select the image to export. 

 Click the Export button. 

 When prompted, enter the desired export location and click OK. 

The image is copied and saved to the specified location, but still remains attached to the 

assigned Group.  
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Messages Tab 

The Messages tab allows you to apply previously defined “shared” messages, and to 

create new, private messages to assign to the selected group. 

 

Figure 2 - 2. 

The Group Properties Dialog’s Messages Tab. 

@ptitude Inspector's Group Properties / Messages feature allows you to create and 

assign one message for general machine instruction purposes.  The Messages context 

area displays the type of message available for assignment and any existing messages 

already applied.  You can assign a previously created shared message to the current 

group, or create and apply a new private message. 

The Name drop down list displays all previously created messages and a <Private> 

option.  Use this drop down list to specify whether you wish to set up a unique  

<Private> message for the current group only, or specify a previously defined “shared” 

message (selected by name).  If you specify a shared message, its format, summary, 



 Working With Your SKF @ptitude Inspector Hierarchy 

 Group Properties Dialog 

 

SKF @ptitude Inspector 2 - 9 

User Manual 

and content automatically display in subsequent fields.  If you specify a Private message, 

proceed to configure the message settings as described below. 

 For more information on creating and managing public messages, 

refer to the Customize / Database Operations section later in 

this chapter. 

Format – This drop down list allows you to specify your message's format. 

Free form – Allows you to manually type in the summary and content for your 

message. 

Hyperlink – Allows you to create a link to an existing file on your Microlog 

Inspector / MARLIN.  During data collection, when the specified message 

condition is met, the originating application (Word, Acrobat) launches the 

machine's hyperlinked message file on the unit.  When the message condition 

occurs, an Instruction (i) button becomes available (un-ghosts) on the display.  

Tap this Instruction (i) button to display the message. This feature allows you 

to associate detailed instructions with particular machines while still keeping 

downloads small and efficient.The message file and the application used to 

create the message must both be present on the Microlog Inspector / MARLIN.  

Message files are downloaded to the Microlog Inspector / MARLIN using 

ActiveSync.  Reference your ActiveSync User Manual for more information. 

Summary – Type in text summarizing your message for easy recognition.  For example, 

if you have a message that details specifics about a group of machinery, your summary 

may read, "FD Fan Data Collection Information."  

Content  

Free form messages - Enter your complete message in the content text area.  

Using the above example, your alarm message content would include detailed 

data collection information, specific to the current group.  For example, your 

message may read "Ensure sensor is properly mounted before collecting data, 

etc." 

Hyperlink message – Enter the path and filename for the file you wish to 

associate with the message.  For example, C:\\MARLIN Instructions\\FD 

FAN\\Data Collection Instructions.doc. 

To assign a shared message to the current group: 

 Select the shared message from the drop down list and click the OK button.  

Shared messages may be applied to an unlimited number of groups. 

Shared Message 

Alarm messages initially created as private messages may be converted into shared 

(public) messages.  To share a newly created Private message, select the new Private 

message and click the tab’s Share As button. 

The Enter Name dialog specifies the message as a shared (public) message.  When the 

Enter Name dialog displays, you will be prompted to give the shared message a unique 

name for easy identification.   

 Enter a name for the shared message and click the OK button. 



Working With Your SKF @ptitude Inspector Hierarchy 

Group Properties Dialog 

2 - 10 SKF @ptitude Inspector  

 User Manual 

The new shared message now appears as an available selection in the dialog's drop 

down list.  Shared messages are easily assigned to other groups to simplify setup and 

maintenance. 

Details Tab 

 

Figure 2 - 3. 

The Group Properties Dialog’s Details Tab. 

 The Details tab is available only for custom Group Types. 

Additional Group information can be entered in the Details tab and stored in the 

database.  The five fields that appear in the Details tab are defined in the Customize / 

Database / Group Types dialog when you define a custom Group Type.   

Enter appropriate information in the text box following the customized fields.  Helpful 

Details information may include serial number, RPM, address, etc.  These fields may be 

customized to support any type of information applicable to your specific application. 
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The Details tab is unavailable if detail options have not been previously defined in the 

Database / Group Type dialog. 

Inserting New POINTs 

Use the Insert menu to insert new measurement POINTs to your hierarchy machines. 

To insert new POINTs: 

 In the Hierarchy window, select the machine from which you wish the new POINT 

to branch. 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

dialog displays. 

 The keyboard’s Insert key may also be used to insert a new 

POINT. 

 

Figure 2 - 4. 

The DAD / POINT Type Selection Dialog. 

From the DAD / POINT Type Selection dialog, your DAD Type, Application, Sensor, 

and Units selections determine the POINT type 

Fields in this dialog include: 

DAD Type – Select the appropriate data acquisition device type from the drop down list 

of available DADs. 

Application – Only applications consistent with your DAD type selection display in the 

Application drop down list.  Select the appropriate application.   

 For example, select Inspection for an inspection POINT, General 

for a process POINT, or Vibration for an MCD POINT. 

Sensor – Only sensors consistent with your selected application display in the Sensor 

drop down list.  Select the appropriate sensor. 

Units – Only units consistent with your selected sensor type display in the Units drop 

down list.  Select the appropriate units. 

 Click OK to save your settings. 

 Click Cancel to terminate POINT insertion. 
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 Once the POINT is saved with DAD / POINT Type information, 

this information cannot be modified. 

After DAD / POINT Type Selection settings are saved, the POINT Properties dialog 

automatically displays. 

POINT Properties 

The POINT Properties dialog allows you to enter all POINT information and settings.  

On each tab: 

 Click OK to save settings 

 Click Cancel to undo settings. 

General Tab 

The POINT Properties dialog’s General tab allows you to enter the POINT name and 

description and displays the DAD / POINT Type information you previously entered. 

 

Figure 2 - 5. 

The POINT Properties Dialog’s General Tab. 
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POINT Properties / General fields include: 

Name – Enter a unique name to identify the POINT. 

Description – Enter a description to further identify the POINT. 

Enable data collection – When POINTs are downloaded to the collection instrument, 

the Enable data collection setting determines whether the POINT is downloaded or 

ignored.  Click the checkbox to enable. 

DAD Type – Displays the DAD type previously assigned when the POINT was created. 

Application – Displays the application type assigned when the POINT was created. 

Sensor – Displays the sensor type assigned when the POINT was created. 

Units – Displays the appropriate measurement unit assigned when the POINT was 

created. 

 The DAD Type, Application, Sensor, and Units fields of the 

General tab cannot be edited once they have been assigned. 

 When a POINT is disabled from downloading, its existing alarm 

conditions do NOT affect the system. 

Location – Enter the data collection POINT on the machine.  Options include: 

Normal – Alphabetic identifiers A-J. 

Displacement – Numeric identifiers 1-10. 

Other – Six specific identifiers: 

Drive End 

Non-Drive End 

Outboard 

Inboard 

Coupled End 

Non-Coupled End 

Tending Side 

Drive Side 

Orientation – Select from drop down list options (Axial, Horizontal, None, Radial, 

Triax, Vertical, X, Y). 

Exclude from reports if last measurement is a Non-collection event. – Select 

(check) to have any reports that would include this POINT exclude it if its last 

measurement was a non-collection event (for example, the machine was marked as 

non-operating or certain measurement conditions were not met). 

Clear Alarms for Non-collection last measurements. – Select (check) to have the 

system clear any previous measurement alarms for this POINT if its last measurement 

was a non-collection event (for example, the machine was marked as non-operating or 

certain measurement conditions were not met). 
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Setup Tab - Process POINTs 

Enter Process POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to Process 

POINTs. 

 

Figure 2 - 6. 

The POINT Properties Dialog’s Setup Tab for Process POINTs. 

If Setup units allow editing, the values display in an edit field.   

 The POINT Setup Validation Dialog launches when you enter 

incompatible or erroneous information on the Setup tab.  

Reference the POINT Setup Validation section later in this 

manual for more information. 

Setup fields include: 

Full Scale - Enter a number to define the anticipated maximum amplitude to be 

measured for this POINT. 

Location Method - Specify the method used to identify the POINT.  From the drop 

down list, select the appropriate Location Method for the POINT.  Options include: 

None - While collecting data, the POINT is manually identified using hierarchy 

list controls. 
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Barcode / RFID - The barcode scanner is used to automatically locate and 

identify the machine / POINT in the hierarchy list.   

Location Tag - Enter a unique identifier that links the POINT to a specific machine 

location. 

Minimum Scale - Enter the minimum value to display on the input display (may be 

positive, negative, or zero).   

Form Type - Options include Bar, Gauge, Keypad, or Slider.  Select the desired data 

input display type. 

Conditional POINT Setup 

Conditional POINTs allow data collection only when a specified condition exists.  As an 

example, let’s assume Inlet Pressure is specified as the conditional POINT for Outlet 

Pressure (dependent POINT).  In order for Outlet Pressure to be collected, Inlet 

Pressure must have a reading of 1000 PSI or greater (condition).   

Once a conditional POINT has been associated with the current POINT, you may edit the 

conditional POINT's criteria from the setup tab.  

To associate a conditional POINT with the current POINT: 

 Click the Conditional POINT area’s Edit button.  The Conditional POINT dialog 

displays. 

 Click the Select conditional POINT option button. 

 In the list, click to select the conditional POINT. 

 In the Criteria setup area, select the condition that must be present in the 

conditional POINT for data to be collected for the current POINT. 

Criteria options include: 

In alarm 

Out of alarm 

Above 

Below 

In range 

Out of range 

Is equal  (to the selected Result) 

Is not equal (to the selected Result) 

 For details regarding how to set up alarms, refer to the Alarm 

Database section later in this chapter. 

To clear the associated conditional POINT from the current POINT: 

 Click the Clear button. 

 Click OK. 



Working With Your SKF @ptitude Inspector Hierarchy 

POINT Properties 

2 - 16 SKF @ptitude Inspector  

 User Manual 

Setup Tab - MCD POINTs 

Enter MCD POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to MCD 

POINTs. 

 

Figure 2 - 7. 

The POINT Properties Dialog’s Setup Tab for MCD POINTs. 

If Setup units allow editing, the values display in an edit field.   

 The POINT Setup Validation Dialog launches when you enter 

incompatible or erroneous information on the Setup tab.  

Reference the POINT Setup Validation section later in this 

manual for more information. 
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Setup fields include: 

Location Method - Specify the method used to identify the POINT.  From the drop 

down list, select the appropriate Location Method for the POINT.  Options include: 

None - While collecting data, the POINT is manually identified using hierarchy 

list controls. 

Barcode / RFID - The barcode scanner is used to automatically locate and 

identify the machine / POINT in the hierarchy list.   

Location Tag - Enter a unique identifier that links the POINT to a specific machine 

location. 

Store FFT Data – Specify when the WMCD will collect and store FFT data for the 

POINT.   

 FFT spectrum data collection is available with MARLIN Firmware 

version 4.5, Microlog Inspector version 1.0, and WMCD Firmware 

version 6.3.0 and newer. 

None – Never stores FFT data for the POINT. 

Always – Always stores FFT data for the POINT. 

On Alarm – Only stores FFT data for the POINT when the WMCD detects a 

measurement outside the alarm levels. 

Full Scale gE - Enter a number to define the anticipated maximum enveloped 

acceleration to be measured for this POINT. 

Full Scale Velocity- Enter a number to define the anticipated maximum velocity to be 

measured for this POINT. 

Full Scale Temp- Enter a number to define the anticipated maximum temperature to 

be measured for this POINT. 

Speed – Enter the nominal shaft speed in RPM.  Analysis features (i.e., harmonics are 

initially based off the entered shaft speed. 

Conditional POINT Setup 

Conditional POINTs allow data collection only when a specified condition exists.  As an 

example, let’s assume Inlet Pressure is specified as the conditional POINT for Outlet 

Pressure (dependent POINT).  In order for Outlet Pressure to be collected, Inlet 

Pressure must have a reading of 1000 PSI or greater (condition).   

Once a conditional POINT has been associated with the current POINT, you may edit the 

conditional POINT's criteria from the setup tab.  

To associate a conditional POINT with the current POINT: 

 Click the Conditional POINT area’s Edit button.  The Conditional POINT dialog 

displays. 

 Click the Select conditional POINT option button. 

 In the list, click to select the conditional POINT. 
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 In the Criteria setup area, select the condition that must be present in the 

conditional POINT for data to be collected for the current POINT. 

Criteria options include: 

In alarm 

Out of alarm 

Above 

Below 

In range 

Out of range 

Is equal  (to the selected Result) 

Is not equal (to the selected Result) 

 For details regarding how to set up alarms, refer to the Alarm 

Database section later in this chapter. 

To clear the associated conditional POINT from the current POINT: 

 Click the Clear button. 

 Click OK. 

Setup Tab - Inspection POINTs 

In addition to using the Microlog Inspector / MARLIN System's Condition Detector 

sensor (WMCD / MCD), or using its stylus pen and touch sensitive display to manually 

input process data from machinery gauges, inspection POINTs allow the operator to use 

the stylus pen and touch sensitive display to record visual observations (or perform and 

record a physical test of some sort) over time using a set of consistent observable 

results.  The setup of an inspection POINT consists of specifying the observed condition 

along with the observed results.   

Alert and danger alarm conditions can be assigned to inspection results and provide 

immediate feedback messages to the data collection person when the inspection results 

are in alarm condition. 

Enter Inspection POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to 

Inspection and MCD POINTs defined with the DAD.  
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Figure 2 - 8. 

The POINT Properties Dialog’s Setup Tab for  

Inspection and MCD POINTs. 

If Setup units allow editing, the values display in an edit field.   

 The POINT Setup Validation Dialog launches when you enter 

incompatible or erroneous information on the Setup tab.  

Reference the POINT Setup Validation section later in this 

manual for more information. 

Setup fields include: 

Location Method - Options include None, Barcode, or MQC ID.  From the drop down 

list, select the appropriate Location Method for the POINT.  Options include: 

None - While collecting data, the POINT is manually identified using hierarchy 

list controls. 

Barcode/RFID - The barcode scanner is used to automatically locate and 

identify the machine / POINT in the hierarchy list.   

MQC ID - An MQC computerized stud connection automatically locates and 

identifies the POINT in the hierarchy list, and automatically initiates the 

POINT’s data input display.  (MCD POINTs only) 
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Location Tag - A unique identifier that links the POINT to a specific machine location, 

such as the MQC-ID, or the barcode number is automatically read from the 

computerized stud. 

Conditional POINT Setup 

A conditional POINT can be set to collect data for a POINT when a specified condition is 

detected.  For example, if POINT A (conditional POINT) is in alarm (condition), then data 

for POINT B is collected.  If the specified condition is not detected, then no data for 

POINT B is collected. 

Once a conditional POINT has been associated with the current POINT, you may edit the 

conditional POINT's criteria from the setup tab.  

To associate a conditional POINT with the current POINT: 

 Click the Conditional POINT area’s Edit button.  The Conditional POINT dialog 

displays. 

 Click the Select conditional POINT option button. 

 In the list, click to select a conditional POINT. 

 In the Criteria setup area, select the condition that must be present in the 

conditional POINT to collect data for the current POINT, from the Criteria drop 

down list. 

Criteria options may include: 

In alarm 

Out of alarm 

Above 

Below 

In range 

Out of range 

Is equal  (to the selected Result) 

Is not equal (to the selected Result 

 Click OK. 

To clear the associated conditional POINT from the current POINT: 

 Click the Clear button 

 Click OK. 

Inspection Tab 

Enter the Inspection Prompt, possible Results of the inspection, and resulting Alarm 

Conditions for each possible result in the Inspection tab. 

Inspection Results and Alarm Conditions 

An alert or danger alarm condition may be assigned to each of the five Inspection 

results.  In addition, alert and danger alarm messages may be assigned to 

corresponding alarm conditions using the dialog’s Messages tab.  If, during data 

collection, the operator selects an inspection result associated with an Alert or Danger 

alarm condition, the appropriate alarm message is displayed. 
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 For more information on creating and assigning alert and danger 

messages, refer to the POINT Properties / Messages and the 

Customize / Database Operations / Messages sections later in 

this chapter. 

 

Figure 2 - 9. 

The POINT Properties Dialog’s Inspection Tab. 

Inspection POINT Configuration 

Inspection tab fields include: 

Inspection Alarms - Drop-down list contains all user-defined Inspection Alarms.  If 

desired, select a previously created Inspection Alarm to assign to the POINT. 

Prompt - Enter the Inspection Prompt (limit 30 characters). 

Inspection Results - Enter up to five possible inspection results by placing the cursor in 

the drop down list (these drop down lists also act as editable text boxes with a limit of 

15 characters), or select a previously entered Inspection result from the drop-down list 

(if previously configured Inspection results are specified as “shared” alarms).   

For every Result defined, select the appropriate alarm condition from the drop-down 

list on the right.  Options include None, Alert, and Danger. 
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Share As - Click to save the current conditions as a shared alarm.  The Share As dialog 

displays. 

Sharing Inspection Alarms 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

When the Enter Name dialog displays, you will be prompted to give the shared alarm a 

unique name for easy identification.   

 Enter a name for the shared alarm. 

The new shared alarm now appears as an available selection in the drop-down list. 

Editing Inspection POINT Setups 

IMPORTANT – Modifying inspection POINT Prompts and Inspection results for 

existing POINTs modifies any existing POINT data associated with the POINT.  The 

Inspection POINT editing feature should only be used for Inspection Result and 

Prompt clarification or error corrections (typos), not to modify the meaning of the 

labels or the alarm results associated with each Inspection result.   

If you wish to edit the inspection POINT, click to enable the Allow edits anyway 

checkbox.  Once enabled, the fields become active, allowing you to make necessary 

edits. 

 The Allow edits anyway check box only appears if the Modify 

Inspection Alarm option in the user’s Access Level settings is set 

to Allow. 

 Click the OK button to save your edits. 

Setup Tab –Derived POINTs 

A derived POINT provides data from an operator created formula that uses previously 

collected measurement POINT data in its calculation. 

Prior to setting Setup tab options, use the DAD / POINT Type Selection dialog’s setup 

fields to specify a derived POINT type. 

To specify a derived POINT type: 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

dialog displays. 

 Select the DAD type field’s Derived POINT option. 

 Select the Sensor field’s MARLIN / Microlog Inspector option.  Note that for 

Microlog Inspector / MARLIN DADs, derived POINT data is downloaded to the unit.  

The MARLIN / Microlog Inspector setting indicates that POINT data used in a 

derived POINT calculation is first calculated in the unit and then uploaded to 

@ptitude Inspector.  

 For Derived POINTs, the DAD / POINT Type Selection dialog’s 

Application field defaults to General, and the Units field defaults 

to Any Units. 
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Setup Tab Options 

Enter Derived POINT Setup information in this tab.  A Derived POINT consists of an 

operator created formula (expression) using measurement POINT data (variables), fixed 

numbers (constants; i.e., Pi) and mathematical functions (i.e., sin). 

 Not all derived POINT calculations are supported by the Microlog 

Inspector / MARLIN. 

 

Figure 2 - 10. 

The POINT Properties Dialog’s Setup Tab for Derived POINTs. 

If Setup units allow editing, the values display in an edit field.   

 The POINT Setup Validation Dialog launches when you enter 

incompatible or erroneous information on the Setup tab.   

 Reference the POINT Setup Validation section later in this 

manual for more information. 

POINT Properties / Setup fields may include: 

Full Scale - Enter a number to define the anticipated maximum amplitude to be 

measured for this POINT. 

Enable ICP - Click to enable the data manager to provide power to the sensor. 
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Minimum Scale - Enter the minimum value to display on the input display (may be 

positive, negative, or zero).   

Evaluation time – Ensures relevant variable data.  Defines the maximum time 

range during which all variables (POINTs) must collect measurement data for the 

derived POINT to calculate.  All variables in the expression formula must have data 

collected within this specified time range, or the derived POINT does not calculate.  

For example, if the Evaluation time is set to 15 minutes, all variables must be 

collected within 15 minutes of each other. 

Location Method - Options include None, or Barcode/RFID.  From the drop down list, 

select the appropriate Location Method for the POINT.   

Location Tag - Enter a unique identifier that links the POINT to a specific machine 

location, such as the MQC-ID, or the barcode number. 

Form Type - Options include Bar, Gauge, Keypad, or Slider.  Select the desired data 

input display type. 

Expressions Tab (Derived POINTs) 

 The POINT Properties / Expressions tab displays when the 

Derived POINT type is selected.  Use this tab to create or edit 

expressions for the derived POINT’s Expression formula (the 

derived POINT’s calculation).   

 

Figure 2 - 11. 

The POINT Properties Dialog’s Expressions Tab for Derived POINTs. 
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The Expressions drop down list displays all previously created “shared” expressions 

formulas (calculations) and a <Private Expression> option.  Use this drop down list to 

specify whether you wish to set up a unique <Private Expression> for the current 

derived POINT only, or specify a previously defined “shared” expression formula 

(selected by name).  If you specify a shared expression, its settings display in subsequent 

fields.   

 Specify either a shared or Private Expression and proceed to configure the tab’s 

expression settings as described below.  

Assigning Variables 

POINTs used in the derived POINT’s calculation are identified as “variables.”  Assigned 

variables list in the Available Variables area.   

To assign variables for a derived POINT: 

 Click the Variables button.  The Variables dialog displays. 

 

Figure 2 - 12. 

The Variables Dialog. 

 In the Variables dialog, click the Add button.  The Variables area displays the New 

Variable with an “unassigned POINT.”  The Properties area also displays the New 

Variable. 
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 Click the Select POINT assignment option button to activate the hierarchy, 

allowing you to select the POINT to assign to the new variable. 

 Click the Clear POINT assignment option to clear the point 

assigned to the selected variable.  Once cleared, <Unassigned> 

displays in the Assigned POINT column in the Variables list.   

 In the hierarchy, select the POINT to assign to the variable. 

 In the Properties area, type in a name for the new variable.  Tip - you may use the 

same name as the POINT ID. 

 Specify the Value type as Overall-Trend, Inspection Result for Inspection 

POINTs, or the type of MCD POINT for MCD POINTs.  

 Click the Save button to save the new variable.  Its information displays in the 

Variables area.  Repeat the process to Add all necessary variables. 

 You may click the Remove button to remove a variable from the 

Variables list for the current derived POINT. 

 When finished adding variables, click the Close button to return to the POINT 

Properties / Expressions tab.  The new variables display in the Available 

Variables area. 

Once variables have been created for the derived POINT, you can create the POINT’s 

expression formula (calculation).  Enter the calculation in the Expression formula entry 

box.  An expression formula must contain at least one variable, and may also contain 

constants and functions.  Insert mathematical operators (e.g., +, -, /, *) as necessary. 

To insert a variable to the expression formula: 

 In the Expression Formula area, position the cursor where you wish to insert the 

variable. 

 Select a variable from the Variables list and click the Insert button.  The selected 

variable appears as part of the expression formula.  

To add a constant to the expression formula: 

 In the Expression formula field, position the cursor where you would like to insert 

the constant. 

 Click the Constants button to display the Constant dialog. 

 Select a constant from the list of available constants (or create a new constant by 

clicking the Add button). 

 

Figure 2 - 13. 

The Add Constant Dialog. 

 Click OK.  The selected constant appears at the cursor position.   



 Working With Your SKF @ptitude Inspector Hierarchy 

 POINT Properties 

 

SKF @ptitude Inspector 2 - 27 

User Manual 

To add a function to the expression formula: 

 Place the cursor in the Expression formula section where you wish to insert the 

function and click the Functions button. The Functions dialog displays. 

 

Figure 2 - 14. 

The Functions Dialog. 

 Select a function from the dialog and click OK.  The selected function is entered at 

the cursor position in the Expression formula section along with the type of input 

data that is used for the function, shown in parentheses; for example: 

AVERAGE(<Variable>, <Length>). 

 Highlight the input data placeholder (e.g., <Variable>) and enter the applicable 

data, or select a constant to enter by using the Constants button.  You can also 

enter a variable by selecting it from the Variables section and clicking Insert. 

 To calculate more complex formulas, you can enter multiple 

functions within a single expression formula. 

Depending on the function, the type of input data can either be scalar data or dynamic 

data. 

Scalar data can be derived from: 

 Overall trend data from a Microlog Analyzer, Microlog Inspector/MARLIN, 

WMx/WVT, DMx, IMx, LMU/CMU/TMU 

 Inspection results (the calculated formula for inspection results will produce a result 

of either 0 (not valid) or 1 (valid) based on the inspection result that is entered) 

 Manual entry 

 Data from XML import (from sources such as the SKF Wireless Machine Condition 

Sensor, third party developments, etc.) 

 OPC from other systems (Digital Control Systems (DCS), Canary Labs and other 

data historians, etc.) 

 Oil Analysis / Trend Oil 

 MCD (Enveloped Acceleration, Velocity, or Temperature) 
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 WMCD 

 Derived POINTS themselves 

Dynamic data includes: 

 Time waveform data 

 FFT data 

The table below contains a list of the different functions that you can use for an 

expression formula, along with a description of the function and whether the function is 

based on scalar or dynamic data. 

 

Function Description Type of data 

ABS(<Variable>) Calculates the absolute value of the <Variable> entered. Scalar 

ALARMSTATUS 

(<Variable>) 

Determines and stores the current alarm status for the <Variable> 

(POINT) entered. Notice that this function does not re-evaluate past 

alarm conditions and therefore must be operated immediately when 

new alarm conditions are set for the <Variable>. 

 

Returned values are: 

-1   No alarm level (when the <Variable> has no values, no set alarm) 

0   Safe 

1   Alert 

2   Danger 

Scalar 

Dynamic 

ARCCOS(<Radians>) Calculates the arc cosine of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

ARCSIN(<Radians>) Calculates the arc sine of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

ARCTAN(<Radians>) Calculates the arc tangent of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

AVERAGE(<Variable>, 

<Length>) 

Calculates the average of the <Variable> entered using a sliding window 

of <Length> values entered. 

Scalar 

AVERAGE(<Dynamic 

Variable>,<Channel 

Number>) 

Calculates the average of the <Dynamic Variable> entered for the 

specified <Channel Number>. For non-multi-channel measurements, 

<Channel Number> should be set to 1. 

Dynamic 

CEIL(<Param>) Calculates the smallest (closest to negative infinity) integer that is not 

smaller than the <Param> value. 

Scalar 

CONTRIBUTION2 

(<Dynamic Variable>, 

<Speed Multiple>) 

Calculates the contribution (in percentage) of the energy periodical to 

the <Speed Multiple> entered. The <Dynamic Variable> entered is the 

time waveform. The <Speed Multiple> is specified in multiples of 

running speed including fractional values. 

Dynamic (best 

for time 

waveform data) 

CONTRIBUTION3 

(<Dynamic Variable>, 

<Speed Multiple>, 

<Ref Speed>) 

Calculates the contribution (in percentage) of the energy periodical to 

the <Speed Multiple> entered. The <Dynamic Variable> entered is the 

time waveform. The <Speed Multiple> is specified in multiples of 

running speed including fractional values. The <Ref Speed> entered is 

the machine speed value to use. The <Ref Speed> may be a fixed value, 

an overall value from a trend, or a speed value extracted with Speed() 

from a time waveform or spectrum. 

Dynamic (best 

for time 

waveform data) 

COS(<Radians>) Calculates the cosine of the <Radians> value entered. Scalar 
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Function Description Type of data 

COUNT_SPIKES 

(<Dynamic Variable>, 

<Channel Number>, 

<Threshold>, <DC>) 

Counts the number of spikes in the waveform indicated by the 

<Dynamic Variable> entered for the specified <Channel Number> 

entered. A spike is defined as a signal level equal or higher than the 

<Threshold> value entered. The <DC> bias value entered is subtracted 

from the signal prior to evaluation against the threshold value.  

 

Use the Average function to de-trend signals with strong DC bias i.e.: 

COUNT_SPIKES(<Dynamic Variable>, <Channel Number>, <Threshold>, 

AVERAGE(<Dynamic Variable>, <Channel Number>) ) 

 

For non-multi-channel measurements, <Channel Number> should be 

set to 1. 

Dynamic (best 

for time 

waveform data) 

CRESTFACTOR 

(<Dynamic Variable>) 

Calculates the crest factor. The crest factor is defined as the time 

waveform’s Peak value divided by its RMS value. The <Dynamic 

Variable> entered is the time waveform. The resulting value is 

dimensionless. 

Dynamic (best 

for time 

waveform data) 

CTA_PK_PK(<Waveform 

Data>, <Speed Multiple>) 

 

Calculates the Cyclic Time Average of a time waveform using the 

<Speed Multiple> averaging period. The <Waveform Data> entered is 

the time waveform. The <Speed Multiple> entered must be in seconds. 

The returned value is in the same engineering units as the <Waveform 

Data> and Peak to Peak detection type. 

Dynamic (best 

for time 

waveform data) 

CTA_RMS(<Waveform 

Data>, <Speed Multiple>) 

Calculates the Cyclic Time Average of a time waveform using the 

<Speed Multiple> averaging period. The <Waveform Data> entered is 

the time waveform. The <Speed Multiple> entered must be in seconds. 

The returned value is in the same engineering units as the <Waveform 

Data> and RMS detection type.  

Dynamic (best 

for time 

waveform data) 

CUSUM(<Variable>, 

<Variable>) 

Calculates the cumulative difference of the first <Variable> entered 

against the second <Variable> entered. 

Scalar 

DEGTORAD(<Degrees>) Converts the angle <Degrees> value entered to radians. Scalar 

DELTATIME(<Variable>) Calculates the difference in seconds between two adjacent 

measurements. 

Scalar 

Dynamic 

DELTAVALUE(<Variable>) Calculates the difference in value between two adjacent measurements. Scalar 

ENERGY_VALUE 

(<Dynamic Variable>, 

<Band Number>) 

Calculates the overall energy found in the specified <Band Number> 

frequency band. <Band Number> starts at 1. Returns zero when no 

frequency band exists for the specified <Band Number>. Returns a 

band overall energy value with the same units and detection type as the 

<Dynamic Variable> entered. 

Dynamic (best 

for FFT data) 

FLOOR(<Param>) Calculates the largest (closest to positive infinity) integer that is not 

greater than the <Param> value. 

Scalar 

FORECAST_EXP 

(<Variable>, <Length>, 

<Length>) 

Calculates a forecasted alarm, in days, of the <Variable> entered using 

a sliding window of specified <Length> values. Uses an exponential 

fitting function. 

Scalar 

FORECAST_LIN 

(<Variable>, <Length>, 

<Length>) 

Calculates a forecasted alarm, in days, of the <Variable> entered using 

a sliding window of specified <Length> values. Uses a linear fitting 

function. 

Scalar 

HAL(<Dynamic Variable>, 

<Speed Multiple>) 

Calculates the Harmonic Activity Index for the frequency specified by the 

<Speed Multiple> entered in the <Dynamic Variable> entered. The 

<Speed Multiple> must be in orders. The returned value is a 

dimensionless indicator of the likelihood that a harmonic pattern at the 

<Speed Multiple> exists. 

Dynamic (best 

for FFT data) 
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Function Description Type of data 

KURTOSIS(<Variable>, 

<Length>) 

For overall measurements, calculates the Kurtosis of excess for the 

<Variable> entered using a sliding window of specified <Length> 

values. There should be at least three measurements in the POINT 

referenced by the <Variable>. 

Scalar 

KURTOSIS(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the standard deviation of a dynamic signal (FFT or waveform) 

for the specified <Channel Number> entered. For non-multi-channel 

measurements, <Channel Number> should be set to 1. 

Dynamic 

LN(<Param>) Calculates the natural logarithm of the <Param> value entered. Scalar 

LOG(<Param>) Calculates the logarithm of the <Param> value entered. Scalar 

MAX(<Variable>, 

<Variable>) 

Calculates the maximum value between each <Variable> entered. 

Returns the appropriate <Variable>. 

Scalar 

MIN(<Variable>, 

<Variable>) 

Calculates the minimum value between each <Variable> entered. 

Returns the appropriate <Variable>. 

Scalar 

MOD(<Param>, 

<Param>) 

Calculates the remainder after the division of the first <Param> value 

entered by the second <Param> value entered; for example:  

MOD(7, 3) = 1. 

Scalar 

Operating Time This function is available only by selecting “Operating Time” for 

Application Type when creating the POINT. It computes the amount of 

time an asset has been operative in the time unit specified in the create 

POINT dialog. 

Scalar 

PEAK_VALUE(<Dynamic 

Variable>, <Band 

Number>) 

Calculates the peak value found in the specified <Band Number> 

frequency band. <Band Number> starts at 1. Returns zero when no 

frequency band exists for the specified <Band Number>. Returns a 

peak value with the same units and detection type as the <Dynamic 

Variable> entered. 

Dynamic (best 

for FFT data) 

PERCENTCHANGE 

(<Variable>) 

Calculates the percentage change between two adjacent measurements. 

What is computed is: (Value – PreviousValue ) / PreviousValue. 

Scalar 

POWER(<Base>, 

<Exponent>) 

Raises the <Base> entered to the power of the <Exponent> entered. Scalar 

ROC(<Variable>, <Days 

Multiple>) 

Calculates the rate of change (in days) between two adjacent 

measurements. 

Scalar 

ROUND(<Param>) Calculates the integer closest to the <Param> value. Scalar 

SIN(<Radians>) Calculates the sine of the <Radians> value entered. Scalar 

SKEW(<Variable>, 

<Length>) 

Calculates the skew for the <Variable> entered using a sliding window 

of specified <Length> values. There should be at least four 

measurements in the POINT referenced by the <Variable>. 

Scalar 

SKEW(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the skew of a dynamic signal (FFT or waveform) for the 

specified <Channel Number>. For non-multi-channel measurements, 

<Channel Number> should be set to 1. 

Dynamic 

SMAX(<Dynamic 

Variable>) 

Calculates the maximum vector magnitude of an Orbit. The <Dynamic 

Variable>value entered must refer to a 2 channel time waveform value. 

Dynamic (best 

for time 

waveform data) 

SPEED(<Dynamic 

Variable>) 

Extracts the machine speed from the <Dynamic Variable> entered. The 

<Dynamic Variable> must be either a time waveform or spectrum. The 

returned value is in Hertz. 

Dynamic 

SQRT(<Param>) Calculates the square root of the <Param> value entered. Scalar 

STDEV(<Variable>, 

<Length>) 

Calculates the standard deviation of the <Variable> entered using a 

sliding window of specified <Length> values. There should be at least 

two measurements in the POINT referenced by the <Variable>. 

Scalar 
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Function Description Type of data 

STDEV(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the standard deviation of a dynamic signal (FFT or waveform) 

for the specified <Channel Number>. For non-multi-channel 

measurements, <Channel Number> should be set to 1. 

Dynamic 

SUMDURATION 

(<Variable>, <Duration>) 

Enter any number of days (for example: 1, 7, 31, etc.) or partial days 

(for example: 0.5, 3.5, 11.75, etc.) for <Duration>. This function sums 

the <Variable>’s (POINT’s) last measurement with all of its previous 

measurements found within the specified number of days (or partial 

days) prior to the last measurement date/time. 

 

Sample cases: 

Enter a <Duration> of 7 to sum the <Variable>’s (POINT’s) last 

measurement with all of its previous measurements starting 

exactly 7 days prior to the last measurement. 

 

Enter a <Duration> of 3.5 to sum the <Variable>’s (POINT’s) last 

measurement with all of its previous measurements starting 

exactly 3 and one half days prior to the last measurement. 

Scalar 

SUMPERIOD(<Variable>, 

<Period>) 

Enter a specific <Period> (defined in sample cases, below). This function 

sums the <Variable>’s (POINT’s) last measurement with all of its 

previous measurements found within the specified <Period> and 

stamps the result with the period start date/time. 

 

SUMPERIOD differs from the other functions in that it always creates a 

measurement at the start of a period as soon as it begins, even when 

the source <Variable> (POINT) has not yet collected a measurement. 

The initial value is 0, and will be updated as the source <Variable> 

(POINT) collects measurements for that period. 

 

Sample cases: 

Enter a <Period> of Period_Hour to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements within the 

same hour, starting at the top of the hour (for example 08:00 AM). 

Alternatively, you can enter the constant 1 as the <Period> value 

to represent Period_Hour. 

 

Enter a <Period> of Period_Day to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same day, starting at 12:00 AM. Alternatively, you can 

enter the constant 2 as the <Period> value to represent 

Period_Day. 

 

Enter a <Period> of Period_Week_Sunday to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same week, starting Sunday at 12:00 AM. 

Alternatively, you can enter the constant 3 as the <Period> value 

to represent Period_Week_Sunday. 

 

Enter a <Period> of Period_Week_Monday to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same week, starting Monday at 12:00 AM. 

Alternatively, you can enter the constant 4 as the <Period> value 

to represent Period_Week_Monday. 

 

Scalar 
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Function Description Type of data 

Enter a <Period> of Period_Month to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same month, starting the first day of the month at 

12:00 AM. Alternatively, you can enter the constant 5 as the 

<Period> value to represent Period_Month. 

 

Enter a <Period> of Period_Quarter to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same quarter, starting Jan 1, Apr 1, Jul 1, or Oct 

1 at 12:00 AM. Alternatively, you can enter the constant 6 as the 

<Period> value to represent Period_Quarter. 

 

Enter a <Period> of Period_Year to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same year, starting Jan 1 at 12:00 AM. Alternatively, 

you can enter the constant 7 as the <Period> value to represent 

Period_Year. 

SUMSINCE(<Variable>, 

<Start Date>) 

Enter any <Start Date> code (using the format yyyymmdd or, 

optionally, yyyymmddhhmmss). This function sums all of the 

<Variable>’s (POINT’s) measurements found on or after the specified 

date/time. 

 

Sample cases: 

Enter a <Start Date> of 20140101 to sum all of the Variable’s 

(POINT’s) measurements found on or after Jan 1, 2014 at 12:00 

AM. 

 

Enter a <Start Date> of 20140101090000 to sum all of the 

Variable’s (POINT’s) measurements found on or after Jan 1, 2014 

at 09:00 AM. 

Scalar 

TAN(<Radians>) Calculates the tangent of the <Radians> value entered. Scalar 

Total Operating Time This function is available only by selecting “Operating Time” for 

Application Type when creating the POINT. It computes the total 

amount of time an asset has been operative in the time unit specified in 

the create POINT dialog. 

Scalar 

Dynamic 

TRUNC(<Param>) Removes any fractional part from the <Param> value entered. Scalar 

XMAG(<Dynamic 

Variable>, <Channel 

Number>, <Channel 

Number>, <Speed 

Multiple>) 

Computes the cross magnitude value (as opposed to cross phase) 

between two time waveform signals. The waveform signals are 

referenced by the <Dynamic Variable> entered and either of the 

specified <Channel Number> values. The specific frequency the cross 

magnitude value is computed for is determined by the speed value 

associated with the measurement and the <Speed Multiple> value 

entered: f = 1 / (s * Speed Multiple). 

 

This function operates on multi-channel measurements only. 

Dynamic (best 

for time 

waveform data) 
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Function Description Type of data 

XPHASE(<Dynamic 

Variable>, <Channel 

Number>, <Channel 

Number>, <Speed 

Multiple>) 

Computes the cross phase value (as opposed to cross magnitude) 

between two time waveform signals. The waveform signals are 

referenced by the <Dynamic Variable> entered and either of the 

specified <Channel Number> values. The specific frequency the cross 

phase value is computed for is determined by the speed value 

associated with the measurement and the <Speed Multiple> value 

entered: 

f = 1 / (s * Speed Multiple). 

 

This function operates on multi-channel measurements only. 

Dynamic (best 

for time 

waveform data) 

 The value entered for the SIN, COS, and TAN functions must be in 

radians, not degrees.  If the value entered is in degrees, the 

@ptitude Inspector will assume it is in radians, and the calculation 

will be wrong.   

To convert degrees to radians, use the DEGTORAD function in the 

formula.  For example, if you have a value of 45 degrees, the 

entered formula may look like this:  

SIN(DEGTORAD(45))   

When the formula is calculated, 45 degrees is automatically 

converted into radians.   

 Use the DeltaTime function to calculate the difference in seconds 

between the two most recent measurements for that POINT. 

 Use the DeltaValue function to calculate the difference in value 

between the two most recent measurements for that POINT.  

 Use the PercentChange function to calculate the percent change 

between the two most recent measurements for that POINT.  The 

formula will look like this: 

(LastValue – PreviousValue) / PreviousValue 

Important – After initial setup of a derived POINT that references variables 

(POINTs) with existing data records, you must manually calculate the derived 

POINT to immediately acquire derived POINT data based upon the variable POINTs’ 

historical data records.  Reference the Calculating Derived POINTs section later in 

this chapter for details. 

Share As 

 Click Share As to make the expression a shared expression.  The Enter Name 

dialog displays. 

 Enter a name for the shared expression and click OK. 

The new shared expression now appears as an available selection in the dialog's drop 

down list.  Shared expressions are easily assigned to other POINTs to simplify setup and 

maintenance. 
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MCD Tab 

Configure MCD alarms in this tab. 

 

Figure 2 - 15. 

The POINT Properties Dialog’s MCD Tab. 

MCD tab fields include: 

MCD Alarms: - Drop-down list contains all user-defined MCD Alarms.  If desired, 

select a previously created MCD Alarm to assign to the POINT. 

Settings  

Specify your Env. Acceleration, Velocity, and Temperature alarm values. 

Danger High - Enable checkbox to set.  Enter the numerical danger alarm 

value. 

Alert High - Enable checkbox to set.  Enter the numerical alert alarm value. 

Share As - Click to save the current conditions as a shared alarm.  The Share As dialog 

displays. 
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Sharing MCD Alarms 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

When the Share As dialog displays, you will be prompted to give the shared alarm a 

unique name for easy identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop-down list. 

Setup Tab (Manual POINTs) 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with a manual sensor. 

Enter Manual POINT Setup information in this tab.   

 

Figure 2 - 16. 

The POINT Properties Dialog’s Manual Setup Tab. 
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POINT Properties / Setup fields may include: 

 The POINT Setup Validation Dialog launches when you enter 

incompatible or erroneous information on the Setup tab.  

Reference the POINT Setup Validation section later in this 

manual for more information. 

Full Scale – Enter a number to define the measurement's maximum amplitude value. 

The Units selected on the DAD/POINT Type Selection dialog display next to the Full 

Scale field.  If Any Units was selected, the units may be edited.  Adjust the units if 

necessary. 

Compliance Tab 

Use the Compliance tab to enter data collection and archiving scheduling information. 

@ptitude Inspector allows you to archive collected data using its Scheduler feature, its 

Monitor application, or Manually.  To archive with Analyst’s Scheduler wizard or with 

the Monitor application, you must set archive parameters in the POINT Properties / 

Compliance tab and in the Scheduler wizard or Monitor application respectively. 

 

Figure 2 - 17. 

The POINT Properties Dialog’s Compliance Tab – Interval-Based. 
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 IMPORTANT - Keep current data for, Short term archive, and 

Long term archive settings operate ONLY with the Scheduler’s  

archive process or when using the Monitor application’s archive 

feature.  They do not apply to Manual archives. 

Data collection specifies the POINT’s data collection schedule, and the overdue for 

collection status. 

The Compliance tab has two modes: 

Interval-based – Select Interval-based if you wish to schedule data collection at a set 

time interval. 

Calendar-based – Select Calendar-based if you wish to schedule data collection based 

on a calendar date and time.  Calendar-based schedules are set up in the Customize / 

Database’s Compliance dialog. 

Interval-based fields include: 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Second(s), 

Minute(s), Hour(s), Day(s)).  The POINT is tagged as overdue for data 

collection if the time range between the current date (today) and the last data 

collection date is longer than the specified Take data every setting. 

 The Take data every field is used to determine if a POINT is 

overdue for data collection.   

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the hierarchy’s “current data” bin and select the 

appropriate units (Wk(s), Mo(s), Yr(s)).  When the specified time from data 

collection elapses, and a Scheduled or Monitor archive process is performed, 

the measurement is typically moved from the “current data” bin into the “short 

term archive” bin (or discarded) as specified in the Short term archive / 

Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Example - Using a data manager, you may select to Take data every <30 

days> and Keep current data for <1 Yr>.  If you use Analyst’s Scheduler 

feature to schedule an archiving process every month, no archiving will 

take place for the first year.  After the first year, on a monthly basis,  all 

measurement records in the “current data” bin whose date / timestamp 

is older than 1 year from the current date will either be placed in the 

“short term archive” bin (if short term criteria are met) or discarded. 



Working With Your SKF @ptitude Inspector Hierarchy 

POINT Properties 

2 - 38 SKF @ptitude Inspector  

 User Manual 

 

Figure 2 - 18. 

The POINT Properties Dialog’s Compliance Tab – Calendar-Based. 

Calendar-based fields include: 

Compliance name – Select a pre-configured compliance schedule from the drop down 

list.   

 Create and edit compliance schedules on the Customize / 

Database / Compliance tab.  Reference Chapter 3’s Customize / 

Database Operations section for details. 

Starting from – Displays the initial start date / time of when the data collection interval 

is scheduled. 

Data due every – Displays the frequency of when the scheduled data collection is due.  

The POINT becomes overdue if data collection does not take place within the scheduled 

interval. 

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the hierarchy’s “current data” bin and select the appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time from data collection elapses, and a 

Scheduled or Monitor archive process is performed, the measurement is typically 

moved from the “current data” bin into the “short term archive” bin (or discarded) as 

specified in the Short term archive / Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Short term archive (optional, but typically enabled) 

Fields in the short term archive section include: 

Archive data every – Determines whether data leaving the “current data” bin 

is archived in the “short term archive” bin.  Enter numerical value to indicate 

how often data leaving the “current data” bin is stored in the “short term 

archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As scheduled 

archives occur, measurements leaving the “current data” bin are accepted into 

the “short term archive” bin only if this Archive data every setting has expired 
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since the last measurement was stored in the “short term archive” bin.  

Otherwise, they are discarded. 

Example - To continue with our example of a scheduled monthly archive.  

If we set this Archive data every setting to three months, on the 13th 

month of data collection, the measurement(s) leaving the “current data” 

bin are placed in the “short term archive” bin as there is no data yet 

stored in the “short term archive” bin.  On months 14 and 15, 

measurement(s) that exceed the Keep for setting and leaving the 

“current data” bin are discarded, as three months have not expired since 

the last “short term archive” data was stored.  On month 16, 

measurement(s) leaving the “current data” bin are three months newer 

than the last measurement stored in the “short term archive” bin, and 

are therefore stored in the “short term archive” bin.  Thus, by configuring 

this setting to three months, you are able to “thin” the data stored in the 

“short term archive” bin (store short term archive data every three 

months instead of every month). 

Keep archive for – Enter a value to indicate how long to keep (store) the 

measurement record in the “short term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process performed, the measurement is typically moved 

from the “short term archive” bin into the “long term archive” bin (or discarded) 

as specified in the Long term archive fields. 

Fields in the long term archive section include: 

Archive data every – Determines whether data leaving the “short term 

archive” bin is archived in the “long term archive” bin.  Enter numerical value to 

indicate how often data leaving the “short term archive” bin is stored in the 

“long term archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As 

scheduled archives occur, measurements leaving the “short term archive” bin 

are accepted into the “long term archive” bin if this Archive data every setting 

has expired since the last measurement was stored in the “long term archive” 

bin. 

Keep archive for – Enter value to indicate how long to keep (store) the 

measurement record in the “long term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process is performed, the measurement is discarded. 

Unscheduled data 

The last section of the tab schedules alarm data.  In on-line DAD systems, alarm data is 

automatically placed in the “Unscheduled data” bin.  This setting determines how long 

alarm data is stored in the alarm data bin before it is discarded.   Fields include: 

Keep for – Specify value to indicate the desired length of time to store alarm 

data and select appropriate units (Wk(s), Mo(s), Yr(s)).  After the specified 

storage time elapses, the alarm data is discarded. 
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Filter Keys Tab 

 

Figure 2 - 19. 

The POINT Properties Dialog’s Filter Keys Tab. 

@ptitude Inspector allows you to create Filter Keys which can be associated with 

POINTs and Machines for automated filtering purposes.  For example, if you activate a 

“Pump” filter key for a Group and later filter a hierarchy list using the Filter Key / 

Pump, then all Groups with active Pump filter keys display in the filtered Workspace. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab lists all created filter keys and indicates whether or not 

they are currently assigned.   

 Click a specific filter key’s checkbox to associate it to the current POINT. 

 The checkbox appears gray if the filter key is enabled for a parent 

hierarchy item. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 
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Overall Tab 

The Overall tab allows you to re-apply previously defined “shared” overall alarms, 

eliminating the need to define alarms individually, saving time and database space. 

Use the Overall tab to set a process POINT’s overall alarm settings.  The alarm can be 

configured in a variety of ways using the Overall tab’s fields. 

The current alarm appears in the Overall alarm field.  The current alarm’s values 

display below in the dialog’s Properties and Settings areas. 

 

Figure 2 - 20. 

The POINT Properties Dialog’s Overall Tab. 

The Overall alarms drop down list displays all previously created overall alarms and a 

<Private Alarm> option.  Use this drop down list to specify whether you wish to set up 

a unique  <Private Alarm> for the current POINT only, or specify a previously defined 

“shared” alarm (selected by name).  If you specify a shared alarm, it’s alarm settings 

automatically display in subsequent fields.  If you specify a Private Alarm, proceed to 

configure the tab’s alarm settings as described below. 
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The Properties area options relate to Alert and Danger alarm detection values specified 

in the Settings area.  Select from: 

None – No overall alarm is set for the POINT. 

Level – Measurements exceeding the specified Settings will result in an alarm 

condition. 

In Window – Measurements falling within the specified Settings will result in 

an alarm condition. 

Out of Window – Measurements falling outside the specified Settings will 

result in an alarm condition. 

To assign a shared alarm to the current POINT: 

 Select the shared alarm from the drop down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Shared Alarm 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

The Share As dialog specifies the alarm as a shared alarm.  When the Share As dialog 

displays, you will be prompted to give the shared alarm a unique name for easy 

identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop down list.  

Shared alarms are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 
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Messages 

The Messages tab allows you to apply previously defined “shared” alarm messages, and 

to create new alarm messages for various alarm levels and pre- and post- 

measurement instructions. 

 

Figure 2 - 21. 

The POINT Properties Dialog’s Messages Tab. 

@ptitude Inspector's POINT Properties / Messages feature allows you to create and 

assign up to six alarm messages for process POINTs, four corresponding to the four 

overall alarm levels; Overall Alert High, Overall Alert Low, Overall Danger High, and 

Overall Danger Low, and two for pre-measurement and post-measurement 

instructions.  You can create up to eight alarm messages for MCD POINTs, six 

corresponding to the six MCD alarm levels, MCD Env Acc Alert, MCD Env Acc Danger, 

MCD Temperature Alert, MCD Temperature Danger, MCD Velocity Alert, MCD 

Velocity Danger, and two for pre-measurement and post-measurement instructions.  

The Messages context area displays type of messages available for assignment and 
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any existing alarm messages already applied.  You can assign a created shared alarm 

message to one or more alarm levels, or create a new private alarm message and apply 

it to the selected POINT. 

The Name drop down list displays all previously created alarm messages and a 

<Private> option.  Use this drop down list to specify whether you wish to set up a 

unique <Private> message for the current POINT only, or specify a previously defined 

“shared” message (selected by name).  If you specify a shared message, its format, 

summary, and content automatically display in subsequent fields.  If you specify a 

Private message, proceed to configure the message settings as described below. 

 For more information on creating and managing public alarm 

messages, refer to the Customize / Database Operations section 

later in this chapter. 

Format – This drop down list allows you to specify your alarm message's format. 

Free form – Allows you to manually type in the summary and content for your 

alarm message. 

Hyperlink – Allows you to create a link to an existing file on your DAD.  During 

data collection, when the specified message condition is met, the originating 

application (Word, Acrobat) launches the machine's hyperlinked message file on 

the unit.  When the message condition occurs, an Instruction (i) button 

becomes available (un-ghosts) on the display.  Tap this Instruction (i) button 

to display the message. This feature allows you to associate detailed 

instructions with particular POINTs while still keeping downloads small and 

efficient.  The message file and the application used to create the message 

must both be present on the DAD.  Message files are downloaded to the DAD 

using ActiveSync.  Reference your ActiveSync User Manual for more 

information. 

Summary – Type in text summarizing your alarm message for easy recognition.  For 

example, if you have an alarm message that details shut down instructions in the case 

of an overall danger high alarm level, your summary may read, "Emergency Shut Down 

Instructions." 

Content – This field allows you to specify the body of the message. 

Freeform – Enter your complete alarm message in the content text area.  

Using the above example, your alarm message content would include detailed 

shut down instructions, and any other pertinent information required in the 

case of the triggered alarm type. 

Hyperlink message – Enter the path and filename for the file you wish to 

associate with the message.  For example, C:\\MARLIN Instructions\\FD 

FAN\\Data Collection Instructions.doc. 

To assign a shared message to the current POINT: 

 Select the shared message from the drop down list and click the OK button.  

Shared messages may be applied to an unlimited number of POINTs. 
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Shared Message 

Alarm messages initially created as private messages may be converted into shared 

(public) messages.  To share a newly created Private message, select the new Private 

message and click the tab’s Share As button. 

The Enter Name dialog specifies the message as a shared (public) message.  When the 

Enter Name dialog displays, you will be prompted to give the shared message a unique 

name for easy identification.   

 Enter a name for the shared message and click the OK button. 

 The new shared message now appears as an available selection in the dialog's drop 

down list.  Shared messages are easily assigned to other POINTs to simplify POINT 

setup and maintenance. 

Notes Tab 

The POINT Properties / Notes tab allows you to attach a text note to the POINT along 

with a date / time stamp.  This feature conveniently stores and records relevant POINT 

information such as maintenance history. 

 Coded notes uploaded from the DAD for the current Machine 

display in the Notes tab. 

 Click the Notes tab’s Add button to add a new note and date / time stamp. 

 Click the Save button to save edits made to a note. 

 Click the Undo button to cancel edits made to a note. 

 Click the Remove button to remove the selected note from the display. 

POINT Properties / Notes fields include: 

Date – Select the current date from the drop down list. 

Time – Select the current time. 

The selected date and time appear in the dialog’s left Notes field. 

Text – Type in desired note text in the text field. 

 Click the tab’s OK button to save all entries. 

Images Tab 

Scanned photographs or digital images can be added to a particular POINT, stored in 

the database, and viewed from the Images tab.  Images help identify SETs / machines, 

organize similar equipment, and document known defects. 

POINT Properties / Images fields include: 

Image – All attached images display in the drop down list. 

Description – Enter text to identify the image.  Click the Save button to save your 

description entry.  If saved, the new description replaces the filename in the Images list. 

To add a new image: 
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 Click the Add button to add a new image.  The Windows’ Open dialog displays.  

Select desired image and click Open to add or Cancel to undo. 

 Added images use the filename as the default description. 

To replace the current image file with a newer image: 

 Click the Browse button. 

 Select a replacement image file.  The new image displays on the tab. 

 The image name and description of the old image are retained for 

the replacement image. 

 Click Save to confirm the image replacement. 

 Click Cancel to undo the image replacement. 

To export an image to a specific location: 

 Select the image to export. 

 Click the Export button. 

 When prompted, enter the desired export location and filename and click OK. 

The image is copied and saved to the specified location, but still remains attached to the 

assigned POINT.  
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Setup Log 

The POINT Properties’ Setup Log tab records changes made to the POINT’s 

configuration.   

 

Figure 2 - 22. 

The POINT Properties Dialog’s Setup Log Tab. 

POINT Properties / Setup Log fields include:  

Date/Time – Displays the date/time stamp when the change occurred. 

User – Displays the user’s name that made the change. 

Category – Displays the POINT properties tab to which changes were made. 

Previous Value – Displays the previous value before the current change occurred. 

Reason – Displays the user entered reason for making a change to the POINT’s 

configuration.  If no reason is required or entered, this column is empty.   

 When you make a change to a POINT’s properties, you are 

requested to enter a reason for the change.  Reference Chapter 2 

- Setting Your @ptitude Analyst Preferences in the SKF 

@ptitude Analyst Introduction and Global Features user manual 

for details.. 

Save As – Click to save a copy of the log file to your computer’s hard drive.   

Print – Click to print a copy of the log file. 
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POINT Setup Validation Dialog 

The POINT Setup Validation Dialog launches when you enter incompatible or erroneous 

information on the Setup or Expressions tabs.   

The POINT Setup Validation dialog displays both errors and recommendations.  For 

recommendations, a message box displays prior to the POINT Setup Validation dialog, 

which allows you to ignore or view the POINT Setup Validation dialog. 

 

Figure 2 - 23 

The POINT Setup Validation Recommendation Message Box. 

 If you do not wish to see the POINT Setup Validation Message Box for 

recommendations or warnings, uncheck and disable the Show this message box 

again checkbox.   

 You may also modify this preference from the Customize menu's 

Preferences dialog. 

 Press Yes to view the POINT Setup Validation dialog.  

 Press No if you wish to close the message box without viewing the 

recommendation details. 
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Figure 2 - 24. 

The POINT Setup Validation Dialog for the Setup tab. 

 

Figure 2 - 25. 

The POINT Setup Validation Dialog for the Expressions tab. 

 The POINT Setup Validation dialog displays automatically for 

settings in error, and after the message box for settings that are 

recommendations or warnings. 

You may edit POINT setup information while the POINT Setup Validation dialog is 

displayed.  Simply move the dialog out of the way, and make any changes to your 

POINT Properties / Setup or Expressions tab while referencing the errors or 

recommendations. 
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 Press the Refresh button if you have made corrective changes to your POINT 

Properties / Setup or Expressions tab in the background.  If you have eliminated 

the error or recommendation, they will no longer display in the POINT Setup 

Validation dialog. 

 Press the Close button to close the POINT Setup Validation dialog and return to 

the POINT Properties Setup or Expressions tab. 

Multiple POINT Properties 

The Multiple POINT Properties dialog is available when more than one POINT is 

selected.  This dialog provides a set of tabs to view and modify set-up parameters 

common among the set of selected POINTs.  The type of POINTs selected determine 

which tabs display in the Multiple POINT Properties dialog.   

 Configured parameters overwrite each selected POINT’s previous 

settings. 

MCD Tab 

The MCD tab allows you to re-apply MCD alarm settings, eliminating the need to define 

alarms individually, which saves time and database space. 

 

Figure 2 - 26. 

The Multiple POINT Properties Dialog's MCD Tab. 

Use the MCD tab to view and set POINTs’ MCD alarms.  The alarm can be configured in 

a varied of ways using the MCD tab’s fields and graphic displays. 
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The current alarm appears in the MCD Alarms field.  The current alarm’s values display 

graphically and numerically below in the dialog’s Settings areas, divided into each MCD 

measurement type: Env. Acceleration, Velocity, and Temperature. 

 The MCD Alarms drop-down list displays all previously created 

overall alarms and a <Private Alarm> option.  Use the <Private 

Alarm> selection to create a private (unique) MCD alarm for use 

with the current POINTs only. 

The Settings area allows you to enable and configure Danger and Alert alarms for 

each MCD measurement type.  

To assign a shared alarm to the current POINTs: 

 Select the shared alarm from the drop-down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Sharing MCD Alarms 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

When the Share As dialog displays, you will be prompted to give the shared alarm a 

unique name for easy identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop-down list. 

Inspection Tab 

The Inspection tab allows you to re-apply Inspection alarm condition settings, 

eliminating the need to define alarms individually, which saves time and database space. 

 Inspection results and conditions cannot be modified if data has 

been collected for the POINTs. 
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Figure 2 - 27. 

The Multiple POINT Properties Dialog's Inspection Tab. 

Use the Inspection tab to view and set POINTs’ Inspection settings and alarm conditions 

for POINTs without data.   

 Fields are unavailable if POINTs already have collected data. 

The current alarm appears in the Inspection alarms field.  The current inspection 

results and alarm conditions display below in the Result and Conditions areas. 

 The Inspection alarms drop-down list displays all previously 

created inspection alarms and a <Private Alarm> option.  Use the 

<Private Alarm> selection to create a private (unique) Inspection 

alarm for use the current POINTs only. 

The Results and Conditions areas allow you to enable and configure a set of result 

options and their corresponding alarms from the drop-down lists. 

To assign a shared alarm to the current POINTs: 

 Select the shared alarm from the drop-down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Sharing Inspection Alarms 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 
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When the Share As dialog displays, you will be prompted to give the shared alarm a 

unique name for easy identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop-down list. 

Schedule Tab 

The Schedule tab allows you to set a common schedule for all the currently selected 

POINTs. 

 

Figure 2 - 28. 

The Multiple POINT Properties Dialog's Schedule Tab. 

Fields in the data collection portion of the Schedule tab include: 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Second(s), 

Minute(s), Hour(s), Day(s)).  The POINT is tagged as overdue for data 

collection if the time range between the current date (today) and the last data 

collection date is longer than the specified Take data every setting. 

 The Take data every field is used to determine if a POINT is 

overdue for data collection.   

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the database’s “current data” bin and select the 

appropriate units (Wk(s), Mo(s), Yr(s)).  When the specified time from data 



Working With Your SKF @ptitude Inspector Hierarchy 

Multiple POINT Properties 

2 - 54 SKF @ptitude Inspector  

 User Manual 

collection elapses, and a Scheduled or Monitor archive process is performed, 

the measurement is typically moved from the “current data” bin into the “short 

term archive” bin (or discarded) as specified in the Short term archive / 

Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Short term archive (optional, but typically enabled) 

Fields in the short term archive section include: 

Archive data every – Determines whether data leaving the “current data” bin 

is archived in the “short term archive” bin.  Enter numerical value to indicate 

how often data leaving the “current data” bin is stored in the “short term 

archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As scheduled 

archives occur, measurements leaving the “current data” bin are accepted into 

the “short term archive” bin only if this Archive data every setting has expired 

since the last measurement was stored in the “short term archive” bin.  

Otherwise, they are discarded. 

Keep archive for – Enter a value to indicate how long to keep (store) the 

measurement record in the “short term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process performed, the measurement is typically moved 

from the “short term archive” bin into the “long term archive” bin (or discarded) 

as specified in the Long term archive fields. 

Fields in the long term archive section include: 

Archive data every – Determines whether data leaving the “short term 

archive” bin is archived in the “long term archive” bin.  Enter numerical value to 

indicate how often data leaving the “short term archive” bin is stored in the 

“long term archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As 

scheduled archives occur, measurements leaving the “short term archive” bin 

are accepted into the “long term archive” bin if this Archive data every setting 

has expired since the last measurement was stored in the “long term archive” 

bin. 

Keep archive for – Enter value to indicate how long to keep (store) the 

measurement record in the “long term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process is performed, the measurement is discarded. 

Unscheduled data 

The last section of the tab schedules alarm data.  In on-line DAD systems, alarm data is 

automatically placed in the “Unscheduled data” bin.  This setting determines how long 

alarm data is stored in the alarm data bin before it is discarded.   Fields include: 

Keep for – Specify value to indicate the desired length of time to store alarm 

data and select appropriate units (Wk(s), Mo(s), Yr(s)).  After the specified 

storage time elapses, the alarm data is discarded. 
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Filter Keys Tab 

@ptitude Inspector allows you to create Filter Keys which can be associated with 

POINTs and Machines for automated filtering purposes.  For example, if you activated a 

“Pump” filter key for a Group and later filtered by Filter Key / Pump, the group would 

display. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab displays all created filter keys and indicates whether or 

not they are currently assigned.   

 Click a specific Filter Key’s checkbox to associate it with the current Group. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 

 The checkbox appears gray if the filter key is assigned to the 

current group only because it was assigned to the group’s parent. 

 Click the Filter Key dialog’s OK button to save your filter key 

assignments. 

Overall Tab 

The Overall tab allows you to re-apply previously defined “shared” overall alarms, 

eliminating the need to define alarms individually, saving time and database space. 

 

Figure 2 - 29. 

The Multiple POINT Properties Dialog's Overall Tab. 
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Use the Overall tab to set Process POINTs’ overall alarms.  The alarm can be configured 

in a variety of ways using the Overall tab’s fields. 

The current alarm appears in the Overall alarm field.  The current alarm’s values 

display below in the dialog’s Properties and Settings areas. 

The Overall alarms drop down list displays all previously created overall alarms and a 

<Private Alarm> option.  Use this drop down list to specify whether you wish to set up 

a unique  <Private Alarm> for the current POINTs only, or specify a previously defined 

“shared” alarm (selected by name).  If you specify a shared alarm, it’s alarm settings 

automatically display in subsequent fields.  If you specify a <Private Alarm>, proceed to 

configure the tab’s alarm settings as described below. 

The Properties area displays alarm detection options.  Select from: 

None – No overall alarm is set for the POINTs. 

Level – Measurements exceeding the set levels will result in an alarm 

condition. 

In Window – Measurements falling within the set levels will result in an alarm 

condition. 

Out of Window – Measurements falling outside the set levels will result in an 

alarm condition. 

To assign a shared alarm to the current POINTs: 

 Select the shared alarm from the drop down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Shared Alarm 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

The Share As dialog specifies the alarm as a shared alarm.  When the Share As dialog 

displays, you will be prompted to give the shared alarm a unique name for easy 

identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop down list.  

Shared alarms are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 
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Modify by Attribute 

@ptitude Inspector’s Modify by Attribute feature allows you to make similar changes 

for one or more machines or POINTs by allowing you to change specific attributes (for 

example, alarm values, collection schedules, etc.) all at once. 

 POINT setup changes made in Modify by Attribute are not 

incorporated into POINT Properties. 

 

Figure 2 - 30. 

The Modify by Attribute dialog. 

To Modify Settings: 

 Select the hierarchy group (SET / Machine) that contains POINTs whose attributes 

you wish to modify. 

 All Groups and POINTs branching from the specified Group display 

in the Modify by Attribute dialog.   

 Select the Edit menu’s Attributes option.  The Modify by Attribute dialog displays. 

The Modify by Attribute dialog is split into two panels: 

Right panel - displays the selected hierarchy items and their value for the 

currently selected attribute in the left panel. 

 Click to highlight the POINT for which you wish to modify the selected 

attribute.  Its current setting / value displays in an area beneath the 

panels. 
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Left panel - displays the attributes available for modification organized into six 

categories: Alarm Settings, Derived Settings, FFT Settings, General 

Settings, Messages, and Misc. Settings. 

 If you have in the full version of @ptitude Analyst (CMSW7400), you will 

also have Multi-Channel Settings, On-line Settings, and Orbit/SCL 

Settings options.  Open the appropriate category’s folder to view its 

attributes, then click to specify the attribute you wish to modify.  The 

right panel updates to show the selected attribute’s current setting for 

each item. 

 Edit the setting. 

 Click the Set button to update the attribute setting for the selected POINT only, or 

click the Set All button to update the attribute setting for all POINTs in the right 

panel.  

 Use the Set All feature to quickly modify an attribute value for 

multiple items simultaneously.  For example, if you want to set all 

Averages to an identical value, select Averages from the 

Attributes list.  Attribute values display for all items in the tab's 

Attribute values area.  Select an individual item, enter the 

desired value, and click the Set All button.  All items will now have 

the specified number of averages. 

 After completing attribute modifications for all POINTs, click the OK button to save 

the settings in the database. 

Measurement Properties 

General Tab 

The Measurement Properties dialog displays properties for individual measurement 

data records.   

To view / edit a measurement’s properties: 

 Select the measurement record.  

 Select the Edit menu’s Properties option, or use the Properties toolbar button.  

The Measurement Properties dialog displays.  

The current measurement’s time and date appears in the Date and Time fields of the 

Measurement Properties / General tab.   

Measurement Properties fields include: 

Date - View or edit the measurement record’s data collection date.  Select a new date 

from the drop down list.   

Time - View or edit the measurement record’s data collection time.   Use the arrows to 

adjust the time. 

 This feature should only be used to edit an incorrect date or time. 
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Overall / Channel # - View or edit the measurement record’s overall value.  Values are 

displayed for Channel 1 and/or Channel 2 as applicable.  

 

Figure 2 - 31. 

The Measurement Properties Dialog’s General Tab's Overall Area. 

 The Overall area is only available for Process POINTs. 

 This feature should only be used to edit an incorrect overall value.  

 If necessary, the measurement’s alarm status will automatically 

update for the new measurement value.   

Exclude measurement - Enables / disables the measurement record for inclusion in 

statistical calculations. 

Readings - Displays which readings correspond to the current measurement on the 

indicated date / time.  

 

Alarm status will be automatically updated for the new current measurement, if 

necessary.   

The overall value for the current Process measurement's indicated date / time appears 

in the tab’s Overall area.  Values are displayed for Channel 1 and/or Channel 2 as 

applicable.  These values may be edited in the General tab.  Enter a new value in the 

appropriate channel’s text box. 

 This feature should only be used to edit an incorrect overall value.  

The tab’s Readings area displays which readings correspond to the current 

measurement on the indicated date / time. 

 Click the Exclude measurement checkbox to exclude the current measurement 

from being included in statistical calculations. 

 After editing all necessary properties, click the OK button to save changes. 

 Click Cancel to close the dialog without saving changes. 
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MCD Tab 

 

Figure 2 - 32. 

The Measurement Properties Dialog’s MCD Tab. 

The Measurement Properties’ MCD tab displays the current measurement’s Env. 

Acceleration, Velocity, and Temperature values.  Edit current values in the 

appropriate text box. 

 This feature should only be used to edit an incorrect reading. 

Alarms will be automatically updated for the new current measurement, if necessary.   

 Click the OK button to save changes. 

 Click Cancel to close the dialog without saving changes. 
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Inspection Tab 

 

Figure 2 - 33. 

The Measurement Properties Dialog’s Inspection Tab. 

The Measurement Properties’ Inspection tab displays the current measurement’s 

Inspection reading.  Edit current values using either the option buttons (Single-Select 

Inspection POINTs) or the checkboxes (Multi-Select Inspection POINTs). 

 This feature should only be used to edit an incorrect reading. 

Alarms will be automatically updated for the new current measurement, if necessary.   

 Click the OK button to save changes. 

 Click Cancel to close the dialog without saving changes. 
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Set Speed (Multiple) 

Use the Set Speed (Multiple) feature to set the same measurement speed for multiple 

FFT measurements: 

 Starting from a hierarchy, ROUTE, or workspace, expand the appropriate machine. 

Beneath the machine in the hierarchy, right-click on the measurement POINT you 

wish to use as a reference and select Set Speed (Multiple) from the resulting 

context menu. 

OR 

 Starting from a hierarchy, ROUTE, or workspace, expand the appropriate machine. 

Beneath the machine in the hierarchy, click on the appropriate measurement 

POINT to display its measurements in the right panel. Then, right-click on the 

single measurement you wish to use as a reference and select Set Speed 

(Multiple) from the resulting context menu. 

OR 

 Starting from an FFT measurement plot, right-click on the single cursor and select 

Set Speed (Multiple) from the resulting context menu. 

 

 

Figure 2 - 34. 

Selecting Set Speed (Multiple) from a POINT Versus from a Measurement within a Hierarchy. 

 



 Working With Your SKF @ptitude Inspector Hierarchy 

 Set Speed (Multiple) 

 

SKF @ptitude Inspector 2 - 63 

User Manual 

 

Figure 2 - 35. 

Selecting Set Speed (Multiple) from an FFT Measurement Plot. 

 

The Set Speed (Multiple) window appears. 

 

Figure 2 - 36. 

Set Speed (Multiple) Window. 

 Expand the machine in the Set Speed (Multiple) window’s hierarchy view and 

deselect (remove checks from) any POINTs for which you do NOT intend to set a 

measurement speed value. By default, all POINTs are selected (checked) for 

adjustment. 

 Specify the range of measurements for which you intend to set a measurement 

speed value: 

Last measurement – Select to work only with the last measurement collected 

for each selected POINT. 
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Measurements + / - … minutes – Select, then specify x number of minutes to 

work only with measurements collected within the range starting x minutes 

prior to and ending x minutes following the basis date and time. 

 If you selected a POINT as the reference (launched this window 

from a POINT), the basis date and time are equal to the date/time 

stamp of the POINT’s last measurement. If you selected a single 

measurement as the reference (launched this window from a 

single measurement or from an FFT plot), the basis date and time 

are equal to the date/time stamp of that measurement. 

 The system will remember the specified number of minutes when 

you launch this dialog again. 

Measurements… From… To… - Select, then specify starting and ending dates 

and times to work only with measurements collected within that range. 

 By default, this range starts x minutes prior to and ends x 

minutes following the basis date and time, based on the current 

Measurements + / - … minutes setting. 

 Select, then enter an MPA Tag value to work only with measurements that contain 

that value in their Description (Point Properties > General tab). 

 Click Next>>. The Set Speed (Multiple) Measurement List window appears, 

displaying a list of all measurements for the applicable POINTs that meet the 

criteria established. 

 

The Set Speed (Multiple) Measurement List window displays a list of all 

measurements for the applicable POINTs that meet the criteria established in the Set 

Speed (Multiple) window. 

 

Figure 2 - 37. 

Set Speed (Multiple) Measurement List Window. 
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 From the measurement list, select (check) each measurement to which you intend 

to apply the reference POINT’s measurement speed. 

 Select (check) the checkbox in the list header to select all 

measurements. 

 To change the criteria established in the previous window that 

determine the measurements in this list, click <<Back. 

 Click on any column header to sort the list according to that 

column. 

 Verify and/or enter Set Speed values. 

Current Frequency – The speed value from the reference POINT 

measurement. 

 If you initially selected a POINT as the reference, this speed value 

comes from the POINT’s last measurement. If you initially 

selected a single measurement as the reference, this speed value 

comes from that measurement. If you launched this function from 

an FFT plot, this speed value is the frequency value of the single 

cursor on that FFT plot. 

Equivalent to order – If the speed value entered is at a known harmonic, then 

you can use this value to factor the Calculated running speed to its 1x 

component. 

Calculated running speed – Enter the speed value you wish to apply to all 

selected (checked) measurements. 

 Click Finish. The system applies the Calculated running speed and Equivalent to 

order values to all measurements selected (checked) in this list. 

Calculate Derived POINTs 

You must manually calculate derived POINTs upon the initial creation of a derived 

POINT, or after editing a derived POINT’s expression settings.  Once the initial 

calculation has been performed manually, MARLIN / Microlog Inspector  automatically 

calculates the derived POINT during data collection.   

 Upon the initial creation of a derived POINT, if the assigned 

variables do not have existing measurement data, it is not 

necessary to manually calculate the derived POINT.  It is 

necessary to manually calculate a derived POINT only when the 

assigned variables already have measurement data. 

To manually calculate a derived POINT: 

 Select the newly created or recently edited derived POINT from the Hierarchy. 

 Select the Edit menu's Calculate Derived POINTs option to quickly calculate 

measurement values for the derived POINT. 

 The Calculate Derived POINTs message dialog displays.  Select Yes to calculate 

the selected derived POINT. 
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 If calculating a newly created derived POINT, new measurement 

data displays in the Hierarchy’s right panel.  Existing 

measurement data for the assigned variables is used in the 

calculation to create measurement data records for the derived 

POINT.   

 If calculating a recently edited derived POINT, all existing derived 

POINT measurement values previously calculated for the selected 

derived POINT(s) are deleted and replaced with new derived 

POINT measurements. 

 

Figure 2 - 38. 

The Edit menu’s Calculate Derived POINTs Message Dialog. 

IMPORTANT – The measurement data for a derived POINT’s variables must be 

collected before the derived POINT can be calculated.  For example, if two variables 

are assigned to a derived POINT, POINTs A and B in the ROUTE should be the 

variables, and POINT C should be the derived POINT.  This allows the derived 

POINT to be calculated using the variables’ new measurement data. 

When downloading a ROUTE with derived POINTs to the MARLIN / Microlog Inspector, 

the derived POINT settings also download to the MARLIN / Microlog Inspector.  

Derived POINTs are then calculated during ROUTE data collection.  The operator must 

perform normal data collection on the derived POINT (highlight the derived POINT and 

press the Collect button). 

When @ptitude Inspector uploads MARLIN / Microlog Inspector derived POINTs, the 

measurement data area automatically updates with the new derived POINT 

measurements. 

Manual Archive 

@ptitude Inspector’s Manual Archive feature adds flexibility as it allows you to specify 

POINTs to archive, and allows you to archive the newest data in addition to the oldest 

data. 

The Manual Archive process differs from a Scheduled or Monitor archive process in 

several ways.   

Manual Archive: 

 Takes place immediately.   

 Archives only POINTs branching from the selected hierarchy item (or specified 

measurement records). 

 Only archives measurements from the “current data” bin (unless a specific 

measurement record from another bin is specified). 
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 Allows you to specify whether to archive each selected POINT’s Oldest or Newest 

measurement record from the current data bin. 

 Allows you to specify the archive bin in which to place the archived measurements. 

Use Manual Archive to change the archive status for any or all hierarchy items.  

Manual Archive is useful to manually set a measurement’s archive status, bypassing 

automatic archive schedule (if applicable). 

To use manual archive: 

 In the hierarchy list, select a hierarchy item(s) whose measurements you wish to 

manually archive.  All POINTs branching from the selected item are archived. 

 Select the File menu’s Manual Archive option.  The Manual Archive dialog 

displays. 

The dialog’s top area displays a warning if the selected data is tagged as baseline.  

Baseline data cannot be modified. 

Change archive status in the dialog’s Store measurements as area.  Select from: 

Current data bin (available only when archiving a measurement record from 

other bins) 

Unscheduled data bin 

Short term archive data bin 

Long term archive data bin 

The dialog’s bottom area displays Archive measurements.  If working from a POINT or 

above on the hierarchy branch, select from: 

Oldest Measurement – Each selected POINT’s oldest measurement in the current data 

bin. 

Newest Measurement – Each selected POINT’s newest measurement in the current 

data bin. 

 Manual Archive does not utilize “scheduled” archive settings 

@ptitude Inspector Scheduler 

Current Scheduled Events 

The Scheduler feature allows you to configure the software to perform scheduled 

functions based on specific conditions.  A scheduled event consists of a system event 

and an action to be executed whenever that event occurs. For example, you can use 

Scheduler to configure the software to display a message when a specific operation 

completes (action) when a DAD has completed processing (system event). 

 Select the Customize menu’s Scheduler option.  The Scheduler dialog displays. 

The Scheduler dialog displays all current scheduled events and the action assigned to 

each event.  Use the Scheduler dialog to add new events and maintain existing events. 
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To add an event:  

 Click the Add button to define an event.  The Event Scheduler Wizard launches 

automatically. 

You can also add an event by copying an existing event, then modifying the copy as 

necessary. 

To copy an event:  

 Highlight the event you would like to copy and click Copy.  The Event Scheduler 

Wizard launches.  As you navigate the wizard, options default to the settings from 

the copied event.  You may modify the settings as necessary. 

To edit an event:  

 Highlight the event you would like to modify and click Edit.  The Event Scheduler 

Wizard launches with the settings from the event you are editing.   

 Navigate the wizard to the settings you wish to modify and edit the event as 

necessary. 

To remove an event:  

 Click the Remove button to delete a scheduler entry. 

 Scheduled entries remain in effect until they are removed. 

Event Scheduler Wizard 

A scheduled event consists of a system event and an action to be executed whenever 

that event occurs.   

 Scheduled events can only execute if the application is running.  

For example, if your event is a specific time, such as three a.m., 

your specified action will not be performed if the program is shut 

down at three a.m., and it will not be automatically performed 

when the program is restarted. 

The Event Scheduler Wizard guides you through the process of scheduling events. 

 Click the Next button to continue. 

 Select the event you want the system to monitor and that will cause the scheduled 

action to be performed.  All available events appear in the Select an event window.   
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Figure 2 - 39. 

The Event Scheduler Wizard. 

Some events require specific settings that further define the event.  When settings are 

required, the Settings button is enabled.  You must specify the required Settings 

before the Next button is enabled. 

 Complete all Settings entries, if required. 

 Click the Next button. 

 Individual events are detailed later in this section. 

All available actions display in the Select an action area. 

 Select the action you wish the system to perform when the indicated event occurs. 

Some actions require specific settings that further define the action.  When settings are 

required, the Settings button is enabled.  You must specify the required Settings 

before the Next button is enabled. 

 Complete all Settings entries, if required. 

 Click the Next button. 

 Individual actions are detailed later in this section. 

By default, scheduled events only execute if the user who created the event performs 

the triggering action.  (For example, a report set to run on @ptitude Analyst startup only 

runs when the user who created the event logs in.)   

If the user creating the scheduled event is an administrator, an additional dialog displays 

providing the option of assigning the event to another user, or delegating it to the 

Transaction Server.  

The Select Users list shows all @ptitude Analyst users.   

 Select the user who should trigger this event. 

 Events scheduled to trigger at a specified time only occur if the 

user with whom the event is associated is logged into @ptitude 

Analyst.  This applies to both users who are assigned an event by 
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an administrator and non-administrator users who create an 

event for themselves.  For example, if the event is scheduled for 

three a.m., the specified action will not be performed if the 

designated user is shut down at three a.m., and it will not be 

automatically performed when the program is restarted.  

Alternatively, if you have selected to generate a report with this scheduled event, 

Delegate to Transaction Server enables.  The transaction server is a process that 

stays running in the background at all times.  If your triggering event is on MARLIN / 

Microlog Inspector upload, this option allows you to have the transaction server 

generate the report whenever any user uploads MARLIN / Microlog Inspector data.  If 

your triggering event is a specified time, the report runs at that time, regardless of 

whether the associated user is logged in.  

 The report is generated to a file in the path specified in the Report 

Location field on the Report Generator’s Assign tab.  If the 

Delegate to Transaction Server option is selected and the report 

location path references a local hard drive, the report is written to 

the Transaction Server host computer.  It is recommended that 

you set the report location to a network drive and make sure the 

Transaction Server has read / write access to that location. 

 Enable Delegate to Transaction Server to have the transaction server generate 

the report, rather than a specified user. 

 Click the Next button. 

The Event Scheduler Wizard displays a summary of the new scheduled event settings. 

 Click the Finish button to save the scheduled event. 

 Click the Back button to modify the scheduled event. 

 Click the Cancel button to cancel the wizard dialog. 

Scheduler Events 

Alarm condition 

This event is used to schedule an action to be performed when specific alarms occur. 

 Click the Settings button to specify the data source, alarm condition, and alarm 

type for which this event should occur.  The Alarm Condition Settings dialog 

displays. 

Data source –Select the Hierarchies, SETs, Machines, POINTs, ROUTEs, and / or 

Workspaces to monitor for alarm conditions. 

Alarm Conditions –Select the alarm condition (In alert, In danger, or Both) to monitor. 

Alarm Type – Select one or more alarm types to monitor. 

 Click OK to save settings. 

 Click Cancel to discard settings. 
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Analyst startup 

This event is the application’s start up.  Performs an action as soon as the application 

completes its startup process. 

At specified time 

Schedules a task to be performed at a specific time.   

 Click the Settings button to specify the time that this event should occur.  The 

Time Event Settings dialog appears. 

Start Date - Select the date on which the scheduled event should run for the first time. 

Start Time – Select the time at which the scheduled event should run for the first time. 

Specify the interval for the event.  Options are: 

Hourly – Select to run the event Every X hour(s).  Enter the hourly time 

increment in the field (e.g., every 8 hours). 

Daily - Select to run the event Every X day(s).  Enter the number of days in 

the field (e.g., every 3 days). 

Weekly – Select to run the event Every X week(s).  Enter the number of weeks 

in the field, and enable the check box(es) for the day(s) of the week on which 

the event should run. (e.g., Every 2 weeks on Monday and Wednesday) 

Monthly – Select to run the event on a monthly basis.  Select the day of the 

month (1-31) and the frequency of the event in month(s) (e.g., Day 15 of every 

2 month(s)); or select a day of the week and the 1st, 2nd, 3rd, 4th, or last week 

of the month, and the frequency of the event in month(s). (e.g., The 2nd Friday 

of every 1 month(s)) 

Yearly – Select to run the event on a yearly basis.  Select the month / day and 

the frequency of the event in year(s). (e.g., January 1st  of every 1 year(s)); or 

select a day of the week, the 1st, 2nd, 3rd, 4th, or last week of the month, the 

month, and the frequency of the event in year(s). (e.g., The 2nd Friday of 

January every 2 year(s)) 

 Click OK to save settings. 

 Click Cancel to discard settings. 

Upload Complete 

Performs an action when an upload completes (as soon as the data has been processed 

into the database). 

 The Scheduler feature is user specific and may only be applied to 

data uploaded by the current user. 

 Click the Settings button to filter the event based on the ROUTE being uploaded.  

The Upload Schedule Settings dialog appears. 

This dialog allows you to specify that the action should only occur if the data being 

uploaded from the Microlog Inspector / MARLIN belongs to a specific ROUTE.   

All Uploads – Leave this option enabled if you do not wish to filter on data source. 
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ROUTE – Select this option if you only want the action to run when incoming data is 

from specified ROUTEs.  Enable the check boxes next to the ROUTEs that should trigger 

the action.  If data is uploaded from a ROUTE that is not selected, the event will not run. 

Scheduler Actions 

Display a message 

Select the “display message” action to display your specified message text when the 

associated event occurs.   

 Click the Settings button to enter your message text. 

The Display Message Action Settings dialog appears. 

 Type in the desired text. 

 Click the OK button to save. 

 Click the Cancel button to discard changes. 

Generate Report 

Select the Generate Report action to generate a specified report type when the 

associated event occurs. 

To select report type: 

 Select Generate Report from the dialog’s Select an action area. 

 Click the Settings button.  The Generate Report dialog appears. 

Generate Report Settings 

Description – Enter descriptive text to identify this report in the Scheduler. 

Report – Select the desired report type from the drop down list. 

Data Source – Select the data source for the report.  This section varies, 

depending on whether the Report can specify data sources from multiple 

hierarchies option was enabled on the Report Editor’s General tab for the 

selected report. 

If Report can specify data sources from multiple hierarchies was enabled, 

all of your @ptitude Analyst hierarchies display.  Select multiple hierarchies, 

groups, and POINTs to include in your report. 

If Report can specify data sources from multiple hierarchies was not 

enabled, available options include: 

Primary Hierarchy – Use the POINTs from the currently selected 

primary hierarchy as the report’s source. 

Last Upload – Use the POINTs last uploaded from the data collector 

as the report’s source. 

ROUTEs (all available) – Enable the check box next to each ROUTE you 

would like to include. 

Workspaces (all available) – Enable the check box next to each Workspace 

you would like to include. 
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 If the Data Source is a Filtered Workspace, the Workspace will not 

be filtered again before report generation.  The report is based on 

the Workspace in its current state. 

Destination – Select the desired report destination from the drop down 

list.  Available options include: 

Email – Automatically sends an email of the report in HTML and PDF 

format to selected email recipients.  Click the Select button to display 

the Recipient Selection dialog and select one or more contacts or 

groups of contacts.  

HTML – Save to the subdirectory as an HTML file. 

Open Window – Window opens automatically, displaying the report. 

Printer / Landscape – Automatically prints in landscape mode. 

Printer / Portrait – Automatically prints in portrait mode. 

 The Destination selection is not used if the report is delegated to 

the Transaction Server.  In this case, the report is always 

generated to HTML. 

 Click OK to save report settings. 

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set 

up contacts and groups.  

Measurement Management / Archive 

Select the Measurement Management / Archive action to schedule the Monitor 

application to perform measurement management and archiving.  This action checks 

the measurements in the current database, and either archives old data to the short 

term or long term status, or deletes old data from the database.  This action is 

performed on measurements in the current database only.  Refer to SKF @ptitude 

Analyst Introduction and Global Features User Manual, Chapter 3, SKF Machine 

Monitor Application for more information on the Monitor’s functions, including 

archiving data. 

Send Message 

Select the Send message action to send an email or text message to selected recipients 

when the associated event occurs. 

 Click the Settings button to configure your message settings. 

The Send Message Settings dialog appears. 

 In the Subject text box, type the subject of the event’s email message. 

 In the Message text area, type the event’s message to be sent as email and/or text 

messages. 

 Text messages are often limited to a maximum number of 

characters.  Check with the recipient’s service provider to 

understand text message limitations. 
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 Click the Select button to display the Recipient Selection dialog and select one or 

more recipients from the list of available contacts and groups. 

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set 

up contacts and groups. 

 If you wish to include an HTML file with your email message, use the Browse 

button next to the HTML content text box and select an HTML file to include. 

 HTML content is not supported by text messaging. 

 If you wish to include any other type of attachment with your email message, select 

the Browse button next to the Attachments text box to select the file you wish to 

include. 

 Attachments are not supported by text messaging. 

 Enable the Allow content from triggering event check box to allow the default 

alarm message to override the Message text message when a triggering event 

occurs. 

 Enable the Send email check box to send the message to the selected recipients as 

an email. 

 Enable the Send text to phone check box to send the message to the selected 

recipients as a text message. 

 Texting limitations depend on the recipient’s service provider. 

 Click the OK button to save the message settings. 

 Click the Cancel button to discard changes. 
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Microlog Inspector Settings 

The Customize / Microlog Inspector Settings dialog allows you manage your Microlog 

Inspector devices, and set up Microlog Inspector profiles and assign them to Microlog 

Inspector Devices.   

 

Figure 2 - 40. 

The Microlog Inspector Settings dialog’s Profile Manager tab. 

Profile Manager 

Overview 

 Before setting up Microlog Inspector profiles, it is recommended 

that you set up your Microlog Inspector devices to communicate 

with @ptitude Inspector.  Reference your Microlog Inspector User 

Manual for details. 

Before you can transfer data between @ptitude Inspector and the Microlog Inspector 

device, you must first create a profile and assign it to the Microlog Inspector device to 

which you wish to download data. 

A profile identifies all of the operator and ROUTE data collection information to be 

downloaded to the Microlog Inspector.  You may create as many profiles as you wish, 
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but you may only assign one profile to a device at a time.  You may also assign the same 

profile to several devices.  The number of devices to which you can download profiles is 

limited by the number of available Microlog Inspector licenses purchased.  

Creating a New Profile 

To create a new profile: 

 Select the Customize menu’s Microlog Inspector Settings option.  The Microlog 

Inspector Settings dialog’s Profile Manager tab displays. 

 Click the Add button located on the dialog’s bottom right.  The Profiles drop down 

list and Profile name text box display “New Profile.” 

 Define the new profile information using the following fields: 

Profile name – Assign the new profile a unique profile name for future 

identification purposes.   

Operator Set – Select a predefined operator set from the drop down list to 

assign operators and their specified operator preferences to the profile. 

 If necessary, click the View Sets button to create a new operator 

set or edit an existing operator set using the Operator Set dialog.  

For more details on creating operator sets, reference the 

Customize / Database section later in this chapter. 

Profile Owner – Select the analyst user that will be associated with data when 

it is uploaded from the Microlog Inspector.   

Download previous – Enter the number of previous measurement records (1 

– 99) you wish to download to the device for field trending purposes (typically 

10). 

Synchronize device with latest measurements – This setting is used in 

conjunction with the Download previous setting above.  If the profile’s route 

data is being collected by multiple Microlog Inspector devices, enable this 

option to download measurement record data that was uploaded from all the 

devices assigned this profile.  On the Microlog Inspector, this allows you to view 

and trend all the previous data taken with all devices assigned the profile.   

 Depending on the size of the ROUTE, enabling Synchronize 

device with latest measurements may cause 

synchronization to take longer than normal. 

ROUTE/Workspace selection – Click a checkbox to select the ROUTEs / 

workspaces you wish to download with the profile.  When you enable a ROUTE 

/ workspace checkbox, the item moves to the top of the list.  If several items 

are selected, the newest selection appears below previously selected items at 

the top of the list. 

Download order – Specify the order in which the selected ROUTEs / 

workspaces download to, and appear on, the assigned device.  Highlight a 

selected ROUTE or workspace and click the Up and Down buttons to move the 

item up or down in the list of selected items. 
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 Click Save to save the profile.  The Profiles list updates to reflect the newly added 

profile. 

How to Assign a Profile to a Microlog Inspector Device 

The Profile Manager dialog’s Available Devices list displays on the top right.  This list 

displays all Microlog Inspector devices that have been set up to communicate with 

@ptitude Inspector.  In this list, devices displayed with an enabled checkbox are already 

assigned the current profile as selected in the Profiles drop down list, along with all 

devices not currently assigned a profile (indicated by their disabled checkbox).  Directly 

below the Available devices list, the amount of available devices (licenses) versus total 

number of Microlog Inspector licenses purchased is displayed. 

To assign a profile to a device: 

 From the Profiles list, select the profile you wish to assign to a device.  The 

Available devices list updates to display all the devices already assigned the 

selected profile (checkbox enabled), and all unassigned devices (checkbox disabled).  

 Enable the checkbox next to your unassigned device(s) to which you wish to assign 

the selected profile. 

 Click Save. 

Now, when the device is docked and synchronization occurs, the assigned profile’s data 

collection settings will download to the device. 

Device Manager 

The dialog’s Device Manager tab allows you to manage all of the devices currently set 

up to communicate with your SKF @ptitude Inspector software.  You can edit a device’s 

time zone, remove a device, or create a download file of a device’s current profile. 

 For details on setting up a device to communicate with SKF 

@ptitude Inspector, reference your Microlog Inspector User 

Manual. 
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Figure 2 - 41. 

The Microlog Inspector Settings dialog’s Device Manager tab. 

Fields include: 

Portable Devices list – Identifies the devices currently set up to communicate with SKF 

@ptitude Inspector, and the profile, time zone, and unique identifier (UID) for each 

device.  Displayed information includes: 

 Reference your Microlog Inspector User Manual for details on 

device setup. 

Device Name – The name assigned to the device during device setup. 

Profile Name – The profile currently assigned to the device. 

Time Zone – The time zone specified for the device.  The time zone setting 

allows accurate data record date/time stamping for data communicated over 

time zones. 

Device UID – The device’s unique identifier (UID). 

Properties – Fields in the Properties area allow you to edit the selected device’s Device 

Name and Time zone. 
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Create File – Click to create a download file containing the selected device’s profile.  

This is useful when the Microlog Inspector user does not have access to @ptitude 

Inspector.  In this case, the download file is emailed to the device user, who then copies 

it onto the device.  Reference your Microlog Inspector User Manual for details. 

Save – Click to save your changes to the selected device. 

Undo – Click to undo your changes to the selected device. 

Remove – Click to remove the selected device from the Portable Devices list.   

How to Unassign a Profile from a Microlog Inspector Device 

You may wish to unassign a profile from a device, so that you can assign a different 

profile to it. 

To unassign a profile from a device: 

 From the Profiles list, select the profile name you wish to unassign from a device.  

The Available devices list updates to display all devices assigned the selected 

profile (checkbox enabled), and all unassigned devices (checkbox disabled). 

 Disable the checkbox next to the device(s) from which you wish to unassign the 

selected profile. 

 Click Save. 

To remove an existing profile from the Profiles list: 

 Select the profile name you wish to remove from the Profiles drop down list. 

 If the selected profile is assigned to any devices, you must first 

unassign the profile from the devices as described above.  You 

must click Save after unassigning the profile.  

 Click Remove.  You are prompted to confirm the removal. 

 Click Yes. 

To create a copy of an existing profile: 

 Select the profile you wish to copy from the Profiles drop down list. 

 Click Copy.  A copy of the selected profile is created.  A .# suffix is automatically 

added to the new profile’s name (i.e., fanroom becomes fanroom.1). 

 Click Undo immediately after a process to undo your changes and return to the 

previous state. 
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Microlog Inspector Device Status Window 

Use the Microlog Inspector Device Status window to display all of the devices 

currently set up to communicate with your SKF @ptitude Inspector software. 

To view the Microlog Inspector Device Status window: 

 Select the View menu’s Microlog Inspector Status option. The Microlog Inspector 

Device Status window displays. 

 

All devices currently set up to communicate with your SKF @ptitude Inspector software 

display, including the device name, the profile name, device's firmware version, last sync 

date / time, sync status, and last activity. 

Customize / Database Operations 

The Database dialog allows you to create custom group types and to define filter keys, 

coded notes, and operator names.  

Creating Custom Group Types 

Use the powerful Customize  / Database dialog’s Group Types tab to create custom 

Group Types to conveniently organize your machines, SETs, and POINTs to fit your 

application. 

To create a custom Group Type: 

 Select the Customize menu’s Database option.  The Database dialog displays. 

 Select the Group Types tab. 
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Figure 2 - 42. 

The Database Dialog’s Group Types Tab. 

 Click the Group Types tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Group Type – This field is unavailable if you are adding a new Group Type.  In the 

Group type properties area, the following fields are available: 

Name – Specify a name to define your custom group type.  For example, you may want 

to create a custom Group type named “pumps,” for easy organization of all pump 

machinery. 

Base on – Select a type to base the new group type on (SET or Machine). 

 Once a Group Type has been “based on” a SET or Machine, the 

setting cannot be edited. 

Once defined, the new Group Type will be available as a selection in the Group 

Properties dialog’s Type list. 
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Optional data - Provides up to five fields to enter titles for additional data.  Text 

entered in these fields appears as prompts for data entry when new Groups are 

created.  This feature allows you to store detailed information with your Groups. 

 Specify prompt titles that will appear in the Group Properties / Details tab. 

 Examples are “serial number,” “manufacturer,” “operator name,” 

etc. 

 Click the Save button to save the new Group Type and add it to the available types. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current Group Type. 

 Group types currently in use cannot be removed. 

Creating Filter Keys 

Custom filter keys can be assigned to POINTs and/or Machines or SETs.  

To add a new filter key: 

 Select the Customize menu’s Database option.  The Database dialog displays. 

 Select the Filter Keys tab. 
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Figure 2 - 43. 

The Database Dialog’s Filter Key Tab. 

 Click the dialog’s Add button.  The dialog enters edit mode. 

Fields include: 

Filter keys – Displays all previously defined filter keys. 

Name – Specify filter key text. 

 Click the Save button.  The new filter key is now available for assignment. 
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Coded Notes 

Coded notes are notes created and stored in @ptitude Inspector and automatically 

transferred from the software to the DAD.  Create coded notes in the Customize / 

Database dialog’s Coded Notes tab. 

All previously defined coded notes appear in the tab’s Coded notes area.   

IMPORTANT 

Never edit the database’s Coded Notes list unless you intend to immediately re-

download to all affected DADs.  If coded notes stored in DADs do not sync up with 

the databases Coded Notes list, the wrong notes will be uploaded. 

To add a new coded note: 

 Click the Add button. 

Fields include: 

Coded notes – Displays all previously defined coded notes. 

Note - Enter coded note text. 

 Enter your descriptive text in the Note field and click the Save button. 

 To cancel settings, click the Undo button. 

To remove an existing coded note: 

 Select the coded note from the Notes area. 

 Click the Remove button. 

 The coded note, “Machine Not Operating,” may not be removed. 

 If the listing order of the coded notes has changed, you must 

download the coded notes to all DADs to ensure synchronization. 

Compliance 

Compliance schedules enable you to manage data collection into a manageable 

workflow, by allowing you to define a time interval to identify when a POINT must be 

collected.  The time interval allows data collection any time within the set interval.  

For example, if data is scheduled to be collected for a POINT starting at 6 am on a daily 

basis, the POINT will become overdue only if data is not collected by the following day at 

6 am.      

Use the Customize  / Database dialog’s Compliance tab to define, edit, and delete 

compliance schedules. 

All previously defined compliance schedules appear in the Compliance drop down list.  

To edit an existing compliance schedule, select a schedule from the Compliance drop 

down list and make necessary changes to the fields below. 
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To add a compliance schedule:  

 Click Add to create a new compliance schedule. 

 In the Properties area, edit the Name, Start date, Start time, and Take data 

every fields to customize the compliance schedule. 

Name – Enter a descriptive name for the compliance schedule. 

Start date – Enter the date the data collection interval is to begin. 

Start time – Enter the time of day the data collection interval is to begin. 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Second(s), 

Minute(s), Hour(s), Day(s)).  The POINT is tagged as overdue for data 

collection if the collection interval passes and no data is collected for the 

POINT. 

 The Take data every field is used to determine if a POINT is 

overdue for data collection.   

Operators 

Some DADs support operator names to tag measurement data with the corresponding 

operator’s name.  You can also create operator sets that group several operators 

together, making it easier to identify several operators in an associated group.  Operator 

names are downloaded to the DAD.   

 When collecting data, the data collection person logs in using their 

operator name. 

Manage operator names and sets in the Customize / Database dialog’s Operator tab. 
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Figure 2 - 44. 

The Database Dialog’s Operators Tab in View by Operator Mode. 

The Operators dialog has two modes: 

View by operator – Select this mode to manage operators organized by 

operator name. 

View by set – Select this mode to manage operators organized by operator 

set. 

View by Operator Mode 

In View by operator mode, all available operator names display in the Operators drop 

down list.  In this mode, you can add or remove operators, and organize your operators 

into sets.  For example, you can add operators to an "early shift" operator set. 
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To add a new operator: 

 Click the Add button. 

 Enter the new name in the Name field and click the Save button. 

To add an operator to a set: 

All previously created sets display in the Available sets area.  The Included sets area 

displays sets to which the selected operator name is already assigned. 

 Select the operator name from the drop down list. 

 Select the desired set from the Available sets area. 

 Click the Include button to include the selected operator name with the selected 

set.  Click the Include All button to include the selected operator in all available 

sets.   

 Click the Save button. 

To remove an existing operator name: 

 Select the operator name from the Operator Names window. 

 Click the Remove button. 

View by Set Mode 

In View by set mode, all previously created operator sets display in the Operator sets 

drop down list.  In this mode, you can add or remove sets, and organize your operators 

into sets.  For example, you can create an operator set for the early shift, and include 

appropriate operators into the set. 

To create a new operator set: 

 Select New Set from the drop down list. 

 Enter the new set's name in the Set name field and click the Save button. 

All available operators display in the Available operators area.  All operators already 

included in the set display in the Included Operators area. 

 Use the Include, Include All, Exclude, and Exclude All buttons to organize 

operators into the appropriate sets. 

 Click the Save button to save you changes. 

Operator Settings 

Operator settings are the operator preferences used on the MARLIN and Microlog 

Inspector devices.  In @ptitude Inspector, the system administrator may assign these 

operator preferences, unique to each operator, which are then downloaded to the 

device. 

 Operator names must first be set up in the Customize / 

Database dialog’s Operators tab. 

Manage operator settings in the Customize / Database dialog’s Operator Settings tab. 
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Figure 2 - 45. 

The Database Dialog’s Operator Settings Tab. 

To set operator preferences: 

 Select an operator name from the Operators list for which to assign operator 

preferences.  Click Select All to assign global preferences for all existing operator 

names. 

 Select a device type from the Supported DAD types drop down list.  Select All, 

MARLIN, or Microlog Inspector.  The Settings list below displays differently 

depending on the selected device type. 

 Select settings from the Settings list to assign preferences for the selected 

operator(s).   

 Select the desired preferences settings from the Value drop-down list. 

 Click Save to save the current operator preferences for the selected operator(s). 

 Click Undo to cancel changes made to operator preferences. 
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Settings Definitions 

Access Level - Specify one of five access levels for the operator: 

For MARLIN Users: 

Review - Access to data review operations only.  Cannot collect data, 

add/modify/delete hierarchy items, add/modify/delete operators, or restore the 

database using the Restore option. 

Limited - Access to data collection operations only (data collection, review, and 

upload).   

Cannot add, modify, or delete hierarchy items.  Cannot add, modify, or delete 

operators. 

Operator – Access to data collection operations only (data collection, review, 

and upload), and the ability to reset unit.  Cannot add, modify, or delete 

hierarchy items.  Cannot add, modify, or delete operators. 

Full - Access to all MARLIN operations with the exception of adding, modifying, 

and deleting operators. 

Admin - Access to all MARLIN operations including the ability to add, modify, 

and delete operators. 

The following table indicates which operations are available for each access 

level on the MARLIN. 

Operation      

Add Item Admin Full    

Modify Item Admin Full    

Delete Item Admin Full    

Collect Admin Full Operator Limited  

Review Admin Full Operator Limited Review 

Reset Admin Full Operator   

Report Admin Full Operator Limited Review 

Transfer Admin Full Operator Limited  

Operator / 

Admin. 

Admin     

Operator / 

non-Admin 

Admin Full Operator Limited Review 

Back-up Admin Full Operator Limited Review 

Restore Admin Full Operator Limited  

For Microlog Inspector Users: 

Review - Access to data review operations only.  Cannot collect data, configure 

network settings, or restore the database using the Restore option. 
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Limited - Access to data collection operations only (data collection, review, and 

upload).   

Operator – Access to data collection operations only (data collection, review, 

and upload), and the ability to reset unit.   

Full - Access to all Microlog Inspector operations with the exception of 

configuring network settings and database location. 

Admin - Access to all Microlog Inspector operations. 

The following table indicates which operations are available for each access 

level on the Microlog Inspector. 

 

Operation      

Settings – 

Network Setup 

Admin     

Settings – 

Database - 

Location 

Admin     

Settings – 

Database – Clear 

Admin Full    

Settings – 

Database – Reset  

Admin Full Operator   

Settings – 

Database – 

Backup  

Admin Full Operator Limited Review 

Settings – 

Database – 

Restore  

Admin Full Operator Limited  

Settings – Tag 

Harvester 

Admin Full    

Settings – View 

Options 

Admin Full Operator Limited Review 

Settings – WMCD 

Setup 

Admin Full Operator   

Settings – Temp 

Gun Setup 

Admin Full Operator   

Settings – RFID 

Setup 

Admin Full Operator   

Collect Admin Full Operator Limited  

Review Admin Full Operator Limited Review 

Synchronize Admin Full Operator Limited Review 



 Working With Your SKF @ptitude Inspector Hierarchy 

 Customize / Database Operations 

 

SKF @ptitude Inspector 2 - 91 

User Manual 

Automatic Transfer – (MARLIN only) When enabled, docking the MARLIN data 

manager launches “SyncData,” and data is automatically synchronized between the unit 

and @ptitude Inspector software.  Undocking the unit closes SyncData.  

 Automatic Transfer is only available using the ActiveSync 

communication type.  Refer to Chapter 4, Data Collection 

ROUTEs and Other Data Transfer Operations, for more 

information. 

Create Work Notification – (MARLIN only) Enable this option to allow the operator to 

create work notifications. 

Data Collection Time – Allows the administrator to customize the amount of time 

allowed between measurement data collected for the same POINT.  The default setting 

is 45 minutes.  For example, if you use the default Data Collection limit setting (45 

minutes), and download a ROUTE, collect and save data for POINT 1, then collect 

another data sample for the same POINT within the specified 45-minute limit, a 

warning displays.  The warning indicates the previous measurement was saved less 

than 45 minutes ago, and prompts you to either overwrite the previous data with the 

newly collected data, or to cancel the action. 

To set the data limit: 

 Select the data collection limit from the drop down list’s options (0-1500 seconds, 

in 15 minute increments).  Enter “0” to disable the warning. 

Verification Mode – Specify whether to display the Feedback review display during data 

collection.  Choices are, Always, On Alarm, or Never. 

Can change Automatic Transfer – When enabled, allows the operator to enable / 

disable the Automatic Transfer preference on the Modify Operator display.  Default is 

disabled. 

Enable Machine OK – When enabled, this button provides the operator a method to 

quickly describe the overall machine condition as "OK", without collecting current data 

on the machine’s measurements. For machines with Single and Multi-Select 

Inspection POINTs, the Machine OK button specifies and stores the first non-alarm 

Inspection Result for each of the machine's Inspection POINTs, then displays the 

Machine display for the next machine at the same hierarchy level. If no more machines 

exist at the same hierarchy level, the hierarchy display appears with the current 

machine's ID highlighted. 

  WARNING! 

Machine OK should not be used during any ATEX related inspections.  If ATEX 

inspections are planned, it is recommended that Machine OK be disabled. 

Enable Machine Not Operating – (Microlog Inspector only) When enabled, this button 

provides the operator a method to note that the machine is not operating.  Determines 

whether the operator will have access to the Machine Not Operating button in the 

Machine dialog.  Select On or Off. 

Can Change Password – When enabled, the Microlog Inspector / MARLIN operator can 

change the password.  If disabled, the password must be changed in @ptitude Inspector. 
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Messaging – (Microlog Inspector only) When enabled, the following warnings / 

messages display on the device: 

End of ROUTE 

Zero Acceleration / Velocity Reading (warning) 

Show Sets While Collecting 

Save Data as Current (warning) 

Numeric Range Protection – (Microlog Inspector only) When enabled, collected data 

above full scale or below minimum scale is not accepted. 

Password – For MARLIN, enter the password the operator will use to log in to the 

MARLIN.  For the Microlog Inspector, enter the default password the operator will use 

to sign in for the first time, upon which they will be prompted to enter a unique 

password for future sign ins.  

Reset Password – When enabled, the operator must sign in using the default 

password.  Microlog Inspector operators are prompted to change their password upon 

initial sign in.  This option is useful when operators forget their password. 

Scan And Go To First POINT – (Microlog Inspector only) When enabled, after an 

operator scans a Machine, the machine’s first POINT automatically displays. 

Scan Required to Collect – Enable to require the operator to collect data using the 

scanner 

Show Previous Data – Enable to allow the operator to view the previous data prior to 

collecting new data. 

SPC Enabled - When enabled, 18 Statistical Process Control rules apply to process 

trends. 

View FFTs – (Microlog Inspector only) Enable to allow the operator to view FFTs on the 

device. 

View Overdue – Specify whether to display All POINTs or Overdue POINTs on the 

hierarchy display. 

View Tree Element – Specify the hierarchy items you would like to show on the 

hierarchy display.  Choices are POINT only , SET+POINT, Machine+POINT, or All. 

View Work Notification History – Enable this option to allow the operator to view 

historical work notifications. 

Once you have set the operator preferences, you can download them to the device 

using the Config or Clear buttons on Transfer dialog’s Status tab.  Refer to Chapter 4, 

Data Collection ROUTEs and Other Data Transfer Operations, for more information. 

 Any operator preferences that are set on the device will not be 

uploaded to @ptitude Inspector, and will be overwritten with the 

operator preferences set up in @ptitude Inspector on the next 

download.   
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Messages 

Use the Customize  / Database dialog’s Messages tab to create shared (public) 

messages to assign to machines and POINTs to automatically display important 

instructions and information.   

All previously defined messages appear in the Instruction messages drop down list. 

To create a public Message: 

 Select the Customize menu’s Database option.  The Database dialog displays. 

 Select the Messages tab. 

 Click the Messages tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Name – Specify a name to define your custom message.   

Format – Select the message format from the drop down list.  Available options 

include: 

Free form – Allows you to manually type in the summary and content for your 

message. 

Hyperlink – Allows you to create a link to an existing file on your MARLIN / 

Microlog Inspector.  During data collection, when the specified message 

condition is met, the originating application (Word, Acrobat) launches the 

machine's hyperlinked message file on the MARLIN / Microlog Inspector unit.  

When the message condition occurs, an Instruction (i) button becomes 

available (un-ghosts) on the MARLIN / Microlog Inspector’s display.  Tap this 

Instruction (i) button to display the message. This feature allows you to 

associate detailed instructions with particular machines or POINTs while still 

keeping downloads small and efficient. 

 The message file and the application used to create the message 

must both be present on the MARLIN / Microlog Inspector.  

Message files are downloaded to the MARLIN / Microlog 

Inspector using ActiveSync.  Reference your ActiveSync User 

Manual for more information. 

Summary – Type in text summarizing your instruction message for easy recognition.  

For example, if you have a message that details specifics about a group of machinery, 

your summary may read, "FD Fan Data Collection Information." 

Content – Enter your complete instruction message in the content text area.  Using the 

above example, your instruction message content would include detailed data collection 

information, specific to the current group.  For example, your message may read 

"Ensure sensor is properly mounted before collecting data, etc." 

 Click the Save button to save the new message and add it to the available public 

messages. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current message. 

 Messages currently in use cannot be removed. 



Working With Your SKF @ptitude Inspector Hierarchy 

Alarm Database 

2 - 94 SKF @ptitude Inspector  

 User Manual 

Alarm Database 

Use the Alarm Database to create alarms that can be assigned to one or more POINTs.  

Created alarms can be re-assigned and edited. 

To access the Alarm Database dialog: 

 Select the Customize menu’s Alarm Database option.  The Alarm Database dialog 

displays. 

 

Figure 2 - 46. 

The Alarm Database Dialog’s Overall Tab. 

Alarm Database - Overall 

Existing alarms may be edited or removed from the database.  The Overall tab allows 

you to create, edit, or remove shared Overall alarms. 

To create a new alarm: 

 Click the tab's Add button.  The Overall alarms field displays “New Overall Alarm” 

to indicate that you have created a new alarm.   

 In the Name field, assign the new alarm a unique name. 

 Once the editing process begins, the Overall alarms field is no 

longer accessible.  You must complete and Save your edits or 

cancel them by clicking the Undo button. 
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 Click Save.  The Overall alarms field now displays the new alarm name you 

specified.   

You can also adjust the alarm’s Properties and Settings in this tab.  The current 

settings graphically display in the tab’s Settings area. 

To edit or create Overall Alarm Properties and Settings: 

Properties – Select the type of Overall Alarm by clicking the desired option button.  

Choose from: 

Level - Measurements exceeding the specified alert and danger Settings will 

result in an alarm condition. 

In Window - Measurements falling within the specified alert low, danger, and 

alert high Settings will result in an alarm condition. 

Out Of Window - Measurements falling outside the specified danger low, alert 

low, alert high, and danger high Settings will result in an alarm condition. 

Settings – Select the levels you wish to include by clicking each checkbox. 

 The availability of the levels, their checkboxes, and their text fields 

is based on the type of Overall Alarm selected in the Properties 

area.  

 Enter the desired values for each available alarm level. 

 Click the Save button to save your alarm settings. 

To remove an existing alarm from the database: 

 Select the desired alarm from the drop down list.   

 Click the Remove button.  A confirmation dialog displays.   

 Confirm removal.  The selected alarm is permanently removed from the database. 

 An alarm cannot be removed if it is currently assigned to one or 

more POINT.  A warning dialog displays if you attempt to remove 

a currently assigned alarm. 
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Alarm Database - MCD 

Existing alarms may be edited or removed from the database.  The MCD tab allows you 

to create, edit, or remove shared MCD alarms. 

 

Figure 2 - 47. 

The Alarm Database Dialog’s MCD Tab. 

To create a new alarm: 

Click the tab's Add button.  The MCD alarms field displays “New MCD Alarm” to 

indicate that you have created a new alarm.  In the Alarm name field, assign the new 

alarm a unique name. 

 Once the editing process begins, the MCD alarms field is no 

longer accessible.  You must complete and Save your edits or 

cancel them by clicking the Undo button. 

 Click Save.  The MCD alarms field now displays the new alarm name you specified.   

You can also adjust the alarm’s Settings in this tab.  The current settings graphically 

display in the tab’s Settings area. 

 Enter your Settings. 

 Click the Save button to save your alarm settings. 
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To remove an existing alarm from the database: 

 Select the desired alarm from the drop-down list.   

 Click the Remove button.  A confirmation dialog displays.   

 Confirm removal.  The selected alarm is permanently removed from the database. 

 An alarm cannot be removed if it is currently assigned to one or 

more POINT.  A warning dialog displays if you attempt to remove 

a currently assigned alarm. 

Alarm Database - Inspection 

Existing alarms may be edited or removed from the database.  The Inspection tab 

allows you to create, edit, or remove shared Inspection alarms. 

 

Figure 2 - 48. 

The Alarm Database Dialog’s Inspection Tab. 
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To create a new alarm: 

Click the tab's Add button.  The Inspection alarms field displays “New Inspection 

Alarm” to indicate that you have created a new alarm.  In the Alarm name field, assign 

the new alarm a unique name. 

 Once the editing process begins, the Inspection alarms field is no 

longer accessible.  You must complete and Save your edits or 

cancel them by clicking the Undo button. 

 Click Save.  The Inspection alarms field now displays the new alarm name you 

specified.   

You can also adjust the alarm’s Prompt and Inspection Results.   

 Click to place the cursor in the appropriate field you wish to edit (Prompt field or 

Inspection Result field).  Enter the new Prompt or Inspection Result. 

 Click the Save button to save your new Inspection POINT setup. 

 Click the Save button to save your alarm settings. 

To remove an existing alarm from the database: 

 Select the desired alarm from the drop-down list.   

 Click the Remove button.  A confirmation dialog displays.   

 Confirm removal.  The selected alarm is permanently removed from the database. 

 An alarm cannot be removed if it is currently assigned to one or 

more POINT.  A warning dialog displays if you attempt to remove 

a currently assigned alarm. 

Alarm Database - Messages 

Use the Customize / Alarm Database dialog’s Messages tab to create shared (public) 

messages to assign to machines and POINTs to automatically display important 

information.   

 Messages created on the Alarm Database / Messages dialog only 

apply to alarms.  To create messages for specific machines and 

POINTs, reference the Customize / Database Operations 

section. 

All previously defined messages appear in the Alarm messages drop down list. 

To create a public Message: 

 Select the Customize menu’s Alarm Database option.  The Alarm Database dialog 

displays. 

 Select the Messages tab. 

 Click the Messages tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Name – Specify a name to define your custom message.   
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Format – Select the message format from the drop down list.  Available options 

include: 

Free form – Allows you to manually type in the summary and content for your 

message. 

Hyperlink - Allows you to create a link to an existing file on your MARLIN / 

Microlog Inspector.  For example, you can store a large .doc file on your 

MARLIN that will automatically launch when the specified alarm condition is 

encountered on the ROUTE during data collection.  This allows you to associate 

detailed alarm messages with particular machines while still keeping 

downloads small and efficient. 

 The message file and the application used to create the message 

must both be present on the MARLIN / Microlog Inspector.  

Message files are downloaded to the MARLIN / Microlog 

Inspector using ActiveSync.  Reference your ActiveSync User 

Manual for more information. 

Summary – Type in text summarizing your alarm message for easy recognition.  For 

example, if you have an alarm message that details shut down instructions in the case 

of an overall danger high alarm level, your summary may read, "Emergency Shut Down 

Instructions." 

Content – Enter your complete alarm message in the content text area.  Using the 

above example, your alarm message content would include detailed shut down 

instructions, and any other pertinent information required in the case of the triggered 

alarm type. 

 Click the Save button to save the new message and add it to the available public 

messages. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current message. 

 Messages currently in use cannot be removed. 

Statistical Alarms Wizard 

Statistical Overall Alarms Wizard  

Overview 

For POINTs in a Workspace window, the Statistical Overall Alarms Wizard guides you 

through a process that automatically generates accurate overall alarm settings based 

upon historical measurement data. 

 The Statistical Overall Alarms Wizard only operates on an active 

Workspace window. 
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To initiate the wizard: 

 Open the desired Workspace window. 

 Select the Customize menu’s Alarm Attributes / Statistical Overall… option.  The 

wizard’s Introduction dialog displays. 

Introduction 

The Introduction dialog is the first screen in the Statistical Overall Alarms Wizard.  

The measurement data used to generate the alarm values is generated from the 

POINTs included in the selected Workspace (identified in the Workspace field). 

 From the Workspace drop down list, select the Workspace from which you would 

like to use to generate the alarm values. 

 From the Full scale units drop down list, select a measurement unit.  The Full 

scale units drop down list displays a list of the full scale units for POINTs in the 

selected workspace.  Only POINTs with the selected measurement unit are used to 

generate alarm values. 

 Click the Save processing details to “Statistical Overall Alarms.log” check box to 

create and save a log file. 

 Click Next to continue. 

Alarm Assignment 

Select the calculation method to use to determine alarm values. 

Individual POINTs – Select to use each POINT's readings to generate a unique set of 

alarm values for the POINT.  The resulting values are assigned to each POINT as a 

private alarm. 

 This operation generates and assigns a private alarm for each 

POINT. 

Across all POINTs – Select to use the readings for all the POINTs to generate one set 

of alarm values that is assigned to each POINT included in the calculation.  The resulting 

values are saved as a shared alarm. 

 If Across all POINTs is selected, a Review Page displays before 

alarms are applied, allowing verification and confirmation. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Measurement Selection 

Determine the method for selecting the measurement data to generate overall alarm 

values. 

All measurements – Select to use all measurement data to generate the overall alarm 

values. 

Measurements in this date range – Select and enter a date range to use all 

measurements in the indicated date range to generate the overall alarm values. 
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Last fixed number of measurements – Select and enter number of measurements to 

use the specified number of measurements to generate overall alarm values. 

Limits – Allow you to filter abnormal measurements from the calculation: 

Max. Amplitude- Enter the maximum amplitude of the overall value to include 

in calculation. 

Min. Amplitude – Enter the minimum amplitude of the overall value to include 

in calculation. 

Min Measurements – Enter the minimum number of the POINT's 

measurements to be included in calculation. 

 Only POINTs that have the number of indicated minimum 

measurements (or more) are included in the calculation. 

 Min. Measurements field is not available if measurement selection 

is  "Last fixed number of measurements." 

Channel – Enter the channel number of multi-channel POINTs to included in 

the calculation.  

Enable outlier removal – An “outlier” refers to data that is not typical, or is 

outside a specified data measurement range.  When the Enable outlier 

removal check box is enabled, measurement values that fall outside the outlier 

range are excluded from the calculation. 

 Outlier detection only occurs if the number of measurements is 

greater than or equal to the Min Measurements specification. 

Outlier threshold factor – Enter a threshold factor (1.0 to 5.0) to calculate the 

lower and upper limits of the outlier range (outlier threshold).  The threshold 

factor is multiplied by the standard deviation to calculate the outlier threshold.  

The default threshold factor is 3.0. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Alarm Type 

Select the type of overall alarm to generate: 

Level – Provides two alarm levels (Alert High and Danger High).  An appropriate alarm 

registers if the measured value is greater than either of the alarm levels.   

Out of Window – Provides four alarm levels (Danger High, Alert High, Alert Low, 

Danger Low).  An appropriate alarm registers if the measured value progresses out of 

the alarm window (does not fall between the alert high and alert low alarm settings). 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Generation Parameters 

 

Figure 2 - 49. 

The Statistical Overall Alarms Wizard’s Generation Parameters Screen. 

Note that you need not perform the standard deviation math.  The wizard’s default 

values have been selected to produce overall alarms that work well for most situations.  

However, if you wish to conform the overall alarms closer, enter smaller numbers.  To 

conform the overall alarms further away, enter higher numbers.  After completing the 

wizard, view your trend plots and make adjustments as necessary. 

 If necessary, edit the standard deviation information to be used in the overall alarm 

calculations.   

Standard deviation factors 

Danger High – Value to be multiplied by the standard deviation to establish 

the danger high level. 

Alert High - Value to be multiplied by the standard deviation to establish the 

alert high level. 

Alert Low – Value to be multiplied by the standard deviation to establish the 

alert low level. 

Danger Low – Value to be multiplied by the standard deviation to establish the 

danger low level. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Minimum Alarm Values 

Set the minimum alarm values to be used in the calculation.  If the standard deviation is 

small, the minimum alarm values allow you to set a wider range, minimizing the chance 

for bad alarms to occur. 

Enter the minimum values for Danger High, Alert High, Alert Low, and Danger Low. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Process 

Click the Next button to begin the overall alarm calculations.  Process progress displays 

along with the number of POINTs processed. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Review 

 This screen only displays if Across all POINTs was selected on 

the wizard's Alarm Assignment screen. 

 

Figure 2 - 50. 

The Statistical Overall Alarms Wizard’s Review Screen. 

The statistically derived overall alarm results display on this screen.  These numbers 

may be edited, if necessary. 
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Fields include: 

Alarm set name – Specify a unique name for the alarm. 

Calculated alarm values – Edit values as needed. 

 Calculated alarm values fields are available based on overall 

alarm type selection. 

POINTs processed for input criteria – Number of POINTs selected as candidates for 

processing. 

POINTs included – Number of included POINTs. 

POINTs excluded – Number of excluded POINTs. 

 Alarms are still applied to the POINTs excluded from calculation 

functions. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Finish 

 Click the Finish button to assign the statistically derived overall alarm to all POINTs 

in the specified workspace. 

Process progress displays on the screen. 

 Click Back to return to the previous screen. 

 Click Cancel to stop the operation without changing the POINTs. 

Statistical MCD Alarms Wizard 

Overview 

For POINTs in a Workspace window, the Statistical MCD Alarms Wizard guides you 

through a process that automatically generates accurate MCD alarm settings to support 

three distinct alarm levels for each of the measurements collected for an MCD POINT, 

based upon historical measurement data. 

 The Statistical MCD Alarms Wizard only operates on an active 

Workspace window. 

Introduction 

The Introduction screen is the first screen in the Statistical MCD Alarms Wizard.  The 

measurement data used to generate the alarm values is generated from the POINTs 

included in the selected Workspace (identified in the Workspace field). 

 Select a Workspace for MCD calculation from the Workspace drop-down list. 

 Click the Save processing details to “Statistical MCD Alarms.log” checkbox to create 

and save a log file. 

 Click Next to continue, or click Cancel to exit the wizard. 
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Measurement Selection 

Select the method for selecting the measurement data to generate MCD alarm values. 

Select All measurements to use all measurement data to generate the MCD alarm 

values (default).   

Select Measurements in this date range and select From and To dates from the 

drop-down lists to use all measurements in the indicated date range to generate the 

MCD alarm values.   

Select Last fixed number of measurements and enter number of measurements to 

use the specified number of measurements to generate MCD alarm values. 

 Click Next to continue, click Back to return to the previous screen, or click Cancel to 

exit the wizard. 

Alarm Assignment 

Select the calculation method to use to determine alarm values. 

Select Individual POINTs to use each POINT's readings to generate a unique set of 

alarm values for the POINT.  The resulting values are assigned to each POINT as a 

private alarm. 

 This operation generates and assigns a private alarm for each 

POINT. 

Select Across all POINTs to use the readings for all the POINTs to generate one set of 

alarm values that is assigned to each POINT included in the calculation.  The resulting 

values are saved as a shared alarm. 

 If Across all POINTs is selected, a Review Page displays before 

alarms are applied, allowing verification and confirmation. 

 Click Next to continue, click Back to return to the previous screen, or click Cancel to 

exit the wizard. 

Generation Parameters 

Enter standard deviation factors to be used in MCD alarm calculations. 
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Figure 2 - 51. 

The Statistical MCD Alarms Wizard’s Generation Parameters Screen. 

 Enter the standard deviation and amplitude information for each measurement 

type to be used in the MCD alarm calculations. 

 Use the checkboxes to enable and disable measurement types 

(Acceleration, Velocity, and Temperature) as necessary. 

 Enter the appropriate values in the following Standard deviation factor fields: 

Danger - Enter the value to be multiplied by the standard deviation to 

establish the danger level for each enabled measurement type. 

Alert - Enter the value to be multiplied by the standard deviation to establish 

the alert level for each enabled measurement type. 

Limits fields include: 

Max. amplitude - Enter the maximum amplitude of the MCD measurement 

value to include in calculation for each enabled measurement type. 

Min. amplitude - Enter the minimum amplitude of the MCD measurement 

value to include in calculation for each enabled measurement type. 

Min. measurements - Enter the minimum number of the POINT's measurements to 

be included in calculation. 

 Only POINTs that have the number of indicated minimum 

measurements (or more) are included in the calculation. 

 Min. Measurements field is not available if measurement selection 

is Last fixed number of measurements. 
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 Click Next to continue, click Back to return to the previous screen, or click Cancel to 

exit the wizard. 

Process 

Begin the Statistical MCD Alarm calculation by pressing the Next button from this page. 

 Click Next to begin the MCD alarm calculations.  Process progress displays along 

with the number of POINTs processed. 

 Prior to beginning calculation, you may click Back to return to the previous screen. 

 Click Cancel to exit the wizard at any time. 

Review 

 This screen only displays if Across all POINTs was selected on 

the wizard's Alarm Assignment screen. 

 

Figure 2 - 52. 

The Statistical MCD Alarms Wizard’s Review Screen. 

The statistically derived overall alarm results display on this screen.  These numbers 

may be edited, if necessary. 

Fields include: 

Alarm set name – Enter a unique name for the alarm. 

Calculated alarm values – Edit values for each MCD measurement type as needed. 

POINTs processed for input criteria – Number of POINTs selected as candidates for 

processing. 

POINTs included – Number of included POINTs. 
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POINTs excluded – Number of excluded POINTs. 

 Alarms are still applied to the POINTs excluded from calculation 

functions. 

 Click Next to continue, Back to return to the previous screen, or Cancel to exit the 

wizard. 

Finish 

 Click the Finish button to assign the statistically derived MCD alarm to all MCD 

POINTs in the specified workspace. 

Process progress displays on the screen. 

 Click Back to return to the previous screen. 

 Click Cancel to stop the operation without changing the POINTs. 
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Templates 

Templates save time, contribute to consistent organization, and allow you to make bulk 

entries.  For example, you can quickly set the machine speed for all POINTs beneath a 

machine with a template.  Templates allow you to define custom organizational 

structures for repeated use when building or defining your hierarchy.   

 The same template may be used across many different 

hierarchies.   

Managing Templates 

To add a new template: 

 Select the Customize menu’s Template option.  The Template dialog displays. 

 

Figure 2 - 53. 

The Template Dialog. 

 Click the dialog’s Add button.  The Template Properties dialog displays. 

 Enter the new template’s Name and Description. 

 Select the template’s Type from the drop down list.  Select a previously created 

template or <Custom>.   

 If you need a new template that is only slightly different from a 

previously created template, you can select a previous template 

as your Type and then edit only the necessary items. 

 Click the dialog’s OK button.  The new template window displays. 

In the template window, insert new Groups and POINTs to build the new template’s 

hierarchy structure. 
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 Using the Insert menu, insert desired structure elements (groups and POINTs) in 

the desired configuration into the template window. 

 You may also use Copy, Paste, and Paste Multiple to build your 

template’s structure. 

 

Figure 2 - 54. 

Template Window With Custom Structure. 

When building your template structure, you may also set up custom names using 

“special” characters in the name fields. 

When applying a template, the template wizard assists with naming hierarchy items 

whose template name includes “special” characters 

Custom Names 

Templates hierarchy items may be inserted in your hierarchy : 

 With the name specified in the template, or 

 With the Template wizard prompting you to enter a name for items inserted in your 

hierarchy, or 

 With custom names created by the Template wizard that are based upon your 

existing hierarchy. 

The last two options are accomplished by special characters within your template 

hierarchy names. 

 When a new item is inserted into the Template, its Properties dialog displays. 

 You may also access the Properties dialog by right-clicking to 

access the context menu, or using the Properties toolbar button. 

You can configure the custom naming feature to prompt you to input a unique name for 

the specified item as the template is applied.  You can also set up your template to 

automatically name structure items based on your entered parameters. 
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To set up name prompt: 

 In the Properties dialog’s Name field, enter a “^” as the first character.  During the 

application of the template, the template wizard will prompt you to either accept 

the item’s name as it appears after the “^”, or enter a new name for the hierarchy 

item as the template is being processed. 

Use of special characters enables automatic naming during template application.  Based 

on your entries, the new items take their name from the portions of the parent item’s 

name. 

To set up automatic naming: 

 In the Properties dialog’s Name field, use a “$” to cause the inserted template item 

(child) to use a portion of the target hierarchy parent’s name.  Each “$” in the 

template item’s name is replaced by a sequential word from the target hierarchy 

parent’s name.  Use as many “$”s as necessary.  For example, if the parent item’s 

name is “Dryer Section,” you might apply a template item named  “$ $ Felts.”  This 

will insert the template item (child) and name the it “Dryer Section Felts.” 

 Also, square brackets (“[ ]”) may be used to strip items from the final name.  This 

allows you to use “[ ]”s and “$”s together to use some portions of the parent’s name 

while skipping others.  For example, if the parent’s name is “FD Fan”, and you wish 

to remove the “FD” prefix, place “[ ]”s around the dollar sign representing the “FD” ( 

[$]$ ).  The inserted item will be named “Fan.”  You can also use “[ ]”s to include 

comments that are visible when viewing the template and as the template is 

applied.  The comment text does not appear in the final name.  To do so, enter your 

auto-naming characters followed by your comment text enclosed in brackets.  For 

example, using the earlier “FD Fan” example, the entry “[$]$[left env] would result 

in the item being named “Fan.”  The comment text, “left env” is visible to you when 

you view the template, and as the template is applied, but is deleted from the item’s 

name in the hierarchy list. 

To open an existing template: 

 In the Template window, select the template to open. 

 Click the dialog’s Open button.  The selected template window displays. 

To remove an existing template: 

 In the Template window, select the template to remove. 

 Click the dialog’s Remove button.  When prompted, confirm action. 

The selected template is removed. 

To add a Template Type: 

 In the Template dialog, click Add, or select an existing template and click Edit.  The 

Template Properties dialog displays. 

 In the General tab’s Type field, place your cursor in the drop down list and enter 

the new type name. 

 Click OK to save the new template type and apply it to the current template. 
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Applying Templates 

To apply a template: 

 In your target Hierarchy, select the item under which you wish the template items 

to branch. 

 Select the Insert menu’s Apply Template option.  The Apply Template dialog 

displays. 

The Apply Template dialog lists all available templates. 

 Select desired template and click Apply to launch the Apply Template Wizard. 

Introduction Screen 

 

Figure 2 - 55. 

The Apply Template Wizard Dialog. 

The Apply Template Wizard guides you through the required steps to create new 

entries under the selected hierarchy item, using the selected template. 
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The introduction screen displays the following information about the selected template: 

Name – Displays the name of the template being applied. 

Description – Displays the description provided for the template. 

Destination – Displays the location in the hierarchy to which the template will 

be applied.   

Before continuing, ensure the template name is correct, and ensure the destination is 

accurate. 

 Click Next to continue. 

Configuration Screen 

The template application process begins on the Configuration screen.  This screen 

walks through the template, gathering information as needed:   

Name - If necessary, you will be prompted to specify the name of the item being 

processed. 

Running speed - Specify the machine speeds for the highlighted machine.  This speed 

will be used to set the speed of each POINT beneath the machine.   

 The processing stops to allow you to enter necessary information. 

Custom Naming 

 You will be prompted to enter a name if you set your template up 

using the special  name-prompt character “^.”  Your structure 

elements will be automatically named if you set up your template 

using auto-name characters. 

 Click Next to continue. 

When the template processing is complete, click Next to continue to the build screen. 

 View the template’s progress in the dialog’s progress bar. 

 Click Back to return to the wizard’s last stopping point. 
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Build Screen 

 

Figure 2 - 56. 

The Apply Template Wizard Dialog. 

This screen uses the template to build the template hierarchy items within the specified 

target hierarchy item.   

 The wizard is capable of generating multiple copies of the 

template. 

 Specify the number of copies required. 

 Click Next to build the hierarchy. 

 Click Finish to close the wizard. 

Working with Filters 

Filters allow you to setup and apply filter criteria that determine which POINTs display 

in a new filtered Workspace window.  Filtered workspaces group together POINTs and 

Groups (based on your filter input) in one window for easy comparison and analysis. 

Managing Filters 

Use the Customize menu’s Filters option to manage (add, copy, edit, and remove) 

filters.  This allows you to define reusable filters. 
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To add a new filter: 

 Select the Customize menu’s Filters option.  The Filters dialog displays. 

 Click the Add button.  The Filter Editor dialog displays. 

 

Figure 2 - 57. 

The Filter Editor Dialog. 

Name - Specify the new filter’s name. 

 It is helpful to give the filter a name based on its criteria for easy 

recognition.  For example, if you need to sort Groups based on 

their priority setting, you may want to create and name a filter 

specifically for Priority. 

Keep hierarchy – Click the checkbox to determine whether the hierarchy Groups appear 

with their filtered POINTs in the filtered workspace, or whether only the filtered POINTs 

appear in the filtered workspace.  If disabled, filtered POINTs appear beneath the 

filtered machine without the original hierarchical format.  The filtered workspace lists all 

filtered POINTs under a “Filtered Machine” hierarchy item. 

Filter on attributes – Define which attributes to filter on.  Attributes are categorized by 

machine, measurement, POINT, data type, and/or attribute type.  Select an attribute 

group to modify its individual settings. 

Settings – Displays current individual attribute settings for the specified attribute 

category.  Use the edit fields to view and/or edit attributes as necessary. 

 When one or more attribute within an attribute category is 

included in the current filter, a checkmark displays next to the 

attribute category folder. 



Working With Your SKF @ptitude Inspector Hierarchy 

Working with Filters 

2 - 116 SKF @ptitude Inspector  

 User Manual 

 Use the All and Clear buttons to quickly include all or none of the displayed 

attributes (rather than selecting / de-selecting one by one) for the selected attribute 

category in your current filter. 

Include – Specify whether to filter for POINTs that match every attribute setting, or 

filter for POINTs that match at least one attribute setting. 

Any Selected – Select to filter for POINTs matching any individual attribute of 

the total included in the filter.  Only these POINTs display in the Filtered 

Workspace 

All Selected - Select to filter for POINTs matching all attributes included in the 

filter.  Only these POINTs display in the Filtered Workspace. 

 The number of attributes selected and the total number of 

available attributes displays in the dialog’s lower left corner. 

 Click the OK button to create a new workspace based on the defined criteria of the 

current filter.  A progress bar displays, indicating filter process status. 

 Click Cancel to close dialog without performing filter and without saving filter 

entries. 

To create a new filter based on a copy of an existing filter: 

If you need a new filter that is only slightly different from a previously created filter, you 

can select the previous filter and then edit only the necessary items. 

 In the Filters dialog, select the existing filter you wish to copy and use as a 

template. 

 Click the dialog’s Copy button.  The Filters Editor dialog displays. 

 Enter the new filter’s name. 

 By default, the new filter is given the same name as the copied 

filter on which it is based, with a numerical suffix. 

Filter on attributes - Select additional individual attributes, or edit the existing 

attributes.  When an existing filter is selected, its existing selected attributes display. 

 Click OK to apply the new filter. 

To edit an existing filter: 

 In the Filters dialog, select the existing filter you wish to edit. 

 Click the dialog’s Edit button.  The Filters Editor dialog displays. 

Filter on attributes – Displays the selected existing filter’s selected attributes. 

 Perform your edits and click the dialog’s OK button to save the edited filter. 

To remove an existing filter. 

 In the Filters dialog, select the existing filter you wish to remove. 

 Click the dialog’s Remove button.  Confirm removal when prompted.  The filter is 

removed. 
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Applying Filters 

You can create and apply private and shared filters using the Insert menu’s Apply 

Filters dialog.  When a filter is applied, the resulting items display in a new Workspace 

window. 

To apply a filter: 

 Select the Insert menu’s Apply Filter option.  The Apply Filter dialog displays. 

 

Figure 2 - 58. 

The Apply Filter Dialog. 

Filter – Select an existing filter or <Private Filter>.  This determines what to base your 

filter on (either a copy of an existing shared filter or to create a new private filter). 

Filter on attributes – Displays the selected existing filter’s selected attributes. 

Keep hierarchy - Click the checkbox to determine whether the hierarchy Groups appear 

with their filtered POINTs in the filtered workspace, or whether only the filtered POINTs 

appear in the filtered workspace.  If disabled, filtered POINTs appear beneath the 

filtered machine without the original hierarchical format.  The filtered workspace lists all 

filtered POINTs under a “Filtered Machine” hierarchy item. 

 In the dialog’s Filter from area, select Root node – My Hierarchies to search all 

open hierarchies for matching POINTs.  Select Selected node to search from your 

selected node and below only. 

 In the dialog’s Filter on attributes area, define which attributes to filter on.  

Attributes specific to machine, measurement, POINT, data type, and/or attribute 

type are grouped together.  Select an attribute type to include in the filter. 
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 Attribute settings for the selected attribute group display in the dialog’s Settings 

area.  View and/or edit attributes as necessary in the displayed input fields. 

 Individual attributes are described in detail in the next section. 

 When one or more attribute within an attribute group is included 

in the current filter, a checkmark displays next to the attribute 

group folder. 

Include – Specify whether to filter for POINTs that match every attribute setting, or 

filter for POINTs that match at least one attribute setting. 

Any Selected – Select to filter for POINTs matching any individual attribute of 

the total included in the filter.  Only these POINTs display in the Filtered 

Workspace 

All Selected - Select to filter for POINTs matching all attributes included in the 

filter.  Only these POINTs display in the Filtered Workspace. 

 The number of attributes selected and the total number of 

available attributes displays in the dialog’s lower left corner. 

 Click the dialog’s OK button to apply the filter as a private filter 

 When a filter is applied, the resulting items display in a new 

Workspace window. 

To make the filter a shared filter: 

 Click Share As to assign the current filter a unique name and make it available as a 

shared filter.  The Enter Filter Name dialog displays. 

 Enter a unique filter name and click OK. 

 Click the Apply Filter dialog’s OK button to create a workspace based on the 

defined criteria of the current filter.  A progress bar displays, indicating filter 

process status. 

 Click Cancel to close dialog without performing filter and without saving filter 

entries. 



 Working With Your SKF @ptitude Inspector Hierarchy 

 Working with Filters 

 

SKF @ptitude Inspector 2 - 119 

User Manual 

Individual Filter Attributes 

All individual filter attributes are described below. 

Asset 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated asset (the 

physical machinery occupying the segment). 

Edit – Enter the asset in the text field. 

 Standard wildcard operations are supported. 

Location Method - Machine 

This attribute is located under General / Machine. 

Filters for all Machines configured with the selected Location Method.   

Edit - Select the desired location method for the filter.  Options are Barcode, 

MCQ ID, or None. 

Location Tag - Machine 

This attribute is located under General / Machine. 

Filters for all Machine configured with the entered Location Tag. 

Edit - Enter the location tag for the filter in the text edit field. 

Machine Description 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated 

description. 

Edit – Enter the machine description in text field. 

 Standard wildcard operations are supported. 

Machine Name 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated name. 

Edit – Enter the machine name in the text field. 

 Standard wildcard operations are supported. 

Priority 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated priority 

assignment. 

 Edit – Select one or more priority assignment(s). 
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Segment 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated segment 

(physical location of a Group). 

Edit – Enter the segment in the text field. 

 Standard wildcard operations are supported. 

Alarms 

This attribute is located under Measurement. 

Filters for all POINTs with a last measurement in the indicated alarm. 

Edit – Select one or more alarms from the settings list.  Use the All button to 

select all alarms in the settings list.  Use the Clear button to clear all selections 

from the alarms in the settings list.  Select Include All Selected to include 

POINTs matching all alarm selections.  Select Include Any Selected to include 

POINTs matching at least one alarm selection. 

Last MCD Env. Accel. Value 

This attribute is located under Measurement. 

Filters for all MCD Enveloped Acceleration POINTs with measurement values 

within a range between the entered Minimum and Maximum values. 

Last MCD Temperature Value 

This attribute is located under Measurement. 

Filters for all MCD Temperature POINTs with measurement values within a 

range between the entered Minimum and Maximum values. 

Last MCD Velocity Value 

This attribute is located under Measurement. 

Filters for all MCD Velocity POINTs with measurement values within a range 

between the entered Minimum and Maximum values. 

Last Measurement Date 

This attribute is located under Measurement. 

Filters for all POINTs with a last measurement taken between (and including) 

the specified dates. 

Edit – Enter the dates using standard date selection operation. 

Last Measurement Value 

This attribute is located under Measurement. 

Filters for all POINTs with an overall value (Channel 1) between and including 

specified values. 

Edit – Enter values in the edit fields. 
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Overdue 

This attribute is located under Measurement. 

Filters for all POINTs’ schedule condition (Overdue or Not Overdue). 

Edit – Select Overdue or Not Overdue. 

Number of Days – Enter the number of days (from now).  Filters for POINTs 

matching the selected status (Overdue or Not Overdue) within the entered 

date range. 

Inspection Alarms 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared inspection alarm. 

Edit – Select one or more shared inspection alarm from the settings list.  Use 

the All button to select all shared inspection alarms in the settings list.  Use the 

Clear button to clear all selections from the shared inspection alarms in the 

settings list. 

MCD Alarms 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared MCD alarm. 

Edit – Select one or more shared MCD alarm from the settings list.  Use the All 

button to select all shared MCD alarms in the settings list.  Use the Clear 

button to clear all selections from the shared MCD alarms in the settings list. 

Overall Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared overall alarm. 

Edit – Select one or more shared overall alarm from the settings list.  Use the 

All button to select all shared overall alarms in the settings list.  Use the Clear 

button to clear all selections from the shared overall alarms in the settings list. 

Application Type 

This attribute is located under POINT / General. 

Filters for all POINTs configured to collect the indicated application data. 

Edit – Select one or more application type from the settings list.  Use the All 

button to select all application types in the settings list.  Use the Clear button to 

clear all selections from the application types in the settings list. 

DAD Type 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated DAD type. 

Edit - Select one or more DAD type from the settings list.  Use the All button 

to select all DAD types in the settings list.  Use the Clear button to clear all 

selections from the DAD types in the settings list. 



Working With Your SKF @ptitude Inspector Hierarchy 

Working with Filters 

2 - 122 SKF @ptitude Inspector  

 User Manual 

Enable / Disable 

This attribute is located under POINT / General. 

Filters for all POINTs enabled or disabled for download. 

Edit – Select Enable or Disable. 

Filter Keys 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated filter key(s). 

Edit - Select one or more filter key from the settings list.  Use the All button to 

select all filter keys in the settings list.  Use the Clear button to clear all 

selections from the filter keys in the settings list.  Select Include All Selected 

to include POINTs matching all filter key selections.  Select Include Any 

Selected to include POINTs matching at least one filter key selection. 

POINT Description 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated description. 

Edit – Enter POINT description in POINT Description field. 

POINT Name 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated name. 

Edit – Enter POINT name in POINT Name field. 

 Wildcard characters are available for use. 

Sensor Type 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated sensor type. 

Edit - Select one or more sensor type from the settings list. 

Evaluation Time 

This attribute is located under POINT / Derived. 

Filters for all derived POINTs with the indicated evaluation time. 

Edit – Enter the evaluation Units, and Minimum and Maximum values in the 

appropriate fields. 

Expression 

This attribute is located under POINTs / Derived. 

Filters for all POINTs with the selected shared expression. 

Edit – Select one or more expressions from the settings list.  Use the All 

button to select all expressions in the settings list.  Use the Clear button 

to clear all selections from the settings list. 
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Compliance 

This attribute is located under POINT / Schedule. 

Filters for all POINTs with the indicated compliance schedule setting (as 

configured in POINT Properties / Compliance). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units.   

 Units are automatically evaluated for compatibility.  For example, 

an entry of 24 hours will include a POINT with a DAD schedule set 

to 1 day. 

Keep Current Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Keep Current Data units (as 

configured in POINT Properties / Schedule). 

Edit - Select units from the drop down list.  Enter minimum and maximum 

number of selected units.   

Keep Unscheduled Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching indicated Keep Unscheduled Data units (as 

configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Long Term Archive Keep Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Long Term Archive Keep Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Long Term Archive Take Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Long Term Archive Take Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Short Term Archive Keep Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Short Term Archive Keep Data 

units (as configured in POINT Properties / Schedule). 
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Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Short Term Archive Take Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Short Term Archive Take Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Unscheduled 

This attribute is located under POINT / Schedule. 

Filters for all POINTs without a configured compliance schedule. 

Conditional POINT 

This attribute is located under POINT / Setup. 

Filters for all POINTs with a common conditional POINT. 

Edit - Select conditional POINT(s) from settings list.  Use the Clear button to 

clear all selections from the settings list. 

Full Scale, Full Scale gE, Full Scale Temperature, Full Scale Velocity 

This attribute is located under POINT / Setup. 

Filters for all POINTs whose Full Scale setting falls within the indicated full 

scale value range.  

Edit – Select unit types from the settings list.  Use the All button to select all 

unit types in the settings list.  Use the Clear button to clear all selections from 

the settings list.  

Full Scale Units 

This attribute is located under POINT / Setup. 

Filters for all POINTs matching the indicated Full Scale Units type  

Edit – Select full scale unit types from the settings list.  Use the All button to 

select all full scale unit types in the settings list.  Use the Clear button to clear 

all selections from the full scale units settings list. 

Location 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated location setting. 

Edit – Select location(s) from the settings list.  Use the All button to select all 

locations in the settings list.  Use the Clear button to clear all selections from 

the settings list. 



 Working With Your SKF @ptitude Inspector Hierarchy 

 Working with Filters 

 

SKF @ptitude Inspector 2 - 125 

User Manual 

Form Type 

This attribute is located under POINT / Setup. 

Filters for all POINTs configured with the selected Form Type. 

Edit - Select the desired form type for the filter.  Options are Keypad, Bar, 

Slider, or Gauge. 

Location Method - POINT 

This attribute is located under POINT / Setup. 

Filters for all POINTs configured with the selected Location Method.   

Edit - Select the desired location method for the filter.  Options are Barcode, 

MCQ ID, or None. 

Location Tag - POINT 

This attribute is located under POINT / Setup. 

Filters for all POINTs configured with the entered Location Tag. 

Edit - Enter the location tag for the filter in the text edit field. 

Minimum Scale 

This attribute is located under POINT / Setup. 

Filters for all POINTs whose Minimum Scale value falls between the specified 

range. 

Edit - Enter the minimum and maximum values for the filter range in the text 

edit fields. 

Orientation 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated orientation. 

Edit – Select orientation(s) from the settings list.  Use the All button to select 

all orientations in the settings list.  Use the Clear button to clear all selections 

from the settings list. 

Save Data 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated save data setting. 

Edit - Select save data setting from the settings list.  Use the All button to 

select all save data settings in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Clear Alarm Non Collection  

This attribute is located under POINT / General.  

Filters for all POINTs with Clear Alarms for Non-collection last 

measurements enabled or disabled. 

Edit – Select Enable or Disable. 
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Exclude Non-Collection From Report 

This attribute is located under POINT / General.  

Filters for all POINTs with Exclude from reports if last measurement is a 

Non-collection event enabled or disabled. 

Edit – Select Enable or Disable. 

Customize / Derived POINTs 

The Derived POINTs dialog allows you to customize shared expressions, create new 

expressions, and to edit variables, constants, and the expression formula. 

 

Figure 2 -  59. 

The Customize menu’s Derived POINTs Expressions tab. 

To customize a shared expression: 

 Select the expression you wish to edit from the Expressions drop down list. 



 Working With Your SKF @ptitude Inspector Hierarchy 

 Customize / Derived POINTs 

 

SKF @ptitude Inspector 2 - 127 

User Manual 

Important - Any changes made to a shared expression affect all other POINTs 

sharing that expression, and overwrites the currently selected expression. 

 You may rename the shared expression in the Name entry box.  

 Click the Variables button to edit, add, or remove variables.   

 You cannot assign POINTs to the variables from the Customize / 

Derived POINTs dialog.  Refer to the POINT Properties / 

Expressions tab section earlier in this chapter for details on 

assigning POINTs to variables. 

 

Figure 2 - 60. 

The Variables Dialog. 

 Edit the expression formula by inserting variables, constants, or formulas.   

 To add a new expression, click the Add button, and enter settings 

as previously described in this chapter’s POINT Properties / 

Expression Tab section. 

To edit constants: 

There are two ways to edit shared constants.  You can edit constants using the 

Expressions tab's Constants button, or by using the Constants tab.  Both methods 

are described below. 

 From the Expressions tab, click the Constants button to add a new constant to the 

Constants list.  In the Constants dialog, click the Add button. 

Or 

 Click the Constants tab to add or remove a constant, or to edit pre-existing 

constants. 

 Click the Add button to create a new constant, or select a constant from the 

Constants list and edit the Name and Value in the Constant properties area.   
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 Click the Remove button to remove the selected constant from the Constants list. 

 

Figure 2 - 61. 

The Customize menu’s Derived POINTs Constants tab.  

Important – After editing a derived POINT, you must manually calculate the derived 

POINT to update the POINT’s existing data records.  Reference the Calculating 

Derived POINTs section earlier in this chapter for details. 
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3 

Data Collection ROUTEs and Other Data Transfer 

Operations 

Overview 

After establishing your database's POINTs, you are ready to create your collection 

ROUTEs. 

 It is not imperative that you create @ptitude Inspector ROUTEs to 

download POINTs to the data acquisition device.  Downloading 

directly from a plant hierarchy list is discussed later in this 

chapter. 

A ROUTE is a measurement POINT collection sequence.  ROUTEs are downloaded to a 

DAD to provide orderly collection of measurement data on a timely basis. 

ROUTEs are first created on paper.  You simply walk through your facility and list (in a 

logical, efficient collection sequence) the equipment and pre-defined POINTs you plan to 

collect at a given time.  For example, list the measurements you plan to perform weekly 

(e.g., every Tuesday) as “Tuesday's ROUTE”, and/or list the measurements you plan to 

perform monthly as the “monthly ROUTE.” 

Take time to organize your collection ROUTE paper copy thoroughly.  A complete and 

organized paper copy collection ROUTE makes building @ptitude Inspector ROUTEs 

much easier. 

After establishing your paper copy ROUTE(s), your next task is to use your paper copy 

ROUTE to create a @ptitude Inspector ROUTE. 

How To Build ROUTEs 

@ptitude Inspector's method for creating ROUTEs is simple. 

Using your paper copy ROUTE, open the Hierarchy, ROUTE, or Workspace window for 

those measurement POINTs you wish to have in the ROUTE, and copy selected items 

(machines with their POINTs, SETs with their machines and POINTs, Custom Groups 

with their machines and POINTs, or the entire hierarchy) from the open Hierarchy 

window to the new ROUTE window, creating the new ROUTE's hierarchy list. 

You may also insert (Insert menu) Groups directly into a ROUTE window, then select 

POINTs from a Hierarchy, ROUTE, or Workspace window, and copy them to your new 

ROUTE, organized beneath your newly inserted Groups. 

If necessary, move hierarchy items in the ROUTE window to match the most efficient 

collection sequence (detailed on your paper copy ROUTE). 

You can also configure your ROUTE to keep ROUTE statistics by designating it as a 

Structured ROUTE.  Statistical ROUTE information can provide valuable information to 

assist in managing your ROUTEs. 
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 IMPORTANT - When moving hierarchy items to create the most 

efficient collection sequence, note that in a ROUTE list, parental 

hierarchy items always remain attached to their measurement 

POINTs.   

 IMPORTANT - In a ROUTE window, changes to a POINT’s 

placement in the list, and POINT deletions do not affect the 

Hierarchy window (database).  However, changes to individual 

POINT setup settings (POINT Properties) do apply to the database 

and reflect in Hierarchy window. 

 

Changes to Group item Properties do not affect the database / 

Hierarchy window. 

To open an existing ROUTE: 

 Select the View menu’s ROUTE command.  The ROUTE dialog displays. 

 Select an existing ROUTE and click the Open button.  The selected ROUTE window 

opens. 

To add a new ROUTE: 

 Click the ROUTE dialog’s Add button.  The ROUTE Properties dialog displays. 

ROUTE Properties / General 

 

Figure 3 - 1. 

The ROUTE Properties / General Dialog. 
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ROUTE Properties / General fields include: 

Name – Enter a new ROUTE name. 

Description – Enter a new description. 

The ROUTE Statistics area allows you to make your ROUTE a structured ROUTE, and 

determine the type of historical information to keep.  If historical record settings are 

entered, then ROUTE statistics, such as collection time duration, start and stop times, 

and operator ID, are recorded with the ROUTE.  If the ROUTE is designated as a 

structured ROUTE, then data must be collected in the order in which the POINTs are 

listed in the ROUTE. 

To create a structured ROUTE: 

 Click the Structured ROUTE checkbox to designate the selected ROUTE as a 

structured ROUTE. 

To enter ROUTE statistic settings: 

 Click an option button to specify the amount of historical records to keep.  Included 

in each historical record are the ROUTE’s collection time duration, start and stop 

times, and Operator ID.  Options include: 

Keep all historical records – Saves all historical ROUTE collection statistics for 

the selected ROUTE. 

Keep fixed number of historical records – Enter the number of historical 

records to save for the selected ROUTE. 

Keep records for – Enter a time duration value for storing historical records.  

For example, enter 6 in the text box and select weeks from the drop down list 

to save historical records for 6 weeks.   

The number of POINTs included in the selected ROUTE display at the bottom of the 

dialog. 
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ROUTE Properties / Schedule 

  

Figure 3 - 2. 

The ROUTE Properties / Schedule Dialog – Interval-based. 

On the ROUTE Properties / Schedule dialog, click the Enable collection schedule 

checkbox to configure the ROUTE’s collection schedule. 

ROUTE Properties / Schedule has schedule types: 

Interval-based – Select Interval-based if you wish to schedule data collection at a set 

time interval. 

and 

Calendar-based – Select Calendar-based if you wish to schedule data collection based 

on a calendar date and time.  Calendar-based schedules are set up in the Customize / 

Database’s Compliance dialog. 

Interval-based fields include: 

Schedule – Enter the ROUTE’s collection interval (in days or hours, starting from the 

Next ROUTE Due entry). 

Next ROUTE due – Enter the beginning collection date and time for the ROUTE. 

Together, the Next ROUTE Due and Schedule fields establish the ROUTE’s collection 

schedule. 

First shift starts at – Enter the time the first shift begins. This field is only available if 

the Schedule entry is in hours. 
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Figure 3 - 3. 

The ROUTE Properties / Schedule Dialog – Calendar-based. 

Calendar-based fields include: 

Start date – Select the initial start date of when the data collection interval is 

scheduled. 

Start time – Select the initial start time of when the data collection interval is 

scheduled. 

End time – Select the time at which the ROUTE is considered overdue if data collection 

does not occur. 

Collection schedule – Choose a collection schedule and set the appropriate dates and 

frequencies as described below. 

Hourly – Enter the duration of shift in hour(s). (i.e., Duration of shift: 8 hrs) 

Daily  - Enter the frequency of the collection schedule in day(s). (i.e., Every 2 days) 

Weekly – Enter the frequency of the collection schedule in week(s), and select the day of 

the week that the collection schedule interval will start and end on. (i.e., Every 2 weeks 

on Monday) 

Monthly – Select the day of the month (1-31) and the frequency of the collection 

schedule in month(s) (i.e., Day 1 of every 1 month(s)); or select a day of the week and 

the 1st, 2nd, 3rd, 4th, or last week of the month, and the frequency of the collection 

schedule in month(s). (i.e., The 2nd Friday of every 1 month(s)) 
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Yearly – Select the month / day and the frequency of data collection in year(s). (i.e., 

January 1st  of every 1 year(s)); or select a day of the week, the 1st, 2nd, 3rd, 4th, or last 

week of the month, the month, and the frequency of the collection schedule in year(s). 

(i.e., The 2nd Friday of January every 1 year(s)) 

ROUTE Properties / Notes 

ROUTE Properties / Notes fields include: 

ROUTE instruction notes – Allows you to create, edit, and store instructions / 

notes relating to the ROUTE.  ROUTE instructions are downloaded to the data 

acquisition device along with the ROUTE, and may be viewed on the DAD’s LCD 

panel. 

 Enter appropriate ROUTE properties and click OK.  The new ROUTE’s window 

displays. 

 Use drag and drop or copy and paste operations to copy selected Groups and 

POINTs, from the Hierarchy or Workspace windows into the new ROUTE's window 

to create the new ROUTE's hierarchy list. 

 

Figure 3 - 4. 

The ROUTE Window With Copied Items. 

To remove an unnecessary ROUTE: 

 In the ROUTE dialog, select the ROUTE name. 

 Click the Remove button.  Confirm action when prompted.  The selected ROUTE is 

removed. 
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To set the same measurement speed for multiple FFT measurements: 

 Starting from a ROUTE, expand the appropriate machine. Beneath the machine in 

the hierarchy, right-click on the measurement POINT you wish to use as a 

reference and select Set Speed (Multiple) from the resulting context menu. 

OR 

 Starting from a ROUTE, expand the appropriate machine. Beneath the machine in 

the hierarchy, click on the appropriate measurement POINT to display its 

measurements in the right panel. Then, right-click on the single measurement you 

wish to use as a reference and select Set Speed (Multiple) from the resulting 

context menu. 

The Set Speed (Multiple) window appears. 

Synchronizing the Microlog Inspector with SKF @ptitude Inspector 

 The Microlog Inspector differs from the MARLIN in the way that it 

communicates with SKF @ptitude Inspector.  For MARLIN 

transfer information, reference the Downloading ROUTEs to the 

MARLIN section later in this chapter. 

The Microlog Inspector’s Synchronization feature provides automatic data transfer 

between the Microlog Inspector device and @ptitude Inspector software.  Automatic 

data transfer includes: 

 Establishing communications 

 Uploading collected data from the device. 

 Downloading a profile to the device (i.e., operator settings, ROUTEs / workspaces, 

previous measurement records, etc.) 

Prior to using your Microlog Inspector for the first time, you must: 

 Set up the device to communicate with @ptitude Inspector 

 Assign a profile to your device 

 Perform a synchronization to download the profile to your device. 

Once the initial synchronization is performed, you can easily transfer data between the 

Microlog Inspector and SKF @ptitude Inspector by simply docking the device.   

To set up the Microlog Inspector for data transfer: 

 Set up communications on the Microlog Inspector.  Reference your Microlog 

Inspector User Manual for details. 

 On the Microlog Inspector main menu, click Synchronize.  The Microlog Inspector 

communicates with SKF @ptitude Inspector and is recognized by @ptitude 

Inspector as an “available” device. 

 In SKF @ptitude Inspector, assign a profile to the Microlog Inspector using the 

Customize menu’s Microlog Inspector Settings dialog.   
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 Reference the Microlog Inspector Settings section in Chapter 2, 

Working With Your @ptitude Inspector Hierarchy for details on 

how to set up and assign profiles. 

 On the Microlog Inspector, click the Synchronize button again to download the 

profile (operator settings, routes / workspaces, etc.) to the device. 

You are now ready to collect data and transfer data between the Microlog Inspector 

device and SKF @ptitude Inspector software. 

Downloading ROUTEs to the MARLIN 

 The MARLIN differs from the Microlog Inspector in the way that it 

communicates with SKF @ptitude Inspector.  For Microlog 

Inspector transfer information, reference the Synchronizing the 

Microlog Inspector with SKF @ptitude Inspector section earlier 

in this chapter. 

MARLIN Transfer Overview 

The MARLIN transfer function allows you to download measurement POINT setups to 

the MARLIN, upload collected data from the MARLIN, check the MARLIN status, and 

configure, clear, or reset the MARLIN . 

To Set Up the MARLIN for Data Transfer: 

 Connect the MARLIN to the host computer.  Reference your MARLIN User Manual 

for specifics. 

 Turn on the MARLIN. 

 On the MARLIN, access the Transfer screen.  The MARLIN is ready to communicate 

with @ptitude Inspector. 

 In @ptitude Inspector, Select MARLIN from @ptitude Inspector’s Transfer menu.  

The MARLIN dialog displays and the MARLIN is ready to communicate with 

@ptitude Inspector. 

 The software automatically checks for a connection between the host computer and 

the MARLIN .  An alert dialog displays if there is a connection error.  

 If you are using a serial connection, the software's auto detection 

capabilities will alert you of connection status. 

 Check the dialog’s Status tab to compare the MARLIN's current database to the 

current @ptitude Inspector database.  If there is a database discrepancy, an error 

dialog appears when the download process is initiated. 
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Download to DAD 

 

Figure 3 - 5. 

The MARLIN Dialog’s Download to DAD Tab Displaying Tree View. 

Items available for download appear in the tab's Select items to download window.  

You can download items from the Hierarchy, ROUTEs, and Workspaces directly using 

Tree View or select one or more ROUTEs using ROUTE View by clicking the item’s 

check box. 
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Tree View 

Select items to download in Tree View: 

 A checkmark in the checkbox indicates all items in the Hierarchy, ROUTE, or 

Workspace are selected. 

 A grey checkmark indicates some items are selected. 

 No checkmark indicates no items are selected. 

 By default, only Hierarhchies, ROUTEs, and Workspaces 

associated with the primary hierarchy display for download in 

Tree View.  To display all Hierarchies, ROUTEs, and Workspaces 

associated with all open hierarchies, you must enable the Allow 

multiple hierarchy support on DADs option on the Customize / 

Preferences / General dialog. 

ROUTE View 

 

Figure 3 - 6. 

The MARLIN Dialog’s Download to DAD Tab Displaying ROUTE View. 
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ROUTEs are organized into six categories; ROUTE Name, Due Date, Schedule Date, 

Last Download Date, Overdue Status, and Hierarchy.   

 Only complete ROUTEs may be downloaded.  To download 

individual POINTs, select them from Tree View. 

 By default, only ROUTEs associated with the primary hierarchy 

display for download in ROUTE View.  To display all ROUTEs 

associated with all open hierarchies, you must enable the Allow 

multiple hierarchy support on DADs option on the Customize / 

Preferences / General dialog. 

Download Options 

There are three Download Options: 

Coded Notes 

If enabled, all coded notes from the Customize menu’s Database dialog’s 

Coded Notes tab will be downloaded to the MARLIN. 

 Click to enable the Coded Notes checkbox. 

Use last Inspection Result(s) as default 

If enabled, the previous Inspection Result(s) appear selected in the MARLIN’s 

Inspection POINT Data Collection screen. 

 Click to enable the Use last Inspection Result(s) as default checkbox. 

Download Previous Measurements 

 Enter a number between 1 and 99 or use the arrows to indicate how many 

previous measurements you would like to download. 

Hierarchy Name 

If you select items directly from the Hierarchy list, they will appear as a specially named 

ROUTE in the MARLIN. 

 Assign a unique name in the Hierarchy Name text field for identification purposes. 

Download button 

 Click to begin the download.  The download progress displays in the progress bar. 
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Upload from DAD 

After you have completed collecting data, re-connect the MARLIN and establish 

communications using the same procedure described earlier for downloading. 

 

Figure 3 - 7. 

The MARLIN / Upload from DAD Tab. 

Select items to upload or remove – Displays all ROUTEs currently stored in the 

connected MARLIN.   

 Select the ROUTE(s) you wish to upload or remove (multiple selections are allowed). 

 By default, only ROUTEs associated with the primary hierarchy 

display for upload.  To display all ROUTEs associated with all open 

hierarchies, you must enable the Allow multiple hierarchy 

support on DADs option on the Customize / Preferences / 

General dialog. 
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To Upload Data: 

 Click the Upload button to initiate the upload process.  POINTs are automatically 

processed into the database after the upload.  Process status displays on the status 

bar. 

Status 

The Status tab displays the connected MARLIN's status, and compares the Microlog’s 

current database with the current @ptitude Inspector database.  Status information 

appears in the Device status information window. 

 

Figure 3 - 8. 

The MARLIN Dialog’s Status Tab. 

The tab’s Configuration Parameters area provides an option to select operator sets 

and download them to the DAD, and to specify a network location for MARLIN initiated 

uploads.   

Operator sets – Select an operator set from the drop down list.  The specified operator 

set downloads to the MARLIN unit when you click the Clear / Reset buttons.   
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 Click the View Sets button to view all operators assigned to the selected operator 

set. 

 Select a set from the drop down list.  All operators included in the selected set 

display in the Operators area.   

LAN Support 

@ptitude Inspector's LAN support for MARLIN allows you to upload data from a MARLIN 

with firmware version 4.0 or higher to a specified LAN location.  While this LAN location 

need not be installed with the @ptitude Inspector application, it must be accessible by 

both a PC running @ptitude Inspector software and the MARLIN DAD.  @ptitude 

Inspector automatically detects the upload to the specified network location and begins 

processing the data.  The LAN support feature allows you to quickly upload data to the 

network instead of having to physically return to a PC running @ptitude Inspector 

software to initiate the upload.  This allows multiple users to upload their data without 

"tying up" the dedicated @ptitude Inspector PC. 

Location – Type in the LAN path, or use the Browse button to locate a network location 

to store MARLIN-initiated upload data.  If a LAN location is not specified, the Upload 

screen's LAN button is disabled on the MARLIN DAD and uploads must be initiated from 

@ptitude Inspector. 

 Press the Config button to download the LAN location to the MARLIN.  When you 

initiate an upload from the MARLIN, the data is uploaded to the specified LAN 

location, and is then automatically detected and processed by @ptitude Inspector. 

 Press the LAN Location's Clear button (beneath the View Sets button) to clear your 

specified LAN location.  If no location is specified, uploads can only be performed 

from @ptitude Inspector, and may not be initiated from the MARLIN DAD.  

Device status information includes: 

Internal Clock – Date and time from the MARLIN's clock. 

Data Source – The name of the source database for POINTs currently stored in the 

MARLIN. 

POINTs Downloaded – Number of POINTs currently stored in the MARLIN. 

Version – The MARLIN's firmware version number. 

Free RAM – The percent of the MARLIN's memory that is free for storage. 

Battery – The MARLIN's battery voltage level. 

Status – Displays the MARLIN's status string located on the MDM. 

Three command buttons appear in this tab.  They are: 

Config – Use this option to change databases, or when the MARLIN's internal clock is 

incorrect.  It updates the MARLIN's status information to match those of the host 

computer.  The Config button also downloads the entered LAN location (if applicable) to 

the MARLIN for MARLIN initiated uploads.  

Clear – Use this option to clear the entire MARLIN. It erases all data, SETs, Machines, 

POINTs, ROUTEs, ROUTE Instructions, non-ROUTE POINTs, and coded notes stored in 

the MARLIN. All existing operator names are removed and replaced with the operators 

in the selected operator set. It does not change the MARLIN's menu settings. 



 Data Collection ROUTEs and Other Data Transfer Operations 

 Communication 

 

SKF @ptitude Inspector 3 - 15 

User Manual 

Reset – Use this option to clear collected data but leave the downloaded SETs, 

Machines, and POINTs.  It deletes all spectral data, deletes all non-ROUTE POINTs and 

POINT data, and resets the current measurement data to zero for all POINTs (current 

values are retained as LAST values).  ROUTEs, SETs, Machines, and POINT sequence 

and measurement instructions are not affected.  This allows you to take data for a 

ROUTE, upload it, reset the data out of the Microlog without losing the ROUTEs, SETs, 

Machines, or POINTs, and then take data on the same ROUTEs, SETs, Machines, or 

POINTs again..  The reset option also downloads operator names within the selected 

operator set to the MARLIN.  The operator names are appended to the device's operator 

list. 

The ROUTEs area displays all ROUTEs present on the MARLIN device. 

Communication 

Communication options control communication between the software and the MARLIN.  

Configure communication settings in the Communication tab. 

Connection settings include: 

Communication type - Select the Serial communication setting from the drop-down 

list to communicate using a serial cable.  Select the ActiveSync communication setting 

from the drop-down list to communicate using Microsoft’s ActiveSync (via USB, serial, 

TCP/IP, or whatever other communication protocols ActiveSync supports). 

 Selecting USB communication type disables the Port and Serial 

Baud Rate drop-down lists.  Use ActiveSync’s Connection 

Settings to configure communication parameters. 

 Refer to Microsoft.com for more information about ActiveSync 

communication. 

Port (COM1, COM2, COM3, COM4) – Used in Serial mode.  Specify the host computer's 

COM port you are using. 

Serial Baud Rate - Set the baud rate for direct, hard-wired communications.  This 

setting must match the MARLIN’s Baud Rate setting. 

Reconnect - Click the Reconnect button to reconnect your modem connection between 

the MARLIN and the host computer. 

 Click the Close button when finished. 

Sync Data 

Sync Data is the term used for automatic data synchronization between the MARLIN 

device and @ptitude Inspector.  Data synchronization is initiated from the MARLIN 

device when it is docked.   

 For more information about initiating Sync Data, refer to your 

MARLIN Firmware User Manual. 

 Before Sync Data can occur, you must enable the MARLIN Sync 

Data user preference.   
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During data synchronization, @ptitude Inspector automatically uploads all collected 

ROUTE data from the MARLIN, clears the device, and downloads new ROUTE 

information to the device. 

 If you download a ROUTE or workspace, the entire ROUTE or 

workspace will be re-downloaded upon each Sync Data operation.  

Likewise, if you download a Hierarchy, only the POINTs will be re-

downloaded. 

When data synchronization is in progress, a progress bar displays in @ptitude Inspector.  

Once complete, the progress bar simply goes away, and you may continue normal 

operations. 

Manual Data Entry 

Inspection 

Use the Insert menu's Manual Entry dialog to manually enter inspection measurement 

values into your @ptitude Inspector database.  This feature allows you to store 

inspection measurements.  The Manual Entry dialog allows you to manually enter one 

inspection measurement per POINT. 

 

Figure 3 - 9. 

The Manual Entry Dialog for Inspection POINTs. 
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To manually enter data: 

 Select a POINT from the Items area.  The Measurement information area 

updates to show the current measurement’s POINT name, Machine, Date and 

Time settings. 

 Use the option buttons (Single-Select Inspection POINTs) or checkboxes (Multi-

Select Inspection POINTs) to select the value in the Measurement data area. 

 Click the Set button. 

 By default, the current date / time is applied to the entered POINT 

value.  Select desired date and time from the drop down menus 

to edit these fields as needed. 

To clear any field: 

 Place the cursor in the desired field and click the Clear button. 

 Click OK to store the entered values and automatically re-process alarms. 

 Click Cancel to undo settings. 

MCD 

Use Insert menu's Manual Entry dialog to manually enter MCD measurement values 

into your @ptitude Inspector database.  This feature allows you to store, view, and 

analyze measurements made with the MCD.  The Manual Entry dialog allows you to 

manually type in one set of MCD values per POINT. 

 

Figure 3 - 10. 

The Manual Entry Dialog for MCD POINTs. 
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To manually enter data: 

 Select a POINT from the Items area.  The Measurement information area 

updates to show the current measurement’s POINT name, Machine, Date and 

Time settings. 

 Use the text boxes to enter each MCD value (Env. Acceleration, Velocity, and 

Temperature) in the Measurement data area. 

 Click the Set button. 

 By default, the current date / time is applied to the entered POINT 

value.  Select desired date and time from the drop down menus 

to edit these fields as needed. 

To clear any field: 

 Place the cursor in the desired field and click the Clear button. 

 Click OK to store the entered values and automatically re-process alarms. 

 Click Cancel to undo settings.
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4 

Displaying Graphic Plots 

Overview 

After uploading your measurement data to @ptitude Inspector, you can easily display 

the collected measurements in various plot formats for machinery analysis purposes. 

Graphic MARLIN / Microlog Inspector plot formats include: 

 MCD Plot 

 Inspection Plot 

 Trend Plot 

 Spectrum Plot 

How To Display Graphic Plots 

@ptitude Inspector offers multiple methods for displaying measurement data in plot 

format.  Each method has its advantages.  However, regardless of the selected method, 

the first step in displaying plots is to open any view that contains POINTs (Hierarchy, 

ROUTE, Workspace, Plot, and Alarms view).  The second step is to select the 

measurement POINT(s) whose data you wish to display in plot form.   

Then use one of the following methods for displaying measurement data in graphic plot 

format. 

 The File menu's Print option may be used at any time to print the 

contents of the “active” window (including graphic display 

windows). 

Displaying Plots Using Toolbar Buttons 

@ptitude Inspector has toolbar buttons for commonly used plots. 
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Figure 4 - 1. 

Plot Toolbar Buttons (Shown Here as Two Columns). 

 To select multiple POINTs for display in a single plot, you must 

first select the machine in which the POINTs list in the hierarchy’s 

left panel, then select the desired multiple POINTs in the 

hierarchy’s right panel. 

 To select POINTs from multiple machines, you must first copy the 

desired POINTs to a Workspace window. 
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To display graphic plots using the toolbar: 

 Select (highlight) the POINT(s) you wish to display in the Hierarchy, ROUTE, 

Workspace, or Alarms windows. 

 Click one of the toolbar's graphic display buttons to display the selected POINTs or 

measurement(s) in a specific type of plot. 

 Click the All Plots toolbar button to display the All Plots dialog.  From this dialog, 

you may select the plot type to display from all available plots, rather than only the 

commonly used plot types represented with toolbar buttons. 

 Different plot display toolbar buttons may be manually added 

using the Customize menu’s Toolbars option.  Custom toolbars 

are detailed in Appendix A, SKF @ptitude Inspector Toolbars. 

Displaying Plots Using the View Menu 

View menu graphic display operations are similar to toolbar button graphic display 

operations. The View menu allows you to display every graphic plot type that applies to 

the selected POINT(s).   
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Figure 4 - 2. 

The View Menu’s Plots Option. 

To display graphic plots using the View menu: 

 Highlight the POINT(s) you wish to display in the Hierarchy, ROUTE, Workspace, or 

Alarms windows. 

 Select the View menu’s Plot option.  Select one of the visible plot types, or select 

All Plots for more selections.  All plot types display in the dialog.   
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Displaying Plots Using the POINT’s Context Menu 

You can also display a plot directly from selected single or multiple POINTs using the 

context menu.   

To display a plot using the context menu: 

 Select POINT(s) from a Hierarchy, ROUTE, Workspace, or Alarm window. 

 Using your mouse, right click to activate the context menu. 

 

Figure 4 - 3. 

Selecting a Plot from the Context Menu. 

 Select the desired Plot type.  The selected plot type displays in a plot window for 

the selected POINT(s). 

 You can also use the right-click context menu to display a plot 

directly from a selected single measurement data record or 

multiple measurement data records. 
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Plot Window 

The Plot window displays collected measurements in various graphic plot formats for 

machinery analysis purposes. 

 

 

 

 

Figure 4 - 4. 

Plot Window. 

 cursor feedback  various overlay tabs 

 mouse feedback  active overlay   

 inactive plot line  inactive overlays 

 active plot line  right-click context menu 

 running speed anchor   

Plot Window Overview 

The Plot window’s title bar displays the plot type displayed for the current POINT.  The 

Machine name (from the hierarchy) corresponding to the POINT displays in front of the 

POINT name (for a single POINT).  The Machine and POINT name display in the plot 

window’s top center area for all plots.  The date / time stamp and overall value display 

for spectrum and time plots.  Multiple POINTs are not individually identified. 

There are two areas in the Plot window.  The top area is the plot area.  The lower part 

is the information area. 

 You may re-size the entire Plot window, and/or either of the 

window's areas, for customized viewing.  You may also hide the 

information area automatically (using Preferences) or manually 

(using the toolbar or context menu). 

 The status of the information area affects plot print-out.  If a plot 

is printed when the Info tab is displayed, the Info tab’s 

information prints along with the plot.  If a plot is printed when 

the Info tab is hidden, the Info tab’s information does not print 

with the plot. 
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Plot Window Information Area  

 

Figure 4 - 5. 

Plot Window Information Area. 

The information area’s tabs display various plot information for the active plot.   

Info tab – Displays general information for the active plot.  

Summary tab – Displays measurement summary information for all POINTs displayed 

on the plot.   

Plot type tab (Trend, Spectrum, etc.) – Displays information for each single cursor on 

the active plot.   

Other tabs appear in the information area depending on the type(s) of overlay(s) used 

on the current plot, and display information specific to each overlay type. 

Plot Feedback Areas  

 

Figure 4 - 6. 

Portion of Plot Window. 

 feedback areas 

The first line displays information corresponding to the active cursor overlay’s current 

position. 

The second line displays information corresponding to the mouse pointer’s current 

position (when positioned over a plot item). 

Plot Window Operations 

Mouse Operations 

There are several ways to work within the Plot window.  The mouse can be used to 

display specific plot information.  The mouse’s pointer changes to an up arrow () when 

placed over a plot item.  Typical plot items include overlay, plot line (trace), anchor, any 

object with feedback information, and context menus. 
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Overlays 

Plot “overlays” superimpose cursors, alarms, text annotations, and frequency markers 

on displayed plots.  Each overlay displays an “anchor” which you use to manipulate the 

overlay. 

Anchors 

Anchors indicate overlays and plot lines on the active plot.  Anchors also identify the 

active status of an overlay and plot line (trace). 

The Active plot line anchor is indicated using a triangle icon.  Plot line anchors 

display on the plot’s left. 

The Active overlay anchor is indicated using a square icon.   Active overlay 

anchors indicate which plot’s data is displayed using the plot’s color in the 

overlay’s square icon.   

Inactive plot line and overlay anchors are indicated using circle icons. 

 Double-click an overlay’s anchor to switch it to another plot.   

Some overlay anchors appear at the top of the plot, others appear to the plot’s right.  

Band cursor, harmonic cursor, sideband cursor, and single cursor anchors display 

across the top of the plot, directly above their respective overlays.  Band alarm, 

envelope alarm, frequencies, curve fit, overall alarm, and peak cursor anchors display 

on the plot’s right.  The running speed anchor displays beneath the plot. 

Many anchors indicate overlay position in respect to the plot’s X and/or Y axis.  Anchors 

provide easy access to the plot item’s right-click context menu.  For example, to access 

the settings dialog for your frequencies overlay, right-click on the frequency overlay 

anchor to launch the frequencies Settings dialog. 

If two or more traces are displaying on a plot and an overlay is added to the plot, it 

automatically attaches itself to the active plot line (trace). 

Text annotations (temporary textual notations ) may be placed anywhere on the plot. 

Text annotations do not have anchors. 

 

Figure 4 - 7. 

Plot Window with Text Annotation. 
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Plot Line (Trace) Right-Click Context Menu 

Position the cursor over the plot line and using your mouse, right-click to access the 

plot line context menu.  Menu options include: 

Lock Trace – Enable this option to “lock” the selected plot line data so it will 

remain visible when auto linking is used.  This allows you to compare the 

“locked” plot line data to the new data that is added or removed when 

autolinking is used. 

Remove – Removes trace from plot. 

Properties – Displays POINT Properties dialog for the plot’s active POINT. 

Go to Hierarchy – Displays the Hierarchy window with the selected hierarchy 

item highlighted for easy identification. 

Priority – Assign a priority level to the Machine the POINT is under. 

Plot Right-Click Context Menu 

Position the cursor over the plot background and using your mouse, right-click to 

access the plot context menu.  Menu options include: 

Plot Specific Options – Plot options display in the menu’s top area (if 

available), allowing you to configure the plot’s content.  Which options appear 

(if any) depends upon the current plot type.   

For example, you can convert the units in an acceleration, velocity, or 

displacement spectrum plot.  Unit types display in the menu’s top area and are 

available for selection. 

Settings – Launches the Settings dialog for the current plot type.  This dialog 

allows you to change the way the plot displays.  For example, use the Settings 

dialog to change axis ranges. 

Reset Settings – Resets to default plot settings.  Use Reset Settings to clear 

all settings you made and reset the plot window based on its current content. 

Copy – Copies the plot image to the clipboard. 

Info Area – Show / Hide the current plot’s information area. 

 Square icons on a trend plot line indicate the measurement is 

included in calculations for mean and standard deviation (as in the 

Info tab) and statistical alarm generation.  Use the single cursor's 

context menu or Measurement Properties to change the 

“include” status. 

Overlay Anchor Right-Click Context Menu 

The Overlay anchor right-click context menu provides quick access to the overlay’s 

options (e.g. Remove the overlay, or if more than one trace is displayed, move the 

overlay to the Next Trace, etc.) 
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Drag and Drop Operation 

Drag and drop operation allows you to easily display plots for different measurements.  

These measurements can belong to the same POINT, or to different POINTs.  By 

default, when the POINT is selected, the plot is displayed for the POINT’s last 

measurement.  The drag and drop feature allows you to override this default setting 

and display specific measurements on the plot. 

You can also drag and drop to view multiple POINTs on the same plot.  Simply drag the 

desired POINT(s) and/or measurement(s) into the open plot window. 

Multiple Measurement and Channels in Plots 

It is possible to have multiple measurements from one or more POINTs represented in 

a plot, either by selecting them when opening the plot, or by dragging and dropping 

additional measurements onto an open plot.   

In trend plots, multiple measurements are represented as individual data points on the 

plot.  A plot anchor is located on the left of the plot for each measurement represented 

in the plot.   

Inactive plot line and overlay anchors are indicated using circle icons. 

The Active plot line anchor is indicated using a triangle icon.   

The active measurement determines the cursor feedback and information window's 

content and overlay settings.  You may toggle between the measurements by clicking on 

the appropriate anchor.   

Zoom Operation 

The zoom operation allows you to easily zoom in and out on the plots for a closer look.  

You may zoom in and out one of two ways: 

 Using the zoom buttons on the toolbar 

 Using the mouse scroll wheel 

To zoom in / out on a plot using the zoom buttons: 

 

Figure 4 - 8. 

Plot Window Zoom Buttons. 

 activates zoom 

 zooms out 

 Activate the zoom by clicking the left magnifying glass.   

 Click and drag across the area of the plot to which you would like to zoom.   

 Click the right magnifying glass to zoom out. 
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To zoom in / out using the mouse scroll wheel: 

 Position your cursor over the area of the plot to which you would like to zoom. 

 While holding the Ctrl key, roll the mouse scroll wheel up or down.  Rolling up 

causes the plot to zoom in, while rolling down causes the plot to zoom out. 

Plot Navigation 

While viewing a plot, use the arrow keys on your keyboard to navigate to the next / 

previous measurement on the plot or to the next / previous POINT’s plot.   

To navigate to the next / previous measurement on the plot: 

 While holding the Ctrl key, press the left arrow to display the previous 

measurement, or press the right arrow to display the next measurement. 

To navigate to the next / previous POINT’s plot: 

 While holding the Ctrl key, press the up arrow to display the plot for the previous 

POINT, or press the down arrow to display the plot for the next POINT. 

Set Speed (Multiple) 

Use the Set Speed (Multiple) feature to set the same measurement speed for multiple 

FFT measurements. 

 Starting from an FFT measurement plot, right-click on the single cursor and select 

Set Speed (Multiple) from the resulting context menu.  

The Set Speed (Multiple) window appears. 
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Plot Types 

Machinery measurements can be displayed in a variety of graphic display formats that 

aid machinery analysis.  Each graphic display type is detailed below. 

For each type of graphic display, @ptitude Inspector provides settings to manipulate the 

plot display and to gain valuable analysis information.  These settings dialogs are 

available from the @ptitude Inspector View menu and from the toolbar (which changes 

according to the active plot display type).  Each plot’s settings dialogs are also detailed 

below. 

MCD Plot 

 

Figure 4 - 9. 

Example of an MCD Plot. 

MCD plots allow you to view trend plots for the three values of an MCD measurement: 

velocity, Enveloped Acceleration, and temperature.  Trend plots are an easy and 

accurate method of detecting gradual changes in machinery condition, changes that 

might otherwise be overlooked. 

In an MCD plot, the X-axis (horizontal axis) of the plot represents the time and date of 

the measurement.  Each Y-axis (vertical axis) represents the amplitude of each MCD 

measurement. 

In addition to displaying MCD plots for individual POINTs, you can display multiple 

POINTs’ MCD trends (from the same machine or from different machines) in one 

graphic display window.  This allows easy comparison between various POINTs' trends. 

The active plot (Velocity, Enveloped Acceleration, or Temperature) determines the 

information window's content and overlay settings. 
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 Square icons on an MCD plot indicate the measurement is 

included in calculations.  Use the single cursor's context menu or 

Measurement Properties to change the "include" status. 

See MCD Plot Settings for display parameters that can be modified to change plot 

display. 

MCD Plot Settings 

To access the MCD Plot Settings Dialog: 

 
 With an MCD Plot displayed, select Settings from the Plot option on the 

View menu or use the toolbar button.  The MCD Plot Settings dialog 

displays, specific to the active plot.   

 

Figure 4 - 10. 

The MCD Plot Settings Dialog. 

Enter desired settings in the following fields: 

Autoscale - Click the checkbox to enable Autoscale.  Enabling Autoscale automatically 

scales the initial amplitude axis so it is approximately 120% of the largest amplitude.  

De-select the checkbox to disable.  Disabling Autoscale displays the MCD trend plots on 

the same full scale vertical axis used when it was recorded. 

% Full Scale - Click the checkbox to enable % Full Scale.  When enabled, the 

amplitude axis displays as a % value of the full scale. 

Magnitude Scale - Enter the minimum and maximum magnitude scale values for each 

MCD measurement (Velocity, Acceleration, and Temperature) in the designated text 

boxes.  This changes the range of values displayed on the Y-axis.  The value entered 

here is an amplitude value if % Full Scale is not checked.  The value is a percent if % 

Full Scale is checked. 

Magnitude Lin / Log - Linear / Logarithmic - Select Linear scaling to space out data 

equally.  Select Logarithmic scaling to emphasize lower values. 
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Date / Time scale - Enter minimum and maximum date and time. 

 Click OK to update the plot with the new settings. 

 Click Cancel to close the dialog without modifying the plot. 

 The Settings dialog is also available from the plot's context menu. 

MCD Plot Settings - Combined Plot 

 The combined MCD Plot Settings dialog differs slightly than the 

stacked MCD Plot Settings dialog. 

 

Figure 4 - 11. 

The MCD Plot Settings Dialog. 

Enter desired settings in the following fields: 

Autoscale - Click the checkbox to enable Autoscale.  Enabling Autoscale automatically 

scales the initial amplitude axis so it is approximately 120% of the largest amplitude.  

De-select the checkbox to disable.  Disabling Autoscale displays the MCD trend plots on 

the same full scale vertical axis used when it was recorded. 

Percent Min / Max - Combined MCD plots automatically display amplitude values as 

Percent Full Scale.  Enter the minimum and maximum percentage scale values for the 

combined MCD plot in the designated text boxes.  This changes the range of values 

displayed on the Y-axis.   

Magnitude Linear - Select Linear scaling to space out data equally.  Logarithmic not 

available for combined MCD plots. 

Date / Time scale - Enter minimum and maximum date and time. 

 Click OK to update the plot with the new settings. 

 Click Cancel to close the dialog without modifying the plot. 

 The Settings dialog is also available from the plot's context menu. 
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Inspection Plot 

 

Figure 4 - 12. 

Example of an Inspection Plot. 

Inspection plots allow you to graphically view inspection measurement results for up to 

six points simultaneously.  Inspection plots are an easy and accurate method of viewing 

inspection history over time. 

In an Inspection plot, the X-axis (horizontal axis) of the plot represents the time and 

date of the measurement (Measurement Time Stamp).  Each Y-axis (vertical axis) 

represents the inspection result options for the POINT’s inspection prompt.  Results and 

conditions are indicated by a red square for danger conditions, a yellow triangle for alert 

conditions, and a green circle for clear conditions. 

In addition to displaying Inspection plots for individual POINTs, you can display multiple 

POINTs’ Inspection histories (from the same machine or from different machines) in one 

graphic display window.  This allows easy comparison between various POINTs' 

inspection histories. 

See Inspection Plot Settings for display parameters that can be modified to change 

plot display. 

Inspection Plot Settings 

To access the Inspection Settings Dialog: 

 
 With an inspection plot displayed, select the View menu’s Plot / Settings 

option, use the settings toolbar button, or right-click to display the plot’s 

context menu and select the Settings option. 

Enter desired settings in the following fields: 

Date / Time scale - Enter minimum and maximum date and time. 
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 Click OK to update the plot with the new settings. 

 Click Cancel to close the dialog without modifying the plot. 

 The Settings dialog is also available from the plot's context menu. 

Trend Plot 

 

Figure 4 - 13. 

Example of a Trend Plot. 

Trend plots allow you to easily compare a POINT’s most recent reading against its 

previous readings and its alarm set up, allowing you to see how the POINT is “trending” 

over time.  Trend plots are an easy and accurate method of detecting gradual changes 

in process conditions and changes that might otherwise be overlooked. 

In addition to displaying trend plots for individual POINTs, you can display multiple 

POINTs' trends (from the same machine or from different machines) in one graphic 

display window.  This allows easy comparison between various POINTs' trends. 

In a trend plot, the X axis (horizontal axis) represents time and the Y axis (vertical axis) 

represents magnitude. 

 Square icons on a trend plot indicate the measurement is 

included in calculations.  Use the single cursor’s context menu or 

the Measurement Properties dialog to change the “include” 

status. 

Trend Settings 

To access the Trend Settings Dialog: 

 
 With a trend plot displayed, select the View menu’s Plot / Settings option, 

use the settings toolbar button, or right-click to display the plot’s context 

menu and select the Settings option. 



Displaying Graphic Plots 

Plot Types 

 

SKF @ptitude Inspector 4 - 17 

User Manual 

Magnitude scale fields include: 

Autoscale - Enabling Autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling Autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded.  

% Full Scale - When enabled, the amplitude axis displays as a % value of the POINT’s 

full scale value.  Use % Full Scale to compare measurements that do not have the same 

units or the same Full Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling). 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Date / Time scale fields include: 

Date / Time Scale - Enter minimum and maximum date and time. 

  With a plot displayed, to reset all settings back to their defaults, 

click the right-click context menu’s “Reset Settings” option. 

Adjust date/time range to include latest notes – When enabled, all notes created 

after the date / time of the last collected measurement display on the plot.  Default is 

enabled.   

Spectrum Plot 

 

Figure 4 - 14. 

Example of a Spectrum Plot. 

As different types of machinery problems often occur at different frequencies, it is very 

useful to analyze measured vibration signals with respect to frequency. 
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FFT spectrum plots (pl. spectra) display vibration amplitudes at various component 

frequencies. 

 FFT is the abbreviation for Fast Fourier Transform (the 

mathematical formula that transforms the vibration signal into its 

component frequencies). 

In an FFT spectrum, the X axis (horizontal axis) represents vibration frequency in Hz or 

CPM (or orders of running speed).  The Y axis (vertical axis) represents vibration 

amplitude (Enveloped Acceleration and Velocity).  The top plot displays Enveloped 

Acceleration data.  The bottom plot displays Velocity data. 

FFT spectrum plots are extremely useful machinery analysis tools.  FFT spectra provide 

information that helps determine the location of a problem, the cause of the problem, 

and with trending, how long until the problem becomes critical. 

In addition to single display, you can display multiple POINTs’ or measurements’ FFT 

spectra (POINTs may be from the same machine or from different machines).  This 

allows easy comparison between various POINTs' FFT spectra. 

The cursor feedback area displays the overall values for both the Velocity and Enveloped 

Acceleration plots.  

The active plot (Velocity or Enveloped Acceleration) determines the information 

window's content and overlay settings. 

Spectrum Settings 

To access the Spectrum Settings dialog: 

 
 With a spectrum plot displayed, select the View menu’s Plot / Settings 

option, or use the settings toolbar button.  

 The Settings dialog is also available from the spectrum plot’s 

context menu. 

 

Figure 4 - 15. 

Spectrum Plot Settings Window. 
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View Type fields include: 

Stacked / Combined – Determine the plot orientation for the two measurements 

collected by a WMCD (velocity and enveloped acceleration) in a spectrum plot.  Stacked 

displays each measurement as a separate plot.  Combined shows a single plot overlaid 

with all measurements. 

 It is recommended to always view WMCD FFT data using the 

Stacked view option. 

Link - If View Type is set to Stacked, determine whether cursors and overlays are 

linked across all plots, or operate independently.  If Link is enabled, cursors and 

overlays appear in the same position across all plots.  If Link is disabled, you may add 

and move cursors and overlays in each plot independently. 

Magnitude scale fields include: 

Autoscale - Enable to automatically scale the initial amplitude axis so it is approximately 

120% of the largest amplitude.  Disable to display the spectrum on the same full scale 

vertical axis used when it was recorded.  

% Full Scale - Enable to display the amplitude axis as a % value of the full scale.  Use % 

Full Scale to compare measurements that do not have the same units or the same Full 

Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling).  

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

You must enter values to determine the plot’s frequency scale (X-axis scaling). 

Frequency scale fields include: 

Frequency Scale - Enter the minimum and maximum frequency scale values in the 

designated text boxes. 

Frequency Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

 With a plot displayed, to reset all settings back to their defaults, 

click the right-click context menu’s Reset Settings option. 

 speed point is used, the speed point’s live data is saved as well.  
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Working with Overlays 

Plot “overlays” superimpose cursors, alarms, and frequency markers on displayed plots.  

Each overlay displays an “anchor” which you use to manipulate the overlay. 

Displaying Overlays Using Toolbar Buttons 

@ptitude Inspector has toolbar buttons for commonly used overlays. 

 

Figure 4 - 16. 

Overlay Toolbar Buttons (Shown Here as Two Columns). 

Toolbar buttons are available for each overlay.  The buttons on the toolbar can be 

configured using the Customize menu’s Toolbar option.  For more information on 

customizing toolbars, refer to Appendix B, SKF @ptitude Inspector Toolbars.  

Each button is enabled / disabled based on whether the overlay can appear on the 

active plot.  Individual toolbar buttons are identified later in this section. 

Displaying Overlays Using the View Menu 

The View menu’s Plot Overlays option contains a list of commonly used overlays.  

Individual items on this list are enabled or disabled based on whether the overlay is 

available for the plot window displayed when the item is selected. 
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Figure 4 - 17. 

The View Menu’s Plot Overlays Option. 

Using the View menu’s Overlay option: 

Select the View menu’s Plot Overlay option.  A group of commonly used overlay types 

displays on the menu. 

 Select one of the visible overlay types, or select All Overlays for more selections. 

 
You may also use the All Overlays toolbar button to display the All Overlays 

dialog. 

All Overlays 

 Select the View menu’s All Overlays option.  The All Overlays dialog displays.   

All overlays applicable to the open plot display in the dialog. 

 Select an overlay to display and click OK.  The selected overlay displays in the plot 

window. 

 You may add as many instances of overlays as needed (excluding 

the peak cursor). 

 Click Cancel to undo your selection. 
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Overlay Settings 
 

To access the Settings dialog for the selected overlay, either click the toolbar’s 

overlay settings button, or use the View menu’s Plot Overlays / Settings option. 

Overlay Types 

Individual Overlay types and settings are listed below: 

Inspection Cursor 

Use an inspection cursor to view individual measurement data on the inspection plot by 

moving the cursor to various measurement values. 

To display an inspection cursor: 

 With an inspection plot displayed, select the View menu’s Plot / Plot Overlays / 

Inspection Cursor option, or use the inspection cursor overlay toolbar button. 

 Drag the cursor to position it on the plot. 

Feedback Area - Displays observed results and date / time information. 

Information Area - Specific information displays on the Inspection tab.  Displays the 

POINT on which the cursor is currently positioned, cursor color, date / time, operator 

name, and inspection result. 

Right-Click Context Menu -  Right-click on the inspection cursor overlay anchor to 

reveal its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Move the cursor with the left and right arrow keys.  Press Enter 

to toggle to next trace.  Press Delete to remove the cursor. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Inspection 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is on. 

MCD Alarm Overlay 

Use an MCD alarm overlay to display MCD alarm levels on the plot. 

Context Menu - Right click to reveal the context menu.  Available operations are: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 
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Remove - Removes overlay from the plot. 

Keyboard Support - Press Enter to toggle to next POINT.  Press Delete to remove. 

Feedback - Displays POINT name and MCD alarm. 

Information Area - Specific information displays on the MCD Alarm tab.  Tab 

information includes alarm name, acceleration danger high value, acceleration alert 

high value, velocity danger high value, velocity alert high value, temperature danger 

high value, and temperature alert high value. 

Available Preferences 

Color - Alarm colors configured in Danger and Alert / Colors in the 

Preferences dialog. 

Display Status - Display status (on or off) is configured in the MCD Alarm – 

MCD Plot / Plot Preferences in the Preferences dialog. 

 The default status is on. 

 MCD Alarm overlay is not available when the Plot Preferences’ 

MCD Layout option is set to Combined. 

MCD Curve Fit Overlay 

Use an MCD curve fit overlay to project the linear direction a trend is heading based on 

current data. 

Context Menu - Right click to reveal the context menu.  Available operations are: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove - Removes overlay from the plot. 

Keyboard Support - Press Enter to toggle to next trace.  Press Delete to remove. 

Feedback Area - Identifies curve fit and associated POINT. 

Information Area – Specific information displays on the MCD Curve Fit tab.  

Information is sorted by POINT name or color of current trace.  Tab information 

includes the following for each of the MCD Acceleration, Velocity, and Temperature 

measurements:  

Date, time, and amplitude for 2 years from last plotted measurement. 

Date, time, and amplitude when alert exceeded (or projected to be reached). 

Date, time, and amplitude when danger exceeded (or projected to be reached). 

Available Preferences  

Color - Color appears as configured in Curve Fit / Color Preferences in the 

Preferences dialog. 

Display Status - Display status (on or off) is configured in the MCD Curve Fit / 

Plot Preferences in the Preferences dialog. 

 The default status is off. 



Displaying Graphic Plots 

Overlay Types 

4 - 24 SKF @ptitude Inspector  

 User Manual 

 MCD Curve Fit overlay is not available when the Plot Preferences’ 

MCD Layout option is set to Combined. 

MCD Cursor Overlay 

Use an MCD cursor overlay to view individual measurement values on the MCD plot. 

Context Menu - Using your mouse, right click when the cursor is selected to reveal the 

context menu.  Available operations are: 

Next trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove - Removes overlay from plot. 

Exclude Reading - Toggles selected measurement's Exclude status on and off.  

When Exclude is selected, the measurement is excluded from all calculations.  

This setting is stored with the measurement and is in effect until the setting is 

changed. 

Keyboard Support - Move the cursor with the left and right arrow keys.  Press Enter to 

toggle to next trace.  Press Delete to remove the cursor. 

Feedback Area - Displays amplitude and date / time information. 

Information Area - Specific information displays on the MCD Cursor tab.  Tab 

information includes the POINT the cursor is currently positioned on, cursor color, 

acceleration / velocity / temperature values, and date / time. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences dialog). 

Display Status - Display status (on or off) is configured in the MCD Cursor / 

Plot Preferences in the Preferences dialog. 

 The default status is on. 

Text Annotation 

Use text annotation overlays to create temporary textual notations and display on a 

plot. 

 Text annotations are for temporary use.  They are not attached to 

the measurement or stored in the database.  They remain on a 

plot until the plot is closed. 

To create a text annotation: 

 With a plot displayed, click the toolbar’s text annotation button, or select the View 

menu’s Plot Overlays / Text Annotation option.  The “Text Annotation” displays on 

the plot. 

To edit the text annotation: 

 Double-click the text annotation.  The Text Annotation Settings dialog displays. 
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Figure 4 - 18. 

The Text Annotation Settings Dialog. 

Annotation text - Enter text to display on the plot.  The entered text displays in the 

dialog’s Preview area, allowing you to view the entered text before displaying it on the 

plot. 

Text attributes options include: 

Left justified, Centered, or Right justified - Determine how the text displays in its text 

box. 

Transparent - Enable to make the annotation’s background area transparent, allowing 

you to see the plot beneath the text. 

Background Color - Click to select the annotation’s background area color. 

Font - Click to select the font for the annotation text. 

 Click the OK button.  The entered text annotation displays on the active plot. 

Context Menu - Right-click on the displayed text annotation to reveal its context menu.  

Available operations are: 

Remove – Removes the annotation from the plot. 

Settings – Launches Text Annotation Settings dialog. 

Keyboard Support – Press Delete to remove the annotation from the plot.  Use up / 

down / left / right arrow keys to re-position.  Use Shift and the left or right arrow key to 

enlarge in the direction of the selected arrow.  Use Ctrl and the up / down / left / right 

arrow keys to shrink the box from the direction of the selected arrow. 

Feedback Area – Displays the annotation text. 

Information Area – None. 

Available Preferences 

None. 

 Text annotation may also be moved with the mouse (drag and 

drop).  Click on an anchor area and drag to re-size. 
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Trend / Notes 

Use the notes overlay to create and display notes at a specific date / time on the trend 

plot. 

To create a note: 

 With a trend plot displayed, position your cursor over the plot area and right click to 

display the right-click context menu.   

 Select Add Notes.  The Add Notes dialog displays.  A new note displays in the 

Notes list with the date and time of the location you right-clicked on the plot.   

 

Figure 4 - 19. 

The Add Notes Dialog.  

 If you need to change the date / time of the note, use the Date and Time fields to 

adjust the date / time as necessary.  The Add / Remove buttons will change to 

Save / Undo buttons.  Click Save and the note’s date / time adjusts accordingly in 

the Notes list. 

 Type your note in the Text area and click Save. 

 Click OK.  The created note displays on the plot at its specified date / time location.  

To create additional notes: 

 Click the Add button.  A new note is added to the Notes list with the current date / 

time stamp. 

 Adjust the date / time using the Date and Time fields as necessary.   

 Type your note in the Text area and click Save. 
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 Click OK.  The created note displays on the plot at its specified date / time location.    

To remove a note: 

 Select the note you wish to remove in the Notes list. 

 Click the Remove button. You will be asked to confirm that you wish to remove the 

note. 

 Click Yes, or if you do not wish to remove the note, click No. 

How Notes Overlays Display on the Plot 

Feedback Area - Displays note and date / time information. 

Information Area – Specific information displays on the Notes tab.  Tab information 

includes the POINT on which the cursor is currently positioned, note, and date / time. 

Context Menu - Right-click on the displayed note to reveal its context menu.  Available 

operations are: 

Remove – Removes overlay from the plot.   

 This does not delete existing notes.  To display the notes overlay 

again, select View / Plot Overlays / Notes. 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Display Note – Displays the note on the plot. 

Remove All Display Notes – Hides all notes displayed on the plot. 

Filter Notes – Allows you to select one or more note categories to display on 

the plot.   

 

Figure 4 - 20. 

The Filter Notes Dialog. 

 From the list of note categories, enable the check box next to one or more note 

categories.   

 In the Include from group area, select the check boxes to include notes from SETs, 

Machines, and / or POINTs. 

 Click OK.  Only notes from the selected note categories display on the plot. 

Available Preferences 
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The following preferences are found on the Preferences dialog’s Plot tab. 

Notes – Configure the default display status (on or off). 

Notes Indicator Location – Configure the display notes indicator (at top or 

bottom of plot).  

Notes Indicator Tooltip – Configure whether to display the tooltip (on or off) 

when hovering over the notes indicator. 

Notes Line Style – Configure how the notes cursor line displays (dashed, solid, 

etc.). 

Trend / Single Cursor 

Use a single cursor to view individual measurement data on the trend plot by moving 

the cursor to various measurement records. 

To display a single cursor: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor overlay toolbar button. 

 Drag the cursor to position it on the plot. 

 If multiple traces appear in a plot, double-click the cursor overlay’s anchor to 

position it on another trace.  The anchor’s color indicates the current trace. 

Feedback Area - Displays amplitude and date / time information. 

Information Area – Specific information displays on the Trend tab.  Tab information 

includes the POINT on which the cursor is currently positioned, cursor color, amplitude, 

and date / time. 

Right-Click Context Menu -  Right-click on the single cursor overlay anchor to reveal 

its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Exclude Reading – Toggles selected measurement's Exclude status on and off.  

When Exclude is selected, the measurement is excluded from all calculations.  

This setting is stored with the measurement and is in effect until the setting is 

changed. 

Keyboard Support – Move the cursor with the left and right arrow keys.  Press Enter 

to toggle to next trace.  Press Delete to remove the cursor. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Trend Single 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is on. 
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Trend / Overall Alarm 

Use an overall alarm overlay to display your overall alarms graphically (as configured in 

POINT Properties) on the active trend plot. 

To display an overall alarm overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Overall Alarm and click OK. 

Feedback Area - Identifies the POINT, displays private alarm or alarm name (if shared), 

and the alarm levels set. 

Information Area - Specific information displays on the Overall Alarm tab.  Tab 

information includes POINT name, type, alarm level values and alarm message 

summaries.   

Overall Alarm tab - Information includes name, type, and alarm level values. 

Right-Click Context Menu - Right-click on the overall alarm overlay anchor to reveal 

its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Color – Alert and Danger colors appear as configured in Cursor / Color 

Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Trend Overall 

Alarm / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Trend / Curve Fit 

Use a curve fit overlay to graphically display the projected linear direction a trend is 

heading based on current data 

To display a curve fit overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / Curve 

Fit option, or use the curve fit toolbar button. 

Feedback Area - Identifies the curve fit and associated POINT. 

Information Area - Specific information displays on the Curve Fit tab.  Tab information 

includes:   

Date, time, and amplitude for 2 years from last plotted measurement. 

Date, time, and amplitude when alert exceeded (or projected to be reached). 
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Date, time, and amplitude when danger exceeded (or projected to be reached). 

Information is sorted by the POINT name or color of the current trace. 

Right-Click Context Menu - Right-click on the curve fit overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences  

Color – Color appears as configured in Curve Fit / Color Preferences in the 

Preferences dialog. 

Display Status – Display status (on or off) is configured in the Trend Curve Fit 

/ Plot Preferences in the Preferences dialog. 

 The default status is off. 

WMCD Spectrum / Single Cursor 

Use a single cursor on a spectrum plot to display the amplitude for the frequency of the 

cursor’s current placement 

To display a single cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area - Displays amplitude, frequency, and number of orders. 

Information Area - Specific information displays on the Spectrum tab.  Tab 

information includes POINT name, cursor color, frequency, amplitude of each 

measurement (velocity and enveloped acceleration), and number of orders.  

Right-Click Context Menu -  Right-click on the single cursor overlay anchor to reveal 

its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Set Speed – Launches the Set Running Speed dialog. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove.  Left 

and right arrow keys move one line at a time.  Shift and the left or right arrow moves 

15 lines at a time. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences dialog). 
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Display Status – Display status (on or off) is configured in the Spectrum 

Single Cursor / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Set Running Speed 

The calculated or custom running speed appears on the active plot if the running speed 

overlay is displayed. 

To specify the running speed: 

 Right click on the single cursor overlay and select Set Speed from the pop-up 

menu. 

 

Figure 4 - 21. 

The Set Speed Dialog. 

Use the Set Running Speed dialog to edit the running speed for the measurement.   

Current frequency – Displays the frequency of the current cursor position on the open 

plot. 

To set a custom running speed: 

 Enter the desired frequency in the Calculated running speed field and click OK. 

To automatically calculate running speed by current frequency and number of 

orders: 

 Enter the desired value in the Equivalent to order# field. 

 Click OK. 

WMCD Spectrum / Harmonic Cursor 

Use a harmonic cursor to display multiples of the current frequency. 

To display a harmonic cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Harmonic Cursor option, or use the harmonic cursor toolbar button. 

Feedback Area – Displays the value for fundamental and harmonic amplitude, 

frequency, and orders.  When the mouse pointer is positioned over a harmonic marker, 

that marker’s amplitude, frequency, and orders display on the feedback area’s second 

line. 

Information Area – Specific information displays on the Harmonic Cursor tab.  Tab 

information includes POINT name, cursor color, frequency, amplitude of each 
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measurement (velocity and enveloped acceleration), number of orders, and percentage 

of each measurement’s fundamental frequency for each harmonic.  

 

Figure 4 - 22. 

The Harmonic Cursor Tab. 

The Harmonic Cursor tab provides details on potential harmonics using SKF’s 

Harmonic Activity Index (HAI).  All impact defects create spectra with a fundamental and 

a series of harmonics (i.e., a harmonic pattern).  The amplitudes of these harmonics are 

affected by the defect itself, as well as the filtering effect of the machine.  HAI is a 

calculation that quantifies the likelihood of harmonic patterns being present in a 

spectrum, and therefore, the likelihood of a defect being present. 

The result of the HAI calculation is displayed in the Activity Index column.  The Activity 

Index is a quick indicator to determine if there is a meaningful pattern under the 

current cursor position (i.e., whether or not there is a defect associated with this 

frequency).  It can also act as a guide to determine the best cursor position for a 

suspected a harmonic pattern. 

An HAI value of 2.5 or greater indicates a likely defect pattern; HAI values of 3 or more 

show clear patterns. 

 HAI values are the same across spectra from different sources 

(i.e., the number of lines or unit types do not matter).  

 HAI values are calculated from spectral data only.  In some 

spectra, many different sources unrelated to each other may 

create a seemingly harmonious pattern.  The HAI value for this 

pattern might be high enough to suggest a true pattern is shown.  

To verify it is a true pattern, always check a few spectra taken 

over time for similar HAI values. 

Right-Click Context Menu -  Right-click on the harmonic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Keyboard Support – Press Enter to toggle to the next trace.  Press Delete to remove. 

Left and right arrow keys move the fundamental line in small increments (one line at a 

time).  Use the Shift and the left or right arrow key to move in larger increments (15 

lines at a time).   

Ctrl and the left or right arrow key moves the marker on the far right in small 

increments. 
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Available Preferences   

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Harmonic 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Number of Harmonics – Maximum number of harmonic markers displayed 

(1-100). 

 The default number is 50. 
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Generating and Printing SKF @ptitude Inspector 

Reports 

Overview 

 The File menu's Print option or the toolbar's Print button may be 

used at any time to print the contents of the “active” @ptitude 

Inspector window (including graphic display windows). 

 Microsoft Internet Explorer version 4.X or newer is required to 

view reports. 

@ptitude Inspector’s Reports feature provides options for controlling the generation 

and printing of hard copy reports showing database and measurement information.   

Collection Status – Produces a report of set ROUTE activity dates and the 

status of each POINT.  POINT status includes Collected, Missed, and Not 

Collected. 

Exception - Produces a report of POINTs in violation of specified exception 

criteria. 

History - Produces a report of machine notes. 

Last Measurement - Reports POINTs’ last measurement values. 

Inspection – Produces a report for open or selected inspection POINTs in the 

hierarchy list. 

Overdue / Non-Compliant- Produces a report of all POINTs that are overdue 

for measurement. 

Pending Overdue/Non-Compliant – Produces a report of all POINTs that are 

pending overdue. Default is seven days. 

ROUTE Statistics - Produces a report of statistics for one or more ROUTEs.  

Statistics include when due, last downloaded, total number of POINTs in the 

ROUTE.   

ROUTE History Report - Produces a report of ROUTE history for the selected 

ROUTEs.  ROUTE History reports include ROUTE collection time duration, start 

and stop times, and operator ID (structured ROUTEs only).  The amount of 

reported ROUTE historical information is determined using the ROUTE 

Properties / General tab.  

SET Statistics - Produces a report of statistics for the selected data source.  

The statistics include total number of POINTs, POINTs in alarm, POINTs 

disabled, and POINTs overdue. 

Upload Statistics – Produces a report of the statistics for information last 

uploaded from the DAD. 
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 Each of @ptitude Inspector’s report types may be customized.  

Report setup is discussed later in this chapter. 

Reports Dialog 

 Select the File menu’s Reports option.  The Reports dialog displays. 

The Reports dialog allows you to select, configure, manage, and generate reports.  

Each report type is available for use and may also be used as a starting point to 

customize reports to fit your particular application. 

 Reports may also be generated automatically using the Scheduler 

feature.  Refer to Chapter 3, Working With Your SKF @ptitude 

Inspector Database for more information on scheduling 

automatic reports. 

Use the Reports dialog to work with existing reports and to create new report 

templates.  The top area provides options for new and current reports.  The bottom 

area provides options for preserved (archived) reports. 

 

Figure 5 - 1. 

The Reports Dialog. 
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Select report area - Displays all existing report definitions. 

 Click a report’s name to select it.   

Reports options include: 

Generate – Generates a report to the computer display based on the selected report 

definition. 

View – Displays the latest generated version of the selected report. 

Add – Defines a new report based on a pre-defined @ptitude Inspector template. 

Copy – Defines a new report using the selected custom report as a template. 

Edit – Launches the Report Editor dialog to edit the selected report. 

Remove – Deletes the selected report.  When you delete a report from the dialog's top 

area, you are asked if you also want to delete all preserved historical reports for the 

selected report definition. 

 When a report is removed, its corresponding subdirectory and all 

included files are also removed from your computer’s hard drive.  

If you wish to delete a report, but save previous copies, copy the 

report’s files from its subdirectory to a new location on your hard 

drive before removing the report. 

History area – Displays all existing preserved reports for the selected report definition. 

 Refer to the Report Editor / General section later in this chapter 

for more information on preserving historical reports. 

 Click a preserved report's name to select it. 

View - Displays the preserved version of the selected report, identified by its date and 

time. 

Send – Launches the Recipient Selection dialog and allows you to send the report in 

an email message to one or more selected contacts or groups of contacts.  The report is 

sent in HTML and PDF format to the selected email recipients.  

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set 

up contacts and groups. 

Rename – Allows you to rename the selected preserved report.  The Enter Name 

dialog displays, prompting you to enter the new report name.  Click OK to rename the 

selected report. 

Remove – Removes the selected preserved report. 

Close – Closes the dialog. 

To generate a @ptitude Inspector Report: 

 Open the Hierarchy window whose data you wish to report.  If necessary, open or 

select hierarchy items within the window to limit the report’s content. 

 Select the File menu’s Reports option.  The Reports dialog displays. 
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 Select a report from the Reports dialog’s Select report area. 

 Click the Generate button.  The report is rendered and when complete, displays in 

a report window for viewing or printing. 

  Report generation progress displays in the progress bar 

in the screen’s lower right corner. 

 When setting up a report, there is an option to select the data 

source at the time the report is generated.  If this has been 

selected, the Select Data Source dialog displays.  Refer to the 

Selecting the Data Source heading, later in this chapter, for 

details. 

 Press your keyboard’s End key to go to the end of the report. 

 Press your keyboard’s Home key to go to the top of the report. 

To print a generated report: 

 With the generated report on the computer’s display, use the Print toolbar button 

or select the File menu’s Print option.   

To view an existing report:  

 In the Reports dialog, select the desired report. 

 Click the View button.  The report displays in a Report window and is available for 

viewing and/or printing. 

Use the Reports dialog to “add” a customized report type.  Customized reports are 

based on pre-defined report types, then modified to suit your particular application.  

Once your new report type is defined, it is available for selection from the Reports 

dialog, and may be generated as needed. 

To add a new report: 

 Click the Report dialog’s Add button.  The Select Report Template dialog displays. 

The Select Report Template dialog displays all pre-defined @ptitude Inspector report 

templates.  These templates may be used to generate reports without further 

modification, or as a starting point for creating custom reports. 

 Select the template to use as a basis for your new report. 

 If you wish to use the selected report “as is,” (no modifications are 

required) assign the report a unique name, verify the path 

settings, and click the OK button to accept all default settings. 

 Click OK.  The Report Editor dialog displays. 

Report Editor 

The Report Editor dialog contains three tabs: 

General – Defines the new report’s identity and processing parameters. 

Definition – Defines the new report’s criteria, criteria settings, and content. 

Assign – Allows you to configure default report configurations for both public and 

hierarchy-specific reports. 
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Report Editor / General 

Report Editor / General tab fields include: 

Name – Using standard file naming conventions, assign the new report a unique name.  

Do not use the pound sign (#) in your report name as it can cause errors when printing.  

The assigned name identifies the most recently generated report and is used to name 

the disk directory (folder) where the report and all its supporting files are stored.  If you 

maintain historical reports, a separate directory is created beneath the report's directory 

identified by the historical report's name. 

 If you change a report’s name, all data for the previously 

generated report remains in the subdirectory with the original 

report’s name.   

Title – Enter a descriptive title for the report.  This text appears at the top of the 

generated report. 

Header – Enter text to display in the printed report’s header area. 

Footer – Enter text to display in the printed report’s footer area. 

Preserve Reports – Click to enable report preservation.  When enabled, newly 

generated reports are archived, organized by report definition and date / time. 

Report is Available for all users – Click to enable and define the report as a public 

report, available to all @ptitude Inspector users.  If you do not check this option, the 

report is defined as a private report, available only to the report creator. 

Report is Available for all hierarchies – Click to enable and make the report available 

for use with all @ptitude Inspector hierarchies.  If you do not check this option, the 

report will only be available to the current hierarchy  

Report can specify data sources from multiple hierarchies – Click to enable and 

make the report available for use with all @ptitude Analyst hierarchies, as well, as 

enable the ability to select multiple data sources from multiple hierarchies.  If you do not 

check this option, the report will only be available using a single hierarchy source. 

Report Editor / Definition 

The Report Editor / Definition tab is divided into two main areas, the Select report 

criteria area in the dialog's left panel and the criteria setup panel on the right.  Click an 

item to expand and view any sub-items available for configuration.   
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Figure 5 - 2. 

The Report Editor / Definition Tab. 

Select report criteria – Select attributes to appear in the report.   

Criteria setup (contents change depending upon item selected in left panel) – 

Allows you to configure the selected report criteria to determine report content.  

To select an element to include in the report: 

 Highlight the item and click the item’s checkbox to include it in your report.  Once 

selected, the item's input fields (if any) display in the dialog's right panel.  Available 

report elements are detailed in the Report Criteria section later in this chapter. 

 Click the item's + icon to expand the item in the hierarchy list and view its additional 

configuration options. 

 Click an additional configuration item to select it.  When selected, the additional 

item's set up fields display in the Criteria Setup area, allowing you to further 

customize the report.  Available setup fields are detailed in the Criteria Setup 

Fields section later in this chapter. 
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Report Criteria 

The following items display in the Select report criteria area as top-level items.   

Alarms - Select individual alarm conditions and types to include in the report. 

Last Measurement - Select to include all POINTs in the report with a last 

measurement. 

Overdue/Noncompliant – Specify the amount of overdue POINTs to include in the 

report. 

Priority – Includes any Machine with a set priority matching your selection(s). 

Inspection / Upload Statistics – Select one or more alarm conditions (Clear, In alert, In 

danger); select the columns, date range and type of notes to include. Check Upload 

Statistics to include a summary of the last data upload from the DAD. 

Work Notification – Select to include all work notifications, a fixed number of them, or 

select a date or date range. Specific ROUTEs and work request statuses can be selected 

for the report.  

SET Statistics – Select to include a summary of the hierarchy item and all its children. 

ROUTE Statistics – Select to include a summary of ROUTE data collection status for 

each ROUTE included in the report. 

History – Select to include all machine notes and images for any machine in the 

selected data source. 

Measurement Statistics – Select to include a summary of statistical information for a 

selected measurement type (selected by the Full Scale Units setting) and alarm 

threshold (selected by the Threshold Level setting).  This setting includes the average 

amplitude for last measurement data of the specified measurement type, and indicates 

all POINTs with an amplitude above the specified alarm threshold in the report. 

Collection Status - Select to include a summary of the ROUTE activities and its POINTs’ 

status. Include all collection activities, a fixed number of them, or select a date or date 

range. You can choose to show only missed or uncollected POINTs.  

Route History – Specify the amount of historical ROUTE information to include in the 

report. 

 The Include records by comparing options under Route History 

are only applicable to the date range settings.  They further filter 

the range based on start time, end time, or both. 

Compliance – Select ROUTEs on which you wish to report a summary of compliance 

status, and specify to report status for either the previous collection interval (previous 

compliance) or the current collection interval (current compliance).  You may also 

specify to list all missed or out of compliance POINTs for the specified ROUTEs and to 

exclude interval-based POINTs. 

Transient – Select to include transient data and specify the phase order (1 – 4). 
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Criteria Setup Fields (right panel setup fields) 

Columns 

Use the Columns input area to specify which columns appear in report tables, to specify 

column order, and select column sort criteria. 

 

Figure 5 - 3. 

The Report Editor / Definition Tab, Criteria Setup. 

Available columns – Displays all available columns for the selected report element.  

Included columns – Displays all included columns for the selected report element. 

To include / exclude columns: 

 Click the column type to select it. 

 Use the Include / Exclude buttons to move the selected column to the Included 

columns area to include in the report, or move the selected column to the 

Available columns area to exclude it from the report. 

To specify column order: 

 Click the column type in the Included columns area. 

 Use the Up and Down buttons to place the column into the desired position. 
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To specify sort criteria: 

 Select a column type from the Sort on drop down list box. 

 Click the desired sort method button, Ascending or Descending. 

 Click the Set All button to use the current column settings for all matching column 

types in other report element setup fields.  For example, the same column settings 

are available for various report elements.  The Set All feature allows you to 

configure this information once and then use the same settings for all applicable 

report elements. 

 Click OK to save changes, or Cancel to undo settings. 

Date Range 

Use the date range fields to specify a date interval.  This date interval is used to retrieve 

only POINTs with a last measurement that falls within the indicated date interval. 

Only include enabled POINTs – Select (check) to have the applicable report 

criterion retrieve data from enabled POINTs only. This checkbox can be 

selected or not selected (checked or not checked) by default and may or may 

not be editable depending on the selected report criterion. 

 For Alarms and Overdue/Non-compliant criteria – This checkbox 

is selected (checked) by default and is read-only. Thus, these 

criteria will always retrieve data from enabled POINTs only for 

reporting. 

 For Last Measurement, Inspection, and Measurement 

Statistics criteria – This checkbox is not selected (not checked) by 

default and is editable. Thus, by default these criteria will retrieve 

data from all POINTs for reporting, but you can select (check) this 

checkbox to have them retrieve data from enabled POINTs only. 

No date range restriction – Select to remove date range restrictions. 

Absolute date – Enter “absolute” (calendar) dates for date range restriction. 

Relative date – Enter number of days (from / to) for date range restriction. 

 Click the Set All button to use the current date range settings for all date range 

settings in other report element setup fields.  The Set All feature allows you to 

configure this information once and then use the same settings for all applicable 

report elements. 

General 

Use the General fields to configure general report element information. 

Include image – Click to enable and include any images associated with the 

selected report element. 

Grouped by machine – Click to enable and display included report items 

grouped by machine. 



Generating and Printing SKF @ptitude Inspector Reports 

Reports Dialog 

5 - 10 SKF @ptitude Inspector  

 User Manual 

Plots 

Use the Plots fields to specify which plot types are to be included with the report table 

for the selected report item. 

 

Figure 5 - 4. 

The Report Editor / Definition Tab, Plots. 

Include plot information tables – Click to enable and include plot content 

details and overlay information in table format on the report. 

Plots area - Displays all available plots.  Click a plot type to include it in the 

report. 

 Selected plots are created only if there is associated data. 

Overlays area – Displays overlays associated with the selected plot type (if 

applicable). 

 Click the Set All button to use the current plot and overlay settings for all matching 

plot and overlay types in other report element setup fields.  For example, the same 

plot settings are available for various report elements.  The Set All feature allows 

you to configure this information once and then use the same settings for all 

applicable report elements. 
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Measurement History 

Use the Measurement History fields to specify which measurements to include in the 

report. 

Last fixed number of measurements – Select this option and type in or use 

the arrow buttons to specify the fixed number of measurements to include in 

the report. 

Measurements in this date range – Select this option to include all 

measurements occurring between your entered date interval in the report.  

Type in a start date in the From field and an end date in the To field, or use 

the arrow buttons to display a pop-up calendar to select start and end dates. 

Measurements from the last fixed number of days – Select this option to 

include measurements occurring within a specific number of days in the report.  

Type in or use the arrow buttons to specify the fixed number of days. 

All measurements – Select this option to include all measurements in the 

report. 

Notes 

Use the Notes fields to specify which notes to include in the report. 

Note Categories – Click to enable and include one or more note categories for the 

selected report item in the report.  Note categories include ACK Alarm Note, Coded 

Note, General Note, Non-Collection, Oil Analysis Note, and Operating Time Reset. 

Settings area – Use the settings area to define which notes to include in the report. 

Last fixed number of notes – Select this option and type in or use the arrow buttons 

to specify the fixed number of notes to include in the report. 

Notes in this date range – Select this option to include all notes occurring between 

your entered date interval in the report.  Type in a start date in the From field and an 

end date in the To field, or use the arrow buttons to display a pop-up calendar to select 

start and end dates. 

Notes from the last fixed number of days – Select this option to include notes 

occurring within a specific number of days in the report.  Type in or use the arrow 

buttons to specify the fixed number of days. 

All notes – Select this option to include all notes in the report. 

Routes 

Use the ROUTEs  fields to specify which ROUTEs to include in the report. 

Routes – All available ROUTEs display in the ROUTEs area.  Click to select one 

or more ROUTE.   

 Click Check All to select all available ROUTEs.  Click Clear All to clear your 

selections.  

 Click the Set All button to use the current ROUTE selections in other report 

element setup fields.  The Set All feature allows you to configure this information 

once and then use the same settings for all applicable report elements. 
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Overdue Forecast 

Use the Overdue fields  to specify the number of days to use with projection and 

trending. 

Absolute date in the future – Enter a future date to indicate when the POINT 

is considered overdue. 

Number of days from today - Enter a number in the text field or use the up 

and down arrows to indicate the number of days from now for use with 

projection and trending. 

Report Editor / Assign 

Use the Report Editor dialog's Assign tab to configure default report settings, and to 

override defaults when the report is generated from the current hierarchy. 

The Assign tab varies, depending on whether Report is available for all hierarchies or 

Report can specify data sources from multiple hierarchies is enabled on this dialog’s 

General tab. 

 

Figure 5 - 5 

The Report Editor / Assign Tab with Report is available for all hierarchies Disabled. 
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Figure 5 - 6. 

The Reports / Assign Tab with Report is available for all hierarchies Enabled. 
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Figure 5 - 7 

The Report Editor / Assign Tab with Report can specify data sources from multiple hierarchies 

Enabled. 

The dialog provides fields to configure default report settings.  Options include: 

Report Location - Specify the path for the disk directory for report storage.  The report 

is stored in a subdirectory (using the report’s name) beneath this indicated directory.  

For example, specify E:\SKF @ptitude Inspector\Reports to place all reports in their 

unique directories branching from a “reports” directory. 

 Click the Browse button to specify a new path. 

 Reports are stored in HTML format and are available for copying, 

moving, and sharing over intranet, world wide web, etc. 

Data Source – Select the source of the data to include in the report.  Use the plus and 

minus icons to expand the hierarchy as needed to display sub-items. If Report can 

specify data sources from multiple hierarchies is disabled, options include: 

Selected Node – Select to include data from the node that is selected in the 

hierarchy at the time the report is generated, including all sub items. For 

example, if a SET is selected in the hierarchy when the report is generated, all 

POINTs from all Machines under that SET are included. 

Current Hierarchy – Select to include all data from the hierarchy that is open 

when the report is generated. 

Primary Hierarchy - Select to us the currently selected primary hierarchy as 

the report's data source. 
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Last Uploaded – Select to include the most recently uploaded data. 

ROUTEs / Workspace – These options appear in the upper section’s Data 

source list if the report is only available for this hierarchy (i.e., Report is 

available for all hierarchies is disabled).  Select a previously defined ROUTE 

or Workspace to use with the report. 

 ROUTE based reports, such as ROUTE Statistics, ROUTE History, 

Compliance, and Collection Status, use data from the ROUTEs 

specified on the Definition tab, rather than the source data 

specified on the Assign tab.  

Profile Devices – Select a Microlog Inspector profile to include the most 

recently uploaded data from device assigned the selected profile. 

If Report can specify data sources from multiple hierarchies is enabled, options 

include: 

Selected Node – Select to include data from the node that is selected in the 

hierarchy at the time the report is generated, including all sub items. 

Select Data Source - Select multiple hierarchies, groups, and POINTs to 

include in your report. 

Define title, data source, and/or history name at time of generation – Enable to 

receive an option to override the Data source selection at the time the report is run.  If 

this is enabled, you must manually specify this report information each time the report 

is generated.  Before report generation occurs, the Select Data Source dialog displays, 

prompting you to enter report information and select the report’s data source.  (See 

Selecting the Data Source below for details.) 

If the Report is available for all hierarchies check box is enabled on the Report 

Editor’s General tab, the dialog's bottom area allows you to configure reports 

specifically for use with the current Hierarchy only.  If you do not use the bottom area's 

configuration options, the default configuration from the dialog's top section is used. 

 You must edit the report in each hierarchy where you wish to 

override the default options.   

The top line of this section displays the current hierarchy name and indicates whether 

the default settings are used, or if custom overrides have been established in the fields 

below. 
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Figure 5 - 8 

The Report Editor / Assign Tab’s Default / Custom Line. 

 hierarchy name 

 default / custom 

The remaining fields function as previously described.  These settings will be used to 

generate the selected report type for the current Hierarchy only. 

 Click the Use Defaults button to clear your custom configuration and return to all 

default settings. 

Selecting the Data Source 

If Define title, data source, and/or history name at time of generation is enabled on 

the Report Editor’s Assign tab, the Select Data Source dialog appears when the 

report is generated. 

The Select Data Source dialog varies, depending on whether Report can specify data 

sources from multiple hierarchies is enabled on the Report Editor’s General tab. 
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Figure 5 - 9 

The Select Data Source Dialog. 

 

Figure 5 - 10 

The Select Data Source Dialog when Report can specify data sources from multiple hierarchies is 

Enabled on the Report Editor’s General Tab. 



Generating and Printing SKF @ptitude Inspector Reports 

Reports Dialog 

5 - 18 SKF @ptitude Inspector  

 User Manual 

This dialog lets you configure the report title, specify whether to preserve a copy of the 

generated report, and specify the data source for this instance of the report.   

 The data source defaults to the Data source setting on the 

Report Editor’s Assign tab. 

 In the Report title field, enter the report title. 

 Click the Preserve report checkbox to enable report preservation.  When enabled, 

newly generated reports are archived, organized (by default) by report definition 

and date / time. 

If Preserve report is enabled, you can also manually enter a History name to use 

when organizing your preserved reports, instead of the default date / time naming 

method.  The History name determines how the reports are organized, and how they 

display in both the Report Editor / General’s History window, and in the separate 

preserved reports directory created in the disk directory (folder) designated as the 

report storage location.  The History name field displays “[Date] [Time]” until you type 

in the field.  If you do not type within the History name field, the preserved report is 

named and organized by its date / time. 

To assign a manual history name: 

 In the History name field, enter text to identify and organize your preserved 

reports, overriding the default date / time history name.   

To select the report’s data source: 

 From the Select data source for report window, click to select the appropriate 

data source from the displayed hierarchy list.   

 Use the plus and minus icons to expand the hierarchy as needed 

to display sub-items. 
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Appendix A 

SKF @ptitude Inspector Toolbars 

Toolbar Tools 

The following figures display @ptitude Inspector’s default toolbars and their default 

toolbar button assignments are discussed below.  You can enable any or all of the 

available buttons by using the Custom Toolbar dialog discussed later in this chapter. 

Primary Toolbar 

Hierarchy Window – open Hierarchy window. Organizes your monitored machinery 

measurements into a hierarchy structure consisting of Groups (which may be 

organizational SETs, machines, or custom groups) and measurement POINTs. 

ROUTE Manager – open ROUTE dialog. A ROUTE is a measurement POINT collection 

sequence that is downloaded to a data acquisition device (DAD).  

Workspace Manager – open Workspace dialog. A workspace organizes specific Groups 

into one location for easy comparison and analysis. 

Microlog Inspector Status – open Microlog Inspector Device Status window. 

Properties – open Properties dialog for the active hierarchy item (could be Group 

Properties or POINT Properties). 

Alarm Window – open Alarms window which displays all POINTs in alarm in the selected 

view. 

Report Setup – open Reports dialog. 

Print – print window contents (also print to file). 

System Information – open System Information view to see the Event Log and Online 

Data. 

Exit – exit the application. A confirmation message displays before exiting. 

Hierarchy View Toolbar 

Alarm Details – open the Alarm Details view.  

Apply Filter – open Apply Filter dialog. When a filter is applied, the resulting items 

display in a new Workspace window. 

Apply Template – open the Apply Template dialog to select a template to apply to the 

hierarchy.  

Navigation Toolbar 

Auto Link – link any open Hierarchy, Workspace, ROUTE, Transient, Template, or 

Alarms window (source windows) to any open Alarm Details or Plot window (target 

windows). With Auto Link enabled, selections in one of the source type windows 

automatically affect all open target type windows.  



SKF @ptitude Inspector Toolbars 

Toolbar Tools 

A - 2 SKF @ptitude Inspector  

 User Manual 

For example, suppose you have a Hierarchy window open (source type window), select a 

POINT, and display its spectrum (target type window). With Auto Link enabled, when 

you select a different POINT in the Hierarchy window, the plot window automatically 

updates to display the newly selected POINT's spectrum. 

Previous POINT – move focus to the previous POINT in the hierarchy. 

Next POINT – move focus to the next POINT in the hierarchy. 

Previous Measurement - move focus to the previous measurement. 

Next Measurement - move focus to the next measurement. 

View Icons Toolbar 

Large Icons – display measurements as large icons. 

Small Icons – display measurements as small icons. 

Simple List Icons – display measurements as a simple list. 

Detailed List Icons – display measurements as a detailed list. 

Plots Toolbar 

Trend Plot – view a POINT’s most recent reading in comparison with its previous 

readings and its alarm set up. See how the POINT is “trending” over time to detect 

gradual changes in process conditions. 

MCD Plot – view stacked trend plots for the three values of an MCD measurement: 

velocity, enveloped acceleration, and temperature. 

Inspection Plot – view inspection measurement results for up to six points 

simultaneously.  Enables viewing inspection history over time. 

Spectrum Plot – view measured vibration signals with respect to frequency. An FFT 

spectrum plot displays vibration amplitudes at various component frequencies. 

All Plots – open the All Plots dialog to select the plot type to display from all available 

plots, including combination plots, in addition to the plot types commonly represented 

with toolbar buttons. 

Plot Tools Toolbar 

Plot Settings – open Plot Settings dialog for the active plot. 

Information Area – open information area beneath the active plot. 

Set Speed – set the cursor position to correspond with the spectrum’s running speed.  

Set Speed (Multiple) – set the same measurement speed for multiple FFT 

measurements 

Activate Zoom – Click to activate the zoom feature, then click and drag across the area 

of the plot which you would like to zoom. The plot will redraw to display the selected 

area. When using a mouse scroll wheel, position your cursor over the area of the plot 

which you would like to zoom. While holding the Ctrl key, roll the mouse scroll wheel up 

or down.  Rolling up causes the plot to zoom in, while rolling down causes the plot to 

zoom out. 
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Zoom Out – zoom out one level. 

Live Data – initiates live data mode when a single POINT is selected. The active display 

updates as new data is collected by its on-line device. Previous spectra and time 

waveform plots are overwritten by updated spectra / time waveforms. 

Play Sound Byte – launches the utility providing various playback options to listen to 

sound data waveform through your computer's speakers or connected earphones. 

Overlays Toolbar 

Overlay Settings – open the Overlay Settings dialog for the selected overlay. 

Single Cursor – display single cursor. Use a single cursor to view individual 

measurement data on the trend plot by moving the cursor to various measurement 

records. Use a single cursor on a spectrum plot to display the amplitude for the 

frequency of the cursor’s current placement. 

Inspection Cursor – display inspection cursor to view individual measurement data on 

the inspection plot by moving the cursor to various measurement values. Specific 

information displays on the Inspection tab: the POINT on which the cursor is currently 

positioned, cursor color, date / time, operator name, and inspection result. 

CTA Cursor – display CTA cursor on a time plot and view a time interval’s average 

waveform. Opens CTA Cursor tab in the plot information area to show details of label, 

interval, frequency, magnitude, and contribution (%). 

MCD Alarm – display MCD alarm levels on the plot.  

MCD Cursor – display MCD cursor to view individual measurement values on the MCD 

plot. Opens the MCD Cursor tab in the information area to show: the POINT the cursor 

is currently positioned on, cursor color, acceleration / velocity / temperature values, and 

date / time. 

MCD Curve Fit – project the linear direction a trend is heading based on current data. 

Text Annotation – open Text Annotation Settings dialog. 

Overall Alarm – display the alert and danger levels designated for detection of 

machinery faults. The overall alarm levels are based on the measurement’s “baseline” 

vibration level. 

All Overlays – open the All Overlays dialog and select the overlays to display. 

Custom Toolbars 

Toolbar buttons are available for each menu item and available function.  By default, 

only toolbar buttons for commonly utilized features are active.  Buttons are arranged by 

related functionality in separate sections of the toolbar area.  You can enable any or all 

of the available buttons using the Custom Toolbar dialog. 

To open the Custom Toolbar dialog: 

 Select the Customize menu’s Toolbars option.  The Custom Toolbar dialog 

displays. 
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Figure A - 1. 

The Custom Toolbars Dialog. 

The Custom Toolbars dialog has two main areas.  The Toolbars area displays all 

available toolbars, sorted by name.  All available buttons (active and non-active) for the 

selected toolbar display in the dialog’s second area, Buttons. 

You can configure each toolbar to display the buttons you frequently use.  You may 

activate buttons that are inactive by default, or inactivate buttons that are active by 

default.   

By default, the Hierarchy View, Navigation, Overlays, Plot Views, Plots, Primary, 

and View Icons toolbars are activated. 

 Click the checkbox next to the toolbar to activate the toolbar. 

 Click the checkbox next to the individual available buttons to activate the buttons for 

the selected toolbar. 

 Click Display toolbar titles to display the toolbar’s descriptive name on the toolbar 

itself for easy identification. 

 Click OK to rebuild all toolbars incorporating your selections. 

 Custom toolbar selections are stored with your user name and 

automatically display for you after initial log in. 
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